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Pl Integrator for Business Analytics 2020 R2
SP2

Pl Integrator for Business Analytics transforma los datos de Pl System en un formato para la toma de decisiones
gue pueden consumir las herramientas de inteligencia empresarial (Bl), como Microsoft Power Bl, Tableau, Tibco
Spotfire y QlikView. Con las herramientas de Bl, puede ejecutar andlisis retrospectivos en grandes conjuntos de
datos de PI System en tiempo real. Estos analisis hacen visibles los comportamientos y patrones operativos para
gue pueda identificar dependencias y correlaciones entre los diferentes aspectos de las operaciones.

La edicién estandar de PI Integrator for Business Analytics publica vistas de activos y eventos en muchas bases de
datos relacionales, lagos de datos, almacenes de datos y destinos de archivos. Pl Integrator for Business Analytics
se puede integrar de manera nativa en Microsoft SQL Server, Amazon S3, Azure Data Lake Storage Gen 2, Google
Cloud Storage, Azure SQL y mas. Para ver la lista completa, consulte Ediciones de Pl Integrator for Business
Analytics.

La edicién avanzada de Pl Integrator for Business Analytics suministra paquetes de datos de Pl System en tiempo
real a las plataformas de transmisién, como Apache Kafka. Las plataformas de transmision contribuyen a poner
en funcionamiento los modelos de aprendizaje automatico y admiten las arquitecturas Kappa y Lambda de
consumo de datos. La edicién avanzada de Pl Integrator for Business Analytics admite toda la funcionalidad de la
edicion estdndar y publica vistas de transmisidon en destinos populares del centro de mensajes, como Apache
Kafka, Azure loT Hub, Amazon Kinesis y Google Cloud Pub/Sub. Para ver la lista completa, consulte Ediciones de
Pl Integrator for Business Analytics.

Pl Integrator for Business Analytics 2020 R2 SP2 esta disponible para descargar.
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¢Qué es Pl Integrator for Business Analytics?

;Que es
Pl Integrator for Business Analytics?

Pl Integrator for Business Analytics presenta los datos de Pl System perfectamente adaptados a herramientas de
inteligencia empresarial, incluidas, entre otras, Tableau, Tibco Spotfire, QlikView y Microsoft Power Bl para
informes y analisis. Las herramientas cliente de inteligencia empresarial (Bl) proporcionan la capacidad de
ejecutar andlisis retrospectivos en un conjunto mucho mayor de los datos en tiempo real de Pl System. Bl lo
ayuda a aprender de los comportamientos y patrones operativos, e identifica dependencias y correlaciones de
diferentes factores en sus operaciones.

Los datos temporales nativos, el contexto de activos y el contexto de eventos estan expuestos a través de las
views configuradas en la web. Los datos se modelan teniendo en cuenta la dimensidn, se limpian y se presentan
con metadatos adecuados, de modo que las herramientas de Bl pueden examinar, consultar y usar
correctamente datos de Pl System. Los datos se pueden integrar y cargar directamente en plataformas de
almacenamiento de datos. Pl Integrator for Business Analytics elimina la necesidad de realizar programaciones o
tener experiencia en SQL y administra el ciclo de vida de datos completo, lo que incluye el acceso, las
actualizaciones y la procedencia de los datos.

Pl Integrator for Business Analytics requiere un modelo de Pl Asset Framework (Pl AF) para seleccionar datos de
Pl System a fin de generar datos para la toma de decisiones. Los datos se pueden limpiar con varios filtros y
mejorar con activos, eventos y contexto temporal de Pl System. Los datos resultantes se pueden usar de
inmediato en las herramientas de Bl sin ninguna otra modificacion.

Ventajas de PI Integrator for Business Analytics

Las ventajas de utilizar PI Integrator for Business Analytics son las siguientes:

¢ Los grandes conjuntos de datos se pueden seleccionar e importar facilmente. No se requiere codificacion
para preparar los datos y no se requiere conocimiento de los datos de origen.

¢ Eltamafio del conjunto de datos se puede aumentar sin requerir la personalizacidn de los procedimientos de
importacién de datos.

¢ Los datos de Pl System pueden fusionarse con otros conjuntos de datos para el analisis de nivel agregado.
Ademas, una variedad de herramientas de inteligencia empresarial, almacenes de datos y plataformas de
transmision pueden consumir estos datos.

¢ Los datos publicados se sincronizan con Pl System y se actualizan automaticamente para reflejar los cambios.
¢ Los datos se actualizan segln un programa o en respuesta a los cambios de los valores clave.

¢ Lainterfaz de usuario basada en la Web es facil de usar y no requiere instalacion por parte de usuarios
finales.

Advertencias sobre el uso de Pl Integrator for Business Analytics

Tenga en cuenta la siguiente informacidn sobre Pl Integrator for Business Analytics:

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 8
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¢ Pl Integrator for Business Analytics solo admite datos con marcas de tiempo en el pasado. En la actualidad,
no se admiten datos del futuro.

¢ Pl Integrator for Business Analytics publica los datos de Pl System en una gran variedad de destinos. No
obstante, no escribe las modificaciones de los destinos nuevamente en Pl Data Archive o el servidor AF.

¢ Las vistas de transmisidn estan disefiadas para ayudarlo a poner en funcionamiento un modelo de
aprendizaje automatico o un analisis mediante la alimentacién de datos casi en tiempo real. Las vistas de
transmision no actian como sincronizacién en tiempo real de Pl System en su totalidad y pueden encontrar
problemas de rendimiento debido al aumento de la sobrecarga en Pl Integrator.

¢ Las vistas de flujo activadas mediante una clave pueden comenzar a experimentar problemas de
rendimiento con 100 a 200 coincidencias en una sola vista.

e Las vistas de transmisidn programadas pueden manejar varios miles de coincidencias por vista,
dependiendo de otros factores de rendimiento. Existe un limite estricto de 25 000 coincidencias totales
de la figura de busqueda por vista.

¢ Elservicio Pl Integrator Sync requiere que solo un miembro del colectivo de Pl Data Archive tenga un nivel de
prioridad 1 en cualquier momento. Pl Integrator Sync no admite varios miembros con el nivel de prioridad 1.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 9



'AV EVA\TM Pl Integrator for Business Analytics
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Ediciones de PI Integrator for Business
Analytics

Existen dos tipos de ediciones de PI Integrator for Business Analytics:

e Estandar

La edicidn Estandar es una solucidn empresarial para clientes que desean publicar sus datos de Pl System en
un almacén de datos externos. Una vez que se exportan a estos almacenes de datos, los datos de Pl System
se pueden fusionar con datos de otros sistemas.

e Avanzada

Ademds de publicar datos en almacenes de datos externos, la edicion Avanzada admite la transmisién de
datos a destinos de transmisidon compatibles. Cuando se publican, estos datos pueden utilizarse para
preparar a las aplicaciones de aprendizaje automatico para que descubran patrones y predigan
comportamientos futuros.

Destinos de publicacion compatibles

En la siguiente tabla se muestran los distintos destinos de publicacion compatibles con cada edicidn y los tipos de
vistas que son compatibles con cada uno de los destinos. Para obtener mas informacidn sobre las vistas, consulte
Vistas de Pl Integrator for Business Analytics.

Tipo de Destino de Formato Vistas compatibles Edicion Edicion
destino salida P Estandar Avanzada
Vistas de Vistas de Vistas de
activos eventos transmision
pestafia Archivo de | row-column / / / /
texto
Base de Microsoft row-column J / / J
datos SQL Server
relacional
oase de v v v v
datos
Oracle
sase de v v v v
datos SQL
de Azure

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 10



AV=VA"

Pl Integrator for Business Analytics
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Tipo de
destino

Destino de
salida

Formato

Vistas compatibles

Edicion
Estandar

Edicion
Avanzada

SAP HANA (
ODBC)

v

v

v

Almacén de
datos

Apache
Hive

Grupo SQL
dedicado de
Azure

Amazon Re
dshift

Google Big
Query

row-column

Data Lake

Sistema de
archivos
distribuido
Hadoop
(HDFS)

Amazon S3

Google Clou
d Storage

Azure Data
Lake Storag
eGen2

row-column

ANAANA NI NENERNERNENE VR
AN NI N VNI NI NN

NNN NN XN XN XX

Centro de
mensajeria

Apache
Kafka

Azure loT
Hub

Centros de
eventos de
Azure

Flujos de
datos de

flujo

AN NI NN

ANEENENE NI NE N NI NE NI NENER NERN
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Tipo de Destino de Formato Vistas compatibles Edicion Edicion
destino salida P Estandar Avanzada
Amazon
Kinesis
Google Clou J
d Pub/Sub
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Arquitectura del sistema

En el diagrama siguiente, se muestra una arquitectura tipica de un sistema de
Pl Integrator for Business Analytics.

Arquitectura del sistema de PI Integrator for Business Analytics

Hadeop Azure MS 50 o ® »
B FRepresents separate processes

B FRepresents required services
Destination Targets

En la siguiente seccion, se describen los componentes necesarios para los destinos del almacén de datos. Los
procesos de Pl Integrator Framework, Pl Integrator Worker Nodes y Pl Integrator Sync residen en el mismo
equipo.

¢ Pl Integrator Framework
Pl Integrator Framework realiza las siguientes funciones:
¢ Proporciona la aplicacion web mediante la cual las vistas se pueden crear, publicar y administrar.
e Programa las tareas que se publicaran.

¢ Distribuye las tareas entre los Pl Integrator Worker Nodes para equilibrar la publicacién de vistas entre
los nodos. En este diagrama, existe solo un nodo de trabajador.

¢ Realiza el seguimiento y administra los flujos de salida utilizados en las vistas.

¢ Registra los datos estadisticos de la vista, que incluyen el tiempo para publicar la vista, el nimero de filas
escritas, el nUmero de filas filtradas y el conteo de errores.

¢ Pl Integrator Sync

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 13
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Arquitectura del sistema

Pl Integrator Sync monitorea los siguientes datos:
¢ los cambios de los datos y las figuras de las vistas de activos y las vistas de transmisién programadas;
¢ los cambios de la figura de las vistas de transmisiéon desencadenadas por valores clave.
¢ Pl Integrator Worker Node

Pl Integrator Worker Node publica tareas en los destinos de salida. Pueden instalarse nodos de trabajador
adicionales para mejorar el rendimiento.

¢ Pl Asset Framework (Pl AF)

Pl Integrator for Business Analytics recupera y actualiza definiciones de vista almacenadas en la base de
datos de configuraciéon de PI AF.

e SQL Server
Las estadisticas, los registros y las tablas de metadatos se almacenan en SQL Server.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 14
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Requisitos del sistema

Requisitos para Pl Integrator for Business Analytics

En esta seccidn, se describen los requisitos del sistema para una instalacion de
Pl Integrator for Business Analytics y para cada uno de los objetivos de publicacién admitidos.

A continuacion, se presentan los requisitos del sistema para Pl Integrator for Business Analytics:

e Pl Server 2018 o posterior
* Pl Asset Framework
¢ Archivo de Datos

e PIAF SDK 2024

Nota: Pl AF SDK 2024 estd incluido en el cliente de Pl AF 2024. El cliente de Pl AF 2024 se incluye con
Pl Integrator for Business Analytics 2020 R2 SP2. Para utilizar las funciones de idioma y regidn, se debe
instalar la funcidén Paquetes de idioma para el cliente de Pl AF 2024.

¢ 16 GB de memoria y 2 nucleos modernos de CPU

Nota: Estos requisitos son suficientes para instalar un minimo de un proceso de nodo de trabajador. Para
cada proceso de nodo de trabajador adicional que desee instalar en el mismo equipo, agregue 4 GB de
memoria adicionales y dos nucleos modernos de CPU.

e Microsoft Windows Server 2016, 2019, 2022

Nota: Microsoft Windows Server debe ser parte de un dominio y no se puede instalar en un equipo que no
esté unido a Active Directory de Windows. (Los equipos unidos a WORKGROUP no son compatibles para la
implementacién de este producto).

e Microsoft SQL Server 2016, 2017, 2019 y 2022 Instale el servidor de Microsoft SQL en el mismo dominio que
el usuario que realiza la instalacidn o en un dominio que confie en el dominio del usuario que realiza la
instalacién. El usuario que realiza la instalacién debe poder autenticar mediante la autenticacion de
Windows en SQL Server de backend, aunque se especifique la autenticacién de SQL. No instale SQL Server de
backend de Pl Integrator for Business Analytics en un grupo de trabajo o un dominio que no confie en el
dominio del usuario que realiza la instalacion.

Nota: Para obtener un mejor rendimiento, se recomienda la versién completa de SQL Server.

¢ El componente de busqueda de texto completo de Microsoft SQL Server es un requisito para
Pl Integrator for Business Analytics. La busqueda de texto completo le permite al servicio de
Pl Integrator Framework indexar y administrar grandes cantidades de PI tags y llevar un registro de los
cambios en las figuras de la vista. Tenga en cuenta que el componente de busqueda de texto completo es un
componente opcional del motor de la base de datos de SQL Server que puede agregar durante la instalacion
de Microsoft SQL Server o posteriormente, cuando ejecute la instalaciéon de SQL Server. Instale antes de
actualizar PI Integrator for Business Analytics.

Requisitos del explorador web

Use uno de los siguientes exploradores web:
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¢ Versidn reciente de Google Chrome

¢ \ersion reciente de Microsoft Edge

Requisitos de destinos de publicacion para la base de datos Oracle
Requisitos de destino de publicacién para la base de datos Oracle:
¢ Cliente de Oracle para Microsoft Tools 19c (64 bits)
Pl Integrator for Business Analytics admite las siguientes versiones de la base de datos Oracle:

e Base de datos Oracle 23c versién para Microsoft Windows (x64)

Requisitos de destino de publicacion para SAP HANA ODBC

Requisitos de destino para SAP HANA ODBC:

e SAP HANA Client
Pl Integrator for Business Analytics se ha probado con las siguientes versiones de SAP HANA Client:
e SAP HANA Client, version 2.3.144, Windows x64
e SAP HANA
Se admiten las siguientes versiones de SAP HANA:
e SAP HANA, version 2.0, SPS 03

Requisitos de destino de Amazon Web Services

Amazon Web Services requiere la version actual de los siguientes servicios:

¢ Flujos de datos de Amazon Kinesis
e Amazon Redshift

e Amazon S3

Controlador ODBC de Amazon Redshift

Pl Integrator for Business Analytics se ha probado con las siguientes versiones del controlador ODBC de
Amazon Redshift:

e Controlador ODBC de Amazon Redshift (x64) version 1.5.9.1011

Versiones probadas de Apache Hadoop
Pl Integrator for Business Analytics se ha probado con los siguientes software:

e HortonWorks —HDP 3.1.0.0
¢ Apache Hive - 3.1.0
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Requisitos del sistema

e HDFS-3.1.1
Nota: Pl Integrator for Business Analytics no se ha probado con Apache Hive con CDH (Cloudera).

Versiones probadas de Apache Kafka

Pl Integrator for Business Analytics se ha probado con las siguientes versiones de Apache Kafka: 3.9x, 3.8x, 3.7x.

Versiones probadas de Apache Thrift

Pl Integrator for Business Analytics se ha probado con Apache Thrift 0.9.3.0. Pl Integrator for Business Analytics
probablemente también funcione con otras versiones.

Requisitos de Google Cloud
Version actual de uno o mas de los siguientes servicios de Google Cloud Platform:

¢ Google Cloud Storage
¢ Google BigQuery
¢ Google Cloud Pub/Sub

Requisitos de Microsoft Azure
Version actual de uno o mas de los siguientes servicios de Microsoft Azure:

e Centros de eventos de Azure

e Azure loT Hub

e Base de datos SQL de Azure

e Grupo SQL dedicado de Azure
¢ Azure Data Lake Storage Gen 2

Version probada de Schema Registry

Pl Integrator for Business Analytics se ha probado con Confluent Schema Registry 4.0.0.
Pl Integrator for Business Analytics probablemente también funcione con otras versiones.
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Como instalar Pl Integrator for Business
Analytics

Pl Integrator for Business Analytics se compone de las siguientes fases de instalacidn:

¢ Fase 1: prepararse para la instalacion

Esta fase asegura que tenga el acceso y los permisos adecuados para los componentes que interactdan con
Pl Integrator for Business Analytics: servidor de Pl AF, Pl Data Archive y Microsoft SQL Server. Estos requisitos
previos deben estar vigentes antes de ejecutar el kit de instalacién para PI Integrator for Business Analytics.

¢ Fase 2: Instalacién de Pl Integrator for Business Analytics

En esta fase, usted instala Pl Integrator for Business Analytics y especifica el servidor de Pl AF y Microsoft SQL
Server. Se crean nuevas bases de datos de Pl Integrator en Microsoft SQL Server para Pl Integrator for
Business Analytics.

¢ Fase 3: verificar la instalacion

En esta etapa, se comprueba que los servicios de Pl Integrator for Business Analytics se hayan iniciado y
estén en ejecucion.

Los siguientes temas describen los pasos para cada fase de la instalacion con mas detalles:

e Fase 1: Preparar para instalar Pl Integrator for Business Analytics
e Fase 2: Instalar Pl Integrator for Business Analytics

e Fase 3: verificar la instalacién

Fase 1: Preparar para instalar Pl Integrator for Business Analytics

Los siguientes componentes son necesarios para una instalacién exitosa de PI Integrator for Business Analytics:
Pl Server (que incluye el servidor de Pl Asset Framework y Pl Data Archive) y Microsoft SQL Server (que incluira
las bases de datos que almacenan los metadatos para vistas continuas y las bases de datos de estadisticas y
registros de Pl Integrator for Business Analytics).

1. Asegurese de que se cumplan los requisitos minimos y se instale el software requerido. Consulte Requisitos
del sistema.

2. Considere dénde instalara los componentes en su instalacion de Pl Integrator for Business Analytics.

3. El producto de Pl Integrator se puede instalar utilizando cuentas virtuales de Windows o cuentas de usuario
de dominio de Windows. El sistema operativo Windows administra las contraseias de las cuentas virtuales y
de las cuentas de servicios administrados. La opcidn de instalacion predeterminada es usar cuentas virtuales
gue no requieren especificar el nombre de usuario o la contrasefia. Si utiliza cuentas de usuario de dominio
de Windows, obtenga un nombre de usuario de cuenta de servicio de Windows. Si no utiliza una cuenta de
servicios administrados (MSA) o una cuenta de servicios administrados grupal (gMSA), necesitara una
contrasefia para su dominio. Es probable que deba comunicarse con el administrador del departamento de
Tl para crear uno para usted.
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Nota: Para una implementacién de mayor seguridad, recomendamos usar una cuenta de servicios
administrados (MSA), una cuenta de servicios administrados grupal (gMSA) o cuentas virtuales, pero
también se admite una cuenta de usuario de dominio estandar dedicada a ejecutar el servicio.

4. Lacuenta de usuario utilizada para instalar Pl Integrator for Business Analytics debe ser un usuario de
dominio con privilegios de administrador local, ubicado en Microsoft Windows Server donde se instalara Pl
Integrator for Business Analytics.

5. Asegurese de que la cuenta de usuario utilizada para instalar el software tenga privilegios de sysadmin en el
SQL Server en el que instalara las bases de datos de PI Integrator. Esto es necesario para crear las bases de
datos SQL de backend de PI Integrator.

Nota: Si la cuenta de usuario no puede obtener los privilegios necesarios, un usuario, en general un
administrador de la base de datos que si tiene privilegios de sysadmin, debe crear manualmente las bases de
datos SQL. En esta situacidn, las bases de datos SQL deben crearse primero, antes de instalar

Pl Integrator for Business Analytics.

Nota: Vaya al Portal de Clientes de OSlsoft para descargar la utilidad SQL de

Pl Integrator for Business Analytics que contiene el script que crea las bases de datos. Después de instalar las
bases de datos SQL, agregue la cuenta de usuario que instalara Pl Integrator for Business Analytics como
inicio de sesion en SQL Server.

El usuario que instala Pl Integrator for Business Analytics debe tener los siguientes permisos:

Membresia de rol en base de datos db_accessadmin en PlintegratorDB y bases de datos PlintegratorStats y
PlintegratorLogs

Membresia de rol de base de datos db_datareader para la base de datos PlintegratorStatus

6. La cuenta de usuario utilizada para instalar Pl Integrator for Business Analytics debe asignarse a la identidad
del administrador de Pl AF.

7. Compruebe que estén disponibles los siguientes puertos. En la siguiente tabla, se describe cémo se utilizan
estos puertos en la arquitectura de Pl Integrator for Business Analytics.

Funcionalidad Aplicacion Protocolo Puerto Direccién Configurado en
remota

Conexién de Pl | PI AF TCP 5457 Entrante Servidor de PI

Integrator for AF

Business

Analytics a PI AF

Conexién de Pl | Archivo de TCP 5450 Entrante Servidor de

Integrator for Datos Archivo de

Business Datos

Analytics a

Archivo de

Datos

Conexion de PI | Pl Integrator for | TCP 14331 Entrante SQL Server

Integrator for Business

Business Analytics

Analytics a la

base de datos

sQL
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Funcionalidad Aplicacion Protocolo Puerto Direccién Configurado en
remota

Conexiones de | Navegador web | TCP 4432 Entrante Servidor de PI

cliente ala cliente Integrator for

interfaz de Business

usuario de Pl Analytics

Integrator for

Business

Analytics

Datos salientes | Microsoft Azur | TCP 5671 3 Saliente Servidor de PI

de Pl Integrator |eloT Hubo Integrator for

for Business Centro de Business

Analytics (solo | eventos de Analytics

son necesarios | Microsoft Azure

para Microsoft

Azure loT Hub o

Microsoft Azure

Event Hub)

1 Se puede configurar esta conexion para usar un puerto dindmico.

2 El puerto predeterminado de HTTPS es 443, pero se puede especificar un puerto alternativo durante la instalacién de

Pl Integrator for Business Analytics. El puerto 80 no se puede utilizar debido a una convencién de Internet.

3 Es posible que Microsoft cambie estos puertos a lo largo del tiempo. Consulte la documentacién de Microsoft para acceder a la
informacion mas actualizada.

8. (Opcional) Comuniquese con el administrador del departamento de Tl para solicitar a una entidad de
certificacion que emita un certificado al servidor que ejecuta Pl Integrator for Business Analytics. En el
asunto del certificado, deberia incluirse el nombre de dominio totalmente calificado (FQDN) del servidor, en
tanto que el nombre alternativo del asunto deberia incluir el FQDN y el nombre de host de este servidor.

El certificado también debe cumplir los siguientes criterios:

¢ El certificado debe estar instalado en la tienda personal del equipo local. Como referencia, el certificado
Pl Web API tiene los mismos requisitos y se enumeran en la seccidén problemas comunes de instalacion
de la guia del usuario del producto.

¢ El certificado no debe estar vencido.

¢ El certificado debe tener una clave privada.

¢ El certificado debe ser un certificado SHA-2.

¢ El certificado debe tener una cadena de confianza valida.

9. (Opcional) Péngase en contacto con su administrador de Tl si esta instalando
Pl Integrator for Business Analytics en un entorno donde hay varios controladores de dominio o un
controlador de dominio de solo lectura. Es posible que haya requisitos de puerto adicionales para estos
entornos. Para ver mas informacién, consulte la documentacion de Microsoft en Requisitos de puerto de los
servicios de Active Directory y Active Directory Domain.

10. Sila cuenta que ejecutard el servicio Pl Integrator Framework es una Cuenta de Servicios Administrados
grupal (gMSA), se debe instalar el médulo Active Directory para Windows PowerShell en el equipo donde
esta instalado Pl Integrator for Business Analytics; consulte Instalar el médulo PowerShell de ActiveDirectory.
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11. Si hay una o mas instancias instaladas de Pl Integrator 1.x en el servidor de Pl AF en el que instala esta
instancia, primero debe actualizar todas las instancias 1.x a 2.x. De esta manera, se asegurard de que las
vistas de Pl Integrator 1.x continlen publicdndose luego de instalar la instancia 2.x.

12. Si prefiere establecer configuraciones de permisos y requisitos previos en los objetivos de publicacidn antes
de instalar Pl Integrator for Business Analytics, consulte la seccién Configuraciéon de los objetivos de
publicacion para obtener mas informacion.

Implementacion de Pl Integrator

A continuacion, se describen las distintas maneras en que puede implementarse Pl Integrator for Business
Analytics. En el diagrama de abajo se muestran varias implementaciones independientes de Pl Integrator for
Business Analytics. Cada instancia de Pl Integrator apunta a su propio servidor de Pl AF e instancia de SQL Server.

2y -
l *—l¢l
2y 8 o=
l "—l®-
2y 8 =
l l@i

Pl AF Pl Integrator for  S0L Server
Business Analytics

También es posible que se instalen varias instancias de Pl Integrator for Business Analytics en el mismo servidor
de PI AF, tal como se muestra a continuacion. Se crea un elemento de instancia Pl AF nuevo y Unico en la misma
base de datos de Pl AF para cada una de las instancias instaladas.

E:w
B Biw
E:w

Pl Integraor for S0l Server
Business Analytics

Por otro lado, multiples instancias de PI Integrator for Business Analytics pueden apuntar al mismo SQL Server,
tal como se muestra abajo. Cuando se instala cada instancia, comparte las mismas bases de datos SQL que las
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otras instancias, pero se crea un conjunto separado de tablas especificas de la instancia en estas bases de datos
de SQL Server para cada instancia de Pl Integrator for Business Analytics.

-— @—
2l -
B~ R:w-

PIAF Pl integrator for  SQLServer
Business Analytics

Nota: SQL Server también puede instalarse en un nodo totalmente separado de cualquiera de las instancias de PI
Integrator for Business Analytics.

En todos los casos, puede instalar una sola instancia de Pl Integrator en un nodo.

Fase 2: Instalar Pl Integrator for Business Analytics

La fase 2 comprende la instalacion de Pl Integrator for Business Analytics y la especificacion del servidor de Pl AF
y Microsoft SQL Server.

Antes de instalar Pl Integrator for Business Analytics:

¢ Asegurese de haber cumplido con todos los requisitos previos en: Fase 1: Preparar para instalar
Pl Integrator for Business Analytics.

Nota: Cada instancia de un producto de PI Integrator desarrollada en Pl Integrator Framework se debe
instalar en su propio equipo.

Inicie sesidn en el equipo en el que instalara Pl Integrator for Business Analytics.

2. Descargue la versidon mas reciente del kit de instalacién de Pl Integrator for Business Analytics del Portal de
clientes.

3. Haga clic con el botén derecho en el archivo ejecutable de instalacion y haga clic en Ejecutar como
administrador para ejecutar el asistente de instalacion.

Se abrird la ventana Archivo ejecutable autoextraible.
4. Especifique la ruta de extraccion para el instalador y haga clic en Aceptar.

Se abre la ventana Bienvenido a la instalacidn de Pl Integrator for Business Analytics en la que se enumeran
los distintos médulos incluidos con la instalacidn. El asistente de instalacién instala cada médulo o garantiza
gue ya exista el modulo en su equipo.

5. Hagaclic en OK.

6. Sino se habia instalado ningun producto de AVEVA en este equipo, siga estos pasos. De lo contrario, avance
al paso siguiente.

a. Enlaventana Servidores predeterminados, especifique el servidor de Pl Data Archive y, de manera
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opcional, el servidor de Pl AF, y haga clic en Siguiente.

b. En la ventana Directorios de instalacion, especifique las ubicaciones de instalaciéon de productos de
AVEVA. Puede aceptar los valores predeterminados o especificar otra ubicacién.

Nota: Pl Integrator for Business Analytics se instala en %PIHOME64%.

c. Haga clic en Siguiente.
En la ventana Bienvenido a la instalacion de Pl Integrator for Business Analytics, haga clic en Siguiente.
Se muestra la ventana Mejora de la experiencia de clientes.

En la ventana Informacidn de inicio de sesidn, seleccione Cuentas virtuales o Cuentas de usuario de
dominio. Si utilizard cuentas de usuario de dominio, especifique el Nombre de usuario (incluido el dominio)
y la Contrasefia de la cuenta de servicio de Windows que ejecutara los servicios de Pl Integrator Framework,
Pl Integrator Sync y Pl Integrator Worker Node.

Nota: Si la cuenta de servicio de Windows es una Cuenta de servicios administrados grupal (gMSA),
especifique el nombre de usuario con el siguiente formato: nombre de usuario$ y omita la contrasefa.

Haga clic en Siguiente.
Se abre la ventana Conexion de servidor AF.

Especifique el servidor de Pl AF en el que PI Integrator for Business Analytics almacenard las definiciones de
la vista y otros metadatos.

En el campo Servidor AF, ingrese el nombre o la ubicacion (direccién IP) del servidor de Pl AF.

Nota: Si encuentra un error, aseglrese de que la cuenta de usuario utilizada para instalar
Pl Integrator for Business Analytics se asigne a la identidad de AF de administradores en el servidor de Pl AF.

Haga clic en Siguiente.
Se abre la ventana SQL Server.

Especifique el Microsoft SQL Server en el que Pl Integrator for Business Analytics almacenara los metadatos
de vista, los datos estadisticos y los registros de Pl Integrator for Business Analytics.

Especifique solo el nombre de host (o el nombre de dominio totalmente calificado) si esta utilizando la
instancia predeterminada. Si esta utilizando una instancia con nombre, especifique el nombre de host (o el
nombre de dominio totalmente calificado), por ejemplo: mySQLserverBA1\PiViewlInstance.

Especifique de qué manera se autenticara Pl Integrator for Business Analytics con la base de datos
especificada de Microsoft SQL Server. Elija una de las opciones siguientes:

¢ Autenticaciéon de Windows (predeterminada)

Se usa el usuario de la cuenta de servicio de Windows como credencial para conectarse a Microsoft SQL
Server.

Nota: Si utiliza una cuenta de servicios administrados grupal (gMSA) o cuentas virtuales, debe usar la
autenticacion de Windows.

e Autenticacion de SQL Server

Nota: No se recomienda la autenticacidn de SQL Server. Cree un inicio de sesidn especificamente para el
servicio de Pl Integrator Framework.

Haga clic en Autenticacion de SQL Server para usar la autenticacion de SQL Server a fin de conectarse a
la base de datos especificada de Microsoft SQL Server.

Ingrese el nombre de usuario y la contrasena para el usuario dedicado de Microsoft SQL Server que tiene
el acceso necesario a Microsoft SQL Server.

Haga clic en Siguiente.
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Se abre la ventana Configuracién de puerto y certificado TLS.

15. Ingrese un numero de puerto disponible valido en el campo Ingresar un nimero de puerto y haga clic en
Validar puerto.

Nota: Este puerto se utiliza en un navegador web para conectarse a Pl Integrator for Business Analytics.

El puerto 80, por convencidn, estd asociado con un protocolo http que no es seguro. Debido a que solo se
admite https (protocolo seguro cifrado), el uso del puerto 80 esta restringido.

Consejo: Si usa el puerto predeterminado, 443, puede omitir este nimero de puerto cuando especifique la
direccién URL para PI Integrator for Business Analytics.

16. Elija un certificado TLS de una de las siguientes fuentes:

¢ (Recomendado) Certificado TLS de una entidad de certificacidon. Elija Importar certificado y haga clic en
Seleccionar certificado para elegir un certificado que haya sido emitido por una entidad de certificacion
e importado al equipo donde se estd instalando PI Integrator for Business Analytics.

¢ Certificado autofirmado que se genera durante la instalacion. Esto es lo predeterminado. Elija
Certificado autofirmado.

Nota: Si elige esta opcidn, los usuarios que inicien sesidn en equipos remotos pueden ver un mensaje de
advertencia de seguridad. Para evitar esta advertencia en los certificados autofirmados, el certificado
debe ser explicitamente confiable en el equipo cliente. Consulte la solucidn en el articulo de la Base de
conocimientos Se produce un error de certificado al navegar a un sitio web de Pl Vision o Pl Web API con
un certificado autofirmado.

17. Haga clic en Siguiente.

Nota: Si encuentra un error, asegurese de que el puerto esté sin usar y abierto.

18. Enlaventana Pl Integrator Worker Nodes, haga clic en la flecha y seleccione el nimero de nodos de
trabajador que desea instalar y, luego, haga clic en Siguiente.

Se abre la ventana Verificacion obsoleta de Pl View.

Nota: Cada nodo de trabajador requiere mas recursos de CPU y RAM. Para obtener mas informacidn sobre
los recursos necesarios, consulte Requisitos del sistema.

19. El paso Verificacion obsoleta de Pl View requiere que reconozca que el destino de Pl View estd en desuso.
Todas las vistas existentes que utilicen el destino de Pl View se deshabilitaran para la publicacién después de
la instalacidn.

¢ (Recomendado) Un scan esta disponible para detectar cualquier vista en su sistema que utilice el destino
de Pl View. Si el scan se completa correctamente, habra una lista de los nombres de las vistas
detectadas, asi como un enlace al archivo de lista exportado en el directorio %PIHOME%\dat. Puede
utilizar este scan para identificar las vistas de Pl View que se pueden eliminar o migrar al destino de
Microsoft SQL Server como alternativa. Para obtener instrucciones sobre cdmo migrar vistas mediante el
destino de PI View a Microsoft SQL Server, consulte Migrar el destino de Pl View al destino de
Microsoft SQL Server.

¢ Sise produce un error durante el scan, aparecera un mensaje. Haga clic en Aceptar para cerrar el
didlogo.

¢ Siel scan se realiza correctamente, pero la lista no se puede exportar, tome nota de forma manual
de los nombres de las vistas.

Haga clic en la casilla de verificacion de confirmacidn para continuar con la instalacién. Haga clic en
Siguiente.

Se abrird la ventana Listo para instalar la aplicacion.
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20. Haga clic en Instalar.
Se abre la ventana Actualizando sistema que muestra el progreso de la instalacién.

21. Cuando finaliza la instalacion, aparece la ventana Instalacion completa. Haga clic en Close.

Fase 3: verificar la instalacidon

Luego de terminar de instalar Pl Integrator for Business Analytics, verifique que se estén ejecutando los servicios.

Inicie sesidn en el equipo que aloja Pl Integrator for Business Analytics.
2. Abra Servicios.
3. Verifique que se hayan incluido y se estén ejecutando los servicios de Pl Integrator for Business Analytics.
Debe ver los siguientes servicios:
¢ Pl Integrator Framework
e Pl Integrator Sync
¢ Pl Integrator Worker Node 1

¢ Pl Integrator Worker Node n(Vera un servicio para cada nodo de trabajador creado).

Nota: Los servicios de Pl Integrator Sync y Pl Integrator Worker Node se instalan con el tipo de inicio
configurado como Manual. PI Integrator Framework Service reinicia automaticamente los servicios segun sea
necesario. Si se requiere un reinicio de servicio manual, cierre todos los servicios de Pl Integrator e inicie PI
Integrator Framework Service. No inicie los otros servicios manualmente; esto producird un comportamiento
inesperado.

4. Abra un explorador web.
Ingrese la direccién URL de Pl Integrator for Business Analytics.

La direccidon URL sefala el equipo y puerto host para Pl Integrator for Business Analytics. La URL es
https://<hostname>:<port number> o https://<fqdn>:<port number>, donde FQDN es el nombre de dominio
completo.

Si instald Pl Integrator for Business Analytics en un host denominado /ab5 en el dominio prod.onet.comy lo
configurd para usar el puerto 7777, podria ingresar cualquiera de las siguientes opciones:

e https://lab5.prod.onet.com:7777
e https://1lab5:7777

Instalacion silenciosa

En esta seccidn, se describe cdmo instalar Pl Integrator for Business Analytics en segundo plano.

Antes de instalar Pl Integrator for Business Analytics, asegurese de haber cumplido con todos los requisitos
previos en Fase 1: Preparar para instalar Pl Integrator for Business Analytics.

Nota: Instale un producto de Pl Integrator desarrollado en Pl Integrator Framework en su propio equipo. Por
ejemplo, Pl Integrator for Business Analytics y Pl Integrator for SAP HANA no pueden instalarse en el mismo
equipo, ni pueden hacerlo dos instancias de Pl Integrator for Business Analytics.

Para instalar Pl Integrator for Business Analytics en segundo plano:
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Inicie sesidn en el equipo en el que instalara Pl Integrator for Business Analytics.

2. Descargue la versidon mas reciente del kit de instalacidén de Pl Integrator for Business Analytics del Portal de
clientes.

3. Haga clic con el botén derecho en el archivo ejecutable de instalacion y haga clic en Ejecutar como
administrador para ejecutar el asistente de instalacion.

Se abrird la ventana Self-Extracting Executable.
4. Especifique la ruta de extraccidon para el instalador y haga clic en Aceptar.

Se extraen los archivos en la ubicacién especificada. Cuando se completa esta accion, se muestra la ventana
Bienvenido a la configuracién de Pl Integrator for Business Analytics 2020.

Haga clic en Cancelar.
Ubique el archivo de configuracion silent.ini en la carpeta.

Edite el archivo de configuracién. Especifique los siguientes parametros en la linea de componentes de PI
Integrator de la seccion [COMMAND LINE] y modifique el valor predeterminado "7 = /g ALLUSERS=1
REBOOT=Suppress REINSTALLMODE=dmus SENDTELEMETRY=0".

Parametro Descripcion

SERVICEACCOUNT Este valor se establece de forma predeterminada en
NT SERVICE\<PI Integrator Service Name>, que
instalara Pl Integrator mediante cuentas virtuales.
También puede especificar una cuenta de servicio
de Windows que ejecuta el servicio de

Pl Integrator Framework.

SERVICEPASSWORD Contrasefia de cuenta de servicio.

Nota: Si utiliza una cuenta de servicios
administrados grupal (gMSA) o cuentas virtuales,
omita este pardmetro.

AFSERVER Servidor de Pl AF que almacena informacién sobre
la configuracién de Pl Integrator.

SQLSERVER SQL Server que utiliza Pl Integrator para almacenar
los metadatos de la vista. Si utiliza una instancia con
nombre asignado, también debe especificarla.

USERPORT Puerto que utiliza Pl Integrator para conectarse con
el navegador web.

SQLHOSTNAME Nombre de la maquina que aloja SQL Server. Si hay
una instancia con nombre asignado, especifique
también la instancia con nombre.

SENDTELEMETRY (Opcional) Si se encuentra configurado con el valor
predeterminado 1, el cliente acepta participar en el
programa de comentarios de clientes de Pl System.
Configure el valor en 0 para salir del programa.
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INSTANCEELEMENTNAME

(Opcional) Elemento de Pl AF que contiene
informacion especifica de la instancia de

Pl Integrator. Utilice la préxima instancia disponible.
Si no se indica lo contrario, el valor predeterminado
es Instancel. Verifique la base de datos de la
configuracién en el servidor de Pl AF para conocer la
préxima instancia disponible.

CERTIFICATE_SELECTED

(Opcional) Si utiliza un certificado personalizado,
establezca en 1. Si el valor no esta especificado, se
utiliza el certificado autofirmado creado por el
instalador.

CERTIFICATE_THUMBPRINT

(Opcional) Huella digital del certificado
personalizado que utilizara PI Integrator. Si se utiliza
una huella digital, el campo CERTIFICATE_SELECTED
debe estar configurado en 1.

SQLUSERACCOUNT

(Opcional) Si utiliza una autenticacién SQL, configure
la cuenta de SQL que utiliza PI Integrator para
acceder a la instancia de SQL Server.

Nota: Si utiliza una gMSA o cuentas virtuales, no
puede usar la autenticacion SQL. Omita este
parametro.

SQLUSERPASSWORD

(Opcional) Contrasefia de la cuenta de SQL.

Nota: Si utiliza una gMSA o cuentas virtuales, no
puede usar la autenticacion SQL. Omita este
parametro.

8. Abra un simbolo del sistema como administrador y ejecute el siguiente comando: Setup.exe -f silent.ini

Tareas posteriores a la instalacion

Después de instalar Pl Integrator for Business Analytics, dirijase a la URL de Pl Integrator Framework Service. Para
obtener mas informacién, consulte Iniciar Pl Integrator for Business Analytics.

Luego realice las siguientes tareas antes de comenzar a usar el Pl Integrator for Business Analytics:

e Agregue las bases de datos y los servidores de Pl AF desde los que obtendra acceso a los datos de sistema de

PIl. Consulte Agregar servidores y bases de datos Pl AF.

e Agregue usuarios que podran crear views. Consulte Agregar y configurar identidades.

¢ Complete las tareas de configuracién requeridas para el destino de publicacién. Consulte Configurar los

destinos de publicacién.

¢ Pl Integrator no otorga permisos para los datos de origen utilizados por las vistas de Pl Integrator. La
identidad del usuario que crea la vista ya debe tener acceso de lectura y datos de lectura a los datos de
origen en AF. Verifique que la cuenta de servicio de Windows de Pl Integrator for Business Analytics tenga los
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siguientes permisos:

¢ Acceso de lectura y datos de lectura a nivel del servidor AF para todos los servidores de Pl AF a los que PI
Integrator for Business Analytics deba acceder para publicar los datos

e Acceso de lectura y datos de lectura en cualquier base de datos de Pl AF y cualquiera de sus objetos
secundarios (elementos, categorias, plantillas, etc.) a los que PI Integrator for Business Analytics deba
acceder para publicar los datos

¢ Acceso de lectura en Pl Data Archive a la tabla de PIPoint en Seguridad de la base de datos

¢ Acceso de lectura en Pl Data Archive a la seguridad del punto y los datos en todos los Pl Points a los que
Pl Integrator for Business Analytics deba acceder para publicar los datos

Nota: La cuenta de servicio requiere permisos de Pl Data Archive porque Pl Integrator Framework
Service consulta a Pl Data Archive directamente para obtener los datos de atributo de Pl AF que son
referencias de datos de PI Point.

Agregar servidores y bases de datos Pl AF

Puede especificar servidores de Pl AF adicionales que contengan datos que se puedan usar en sus vistas.

Haga clic en el icono del menu E y en Administracion.
2. Enla pagina Administracion, haga clic en la pestafia Bases de datos de AF.

3. Enlaseccién de la pagina Agregar un nuevo Servidor AF, ingrese el nombre o la ubicacidn (direccién IP) del
servidor de Pl AF en el campo Servidor AF.

4. Siel servidor de PI AF no esta usando el puerto predeterminado (5457), especifique el puerto que usara en
el campo Puerto.

5. Haga clic en Agregar Servidor AF.

Agregar y configurar identidades

Vea los pasos a continuacidon para crear una identidad nueva, agregar usuarios a la identidad y configurar el
acceso de la identidad a los objetivos de publicacidn y las vistas. Estas identidades administran el acceso del
usuario a la interfaz de usuario (Ul) de Pl Integrator for Business Analytics, asi como también los permisos para
acceder y configurar vistas y objetivos de publicacion.

Haga clic en el icono del menu E y en Administracion.
2. Enla pagina Administracion, haga clic en la pestafia Usuarios.
Se abre la pagina Permisos de acceso del usuario.
3. Haga clic en Add Identity (Agregar identidad).
Se abre el cuadro de didlogo Add Identity (Agregar identidad).
4. Realice una de las siguientes acciones:
e Escriba el nombre de la nueva identidad en el campo Nombre de la identidad y haga clic en Crear.
¢ Seleccione una identidad de la lista y haga clic en Aceptar.

En la lista, se muestran todas las identidades asociadas con el servidor de Pl AF que aloja la configuracion
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para Pl Integrator for Business Analytics.

El campo Nombre se completa con la identidad.

Identities Users and Groups
Identity Description
. Pi Integrator Service Created by P| Integrator Setup Kit

L Created By Advanced Edition

2 Human Resources Created By Advanced Edition

& customer Support Created Edition

L Administrators Administrator security access SaL Server

*) Add Target

dministrato View Permissions

Haga clic en Add User to Identity (Agregar usuario a la identidad) para agregar los usuarios de Windows
Active Directory a la identidad.

En el cuadro de didlogo Add Users and Groups (Agregar usuarios y grupos), ingrese el dominio y el nombre
de usuario en el campo domain\user (dominio/usuario).

Utilice el formato dominio\usuario. Opcionalmente, puede ingresar el nombre completo del usuario en el
campo nombre completo.

Haga clic en Search.

Aparece una lista de usuarios de Active Directory que coinciden con los criterios ingresados que se muestran.
Seleccione un usuario de la lista y haga clic en Aceptar.

El usuario aparece en la lista Usuarios y Grupos.

Haga clic en Agregar objetivo para conceder acceso a la identidad a los objetivos de publicacién.

Si los objetivos deseados no aparecen en esta lista, primero cree el objetivo y luego concédale a la identidad
el acceso a este.

En el cuadro de didlogo Add Publish Targets (Agregar objetivos de publicaciéon), seleccione los objetivos cuyo
acceso desea concederle a la identidad y haga clic en Aceptar.

Los objetivos aparecen en la lista Objetivos de publicacion permitidos.
Haga clic en Agregar permisos de vista para concederle a la identidad el acceso a las vistas existentes.

En el cuadro de didlogo Agregar permisos de vista, seleccione las vistas cuyo acceso desea concederle a la
identidad y haga clic en Aceptar.

Las vistas aparecen en la lista Ver permisos.

Haga clic en la flecha y elija uno de los siguientes permisos (consulte Ver permisos para obtener mas
detalles):

¢ Lector
¢ Propietario

Haga clic en la casilla de verificacién Administrador para otorgar a la identidad de AF seleccionada acceso a
la pagina Administracidn de Pl Integrator for Business Analytics.
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Puede actualizar a Pl Integrator for Business Analytics 2020 R2 SP2 desde las siguientes versiones:

e 2020 R2SP1

Actualizaciones provisionales

En el caso de versiones anteriores a 2020 R2 SP1, primero debe actualizar a
Pl Integrator for Business Analytics 2020 R2 SP1.

¢ No hay ruta de actualizacion directa de Pl Integrator for Business Analytics 2020 R2 parche 2 y versiones
anteriores a Pl Integrator for Business Analytics 2020 R2 SP2.

En el caso de versiones anteriores a 2020, primero debe actualizar a Pl Integrator for Business Analytics 2020.

¢ No hay ruta de actualizacion directa de PI Integrator for Business Analytics 2018 R2 SP2 y versiones
anteriores a Pl Integrator for Business Analytics 2020 R2 SP1 o posteriores.

e Descargue Pl Integrator for Business Analytics 2020 SQL Utility que contiene el script que actualiza las bases
de datos.

En el caso de versiones anteriores a 2018 R2, primero debe actualizar a Pl Integrator for Business Analytics 2018
R2.

¢ Siactualiza a Pl Integrator for Business Analytics 2018 R2 como version intermedia y Pl Integrator for
Business Analytics se estaba ejecutando en Pl AF Server 2014 o una versidn anterior, debe actualizar a PI AF
2015 o posterior antes de continuar. De lo contrario, los usuarios de Pl Integrator for Business Analytics
existentes no se convertiran automaticamente en identidades de Pl AF. Para obtener mas informacidn,
consulte Permisos de acceso del usuario.

¢ Sitiene varias instancias 1.x de Pl Integrator anteriores a 2018 instaladas en el mismo servidor de Pl AF, debe
actualizar todas las instancias a la version de 2020 o posterior (2.x). Si actualiza solo algunas y no todas las
instancias a 2.x, es posible que sus vistas de 1.x presenten errores de publicacidn tras la actualizacion.

¢ Sila cuenta de usuario utilizada para actualizar a Pl Integrator for Business Analytics 2018 R2 tiene una
membresia de rol a la base de datos db_accessadmin en las bases de datos PlintegratorDB, PlintegratorLogs
y PlintegratorStats, la cuenta de usuario también debe tener los privilegios SELECCIONAR, ACTUALIZAR y
MODIFICAR en la base de datos de PlintegratorStats. Si la cuenta de usuario no tiene otorgados permisos
para la actualizacion, debe actualizar las bases de datos de forma manual antes de realizarla.

Preparacion de la actualizacion

Antes de actualizar:
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e Verifique que la cuenta de servicio de Windows especificada ejecute Pl Integrator for Business Analytics en el
formato Dominio\Usuario. Si la cuenta de servicio usa el formato de nombre principal de usuario (UPN)
(cuenta@dominio.com), no podra realizarse la actualizacion. Debera revertir manualmente la cuenta de
servicio en services.msc al formato Dominio\Usuario vy, luego, continuar con la actualizacidn.

¢ Asegurese de tener privilegios de administrador local en el equipo donde instala
Pl Integrator for Business Analytics.

e Asegurese de que la cuenta de usuario utilizada para actualizar el software tenga privilegios de sysadmin en
SQL Server donde instalard las bases de datos de Pl Integrator. Esto es necesario para actualizar las bases de
datos SQL de backend de Pl Integrator.

¢ Sila cuenta de usuario no tiene los privilegios necesarios, un usuario con privilegios de sysadmin,

generalmente un administrador de la base de datos, debe actualizar las bases de datos SQL de forma
manual. Actualice primero las bases de datos SQL, antes que Pl Integrator for Business Analytics.

¢ Después de instalar las bases de datos SQL, agregue la cuenta de usuario que actualizard
Pl Integrator for Business Analytics como inicio de sesién en SQL Server. El usuario que actualiza
Pl Integrator for Business Analytics debe tener los siguientes permisos:

1. Membresia de rol en base de datos db_accessadmin en PlintegratorDB y bases de datos PlintegratorStats y
PlintegratorLogs

2. Permisos SELECCIONAR en la base de datos PlintegratorStats

Nota: Durante la actualizacidn, no podra especificar un servidor nuevo de Pl AF o SQL Server.

¢ Sila configuracién de seguridad de la suplantacién de la aplicacidn esta activada durante la instalacién y
Pl Integrator for Business Analytics estd instalado en un entorno de confianza de dominio de un solo sentido,
ejecute la herramienta de migracién de identidades en el mismo dominio que los usuarios de
Pl Integrator for Business Analytics antes de realizar la actualizacion. Consulte Como ejecutar la herramienta
de migracién de identidades para obtener mas informacion.

Procedimiento de actualizacion

Pl Integrator for Business Analytics instala archivos ejecutables. Si hay alguna vista en ejecucién cuando
comienza la actualizacidn o programada para ejecutarse mientras ocurre la actualizacién, Pl Integrator for
Business Analytics detiene o pospone las tareas antes de comenzar a actualizar los archivos ejecutables. Una vez
gue la actualizacidn esta completa, reinicia las tareas o reanuda la ejecucion de las tareas.

Si prefiere, puede detener manualmente las tareas que se estan ejecutando. Sin embargo, tendra que reiniciar
las tareas una vez que se haya completado la actualizacion.

1. Descargue el kit de instalacidn Pl Integrator for Business Analytics de Pagina Productos del portal de clientes
de AVEVA.

2. Haga clic con el botén derecho en el archivo ejecutable de instalacion y haga clic en Ejecutar como
administrador para iniciar el asistente de instalacién.

Se abrird la ventana Self-Extracting Executable.
3. Especifique la ruta de extraccién para el instalador y haga clic en Aceptar.

Se abre la ventana Bienvenido a la instalacién de Pl Integrator for Business Analytics en la que se enumeran
los distintos médulos incluidos con la instalacidn. El asistente de instalacién actualiza cada mddulo o
garantiza que ya exista la versidn correcta del médulo en su equipo.
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4. Haga clic en OK.

Se abre la ventana Bienvenido a la instalacién de Pl Integrator for Business Analytics.
5. Haga clic en Siguiente.

Se abre la ventana Informacién de inicio de sesion.

6. Especifique la Contraseiia para la cuenta de servicio de Windows que ejecuta los servicios de
Pl Integrator for Business Analytics.

7. Haga clic en Siguiente.
Se abre la ventana Configuracién de puerto y certificado TLS.

8. Ingrese un numero de puerto disponible valido en el campo Ingresar un nimero de puerto y haga clic en
Validar puerto.

La interfaz de usuario de PI Integrator for Business Analytics usa este puerto para conectarse con el
componente de Pl Integrator Framework Service.

Consejo: Si usa el puerto 443, puede omitir este nimero de puerto cuando especifique la direccién URL de
Pl Integrator for Business Analytics.

9. Elija un certificado TLS de una de las siguientes fuentes:

¢ (Recomendado) Certificado TLS de una entidad de certificacidn. Elija Importar certificado y haga clic en
Seleccionar certificado para elegir un certificado que haya sido emitido por una entidad de certificacién
e importado al equipo donde se esta instalando PI Integrator for Business Analytics.

¢ Certificado autofirmado que se genera durante la instalacién. Esto es lo predeterminado.

Nota: Si elige esta opcidn, los usuarios que inicien sesidon en equipos remotos pueden ver un mensaje de
advertencia de seguridad. Para evitar esta advertencia en los certificados autofirmados, el certificado debe
ser explicitamente confiable en el equipo cliente. Consulte la soluciéon en el articulo de la Base de
conocimientos Se produce un error de certificado al navegar a un sitio web de PI Vision o PI Web API con un
certificado autofirmado.

10. En laventana Pl Integrator Worker Nodes, haga clic en la flecha y seleccione el nimero de nodos de
trabajador que desea instalar y, luego, haga clic en Siguiente.

Se abrira la ventana Ready to Install the Application.

Nota: Cada nodo de trabajador requiere mas recursos de CPU y RAM.

Nota: Si encuentra un error, asegurese de que el puerto esté sin usar y abierto.

11. Haga clic en Siguiente.
Si tiene vista, se abre la ventana Backup de las vistas actuales . De lo contrario, avance al paso 13.
12. Haga clic en Realizar backup.

Este paso realiza un backup de la configuracién de la vista actual desde la base de datos de configuracién de
AF. Si el backup se completa correctamente, en este cuadro de didlogo, se mostrara su estado, asi como un
vinculo al archivo de backup en el directorio %PIHOME%\dat.

Si se produce un error, aparecera un mensaje. Haga clic en Aceptar para cerrar el didlogo de error.
En este punto, puede hacer lo siguiente:

¢ Resuelva el error y haga clic en Realizar backup.

¢ Realice el backup de forma manual en PI System Explorer. Para realizar esta accién:

¢ En el equipo donde esta instalado Pl Integrator for Business Analytics, ubique el archivo
%PIHOMEG64\Integrators\BA\CAST.UL.WindowsService.exe.config.
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Abra el archivo de configuracion y anote el valor de la clave InstancePath.

En Pl System Explorer, navegue hasta el elemento indicado por el elemento InstancePath.
Expanda el elemento usando la flecha a la izquierda para exponer el elemento Vistas.
Haga clic con el botdn derecho en el elemento Vistas y seleccione Exportar al archivo.

Seleccione las opciones Objetos referenciados incluidos e Incluir cadenas de seguridad. Tenga en
cuenta la ubicacién del archivo de backup.

Haga clic en OK.

¢ Continue sin realizar el backup (no se recomienda).

13. El paso Verificacion obsoleta de Pl View requiere que reconozca que el destino de Pl View esta en desuso.
Todas las vistas existentes que utilicen el destino de Pl View se deshabilitaran para la publicacién después de
la instalacién.

¢ (Recomendado) Hay un scan disponible para detectar cualquier vista del sistema que utilice el destino de
Pl View. Si el scan se completa correctamente, habra una lista de los nombres de las vistas detectadas,
asi como un enlace al archivo de lista exportado en el directorio %PIHOME%\dat. Puede utilizar este
scan para identificar las vistas de Pl View que se pueden eliminar o migrar al destino de
Microsoft SQL Server como alternativa. Para obtener instrucciones sobre cdmo migrar vistas mediante el
destino de PI View a Microsoft SQL Server, consulte Migrar el destino de Pl View al destino de
Microsoft SQL Server.

Si se produce un error durante el scan, aparecera un mensaje. Haga clic en Aceptar para cerrar el
didlogo de error.

Si el scan se realiza correctamente, pero la lista no se puede exportar, tome nota de forma manual
de los nombres de las vistas.

Haga clic en la casilla de verificacién de confirmacidn para continuar con la instalacién. Haga clic en
Siguiente.

Se abrira la ventana Listo para instalar la aplicacion.

14. Haga clic en Install.

Se abre la ventana Actualizando sistema que muestra el progreso de la instalacién.

15. Cuando finaliza la instalacién, aparece la ventana Instalacién completa. Haga clic en Close.
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Este procedimiento es una descripcidn general de los pasos que deben completarse para configurar el destino de

publicacion, incluidos aquellos que deben seguirse antes de crear y configurar el destino de publicacidn.

Nota: A partir de Pl Integrator for Business Analytics 2020 R2 SP2, el destino de PI View ha quedado obsoleto.

Para migrar cualquier vista que utilice el destino de Pl View a un destino de Microsoft SQL Server como
alternativa, consulte Migrar el destino de Pl View al destino de Microsoft SQL Server.

1. Siesta publicando los datos de su Pl System en uno de los siguientes destinos, siga las instrucciones del tema

de referencia para configurar el destino. Para todos los demas destinos, avance al paso siguiente.

Base de datos Oracle: consulte Configurar el destino de publicaciéon de la base de datos Oracle.

Objetivo de la base de datos SQL de Azure o el grupo SQL dedicado de Azure: consulte Configuracion del

objetivo de la base de datos SQL de Azure o el grupo SQL dedicado de Azure.

Amazon Redshift: instale el controlador ODBC de Amazon Redshift en el equipo donde estd instalado

Pl Integrator for Business Analytics: consulte Instale y configure el controlador ODBC de Amazon

Redshift..

SAP HANA ODBC: instale el cliente SAP HANA en el equipo donde esta instalado PI Integrator for
Business Analytics. Consulte Configuracion del destino de publicacion de SAP® HANA® ODBC.

2. Agregue el destino de publicacion a Pl Integrator for Business Analytics. Consulte Agregar un destino de
publicacién.

3. Configure el destino de publicacion. Consulte el tema de su destino.

Configurar el destino de Amazon Kinesis Data Streams
Configurar el objetivo de Amazon Redshift

Configurar el destino de Amazon S3

Configurar el objetivo de Apache Hive

Configurar el objetivo de Apache Kafka

Configurar el objetivo de Azure Data Lake Storage Gen 2
Configure el objetivo del Centro de eventos de Azure.
Configurar el objetivo de Azure |oT Hub

Configurar el objetivo de la Base de datos SQL de Azure
Configuracion del objetivo del grupo SQL dedicado de Azure
Configurar el destino de Google BigQuery

Configure el destino de Google Cloud Storage

Configurar el objetivo de Google Cloud Pub/Sub

Configure el objetivo del Sistema de archivo distribuido Hadoop (HDFS)
Configurar el destino de Microsoft SQL Server

Configurar el objetivo de Oracle

Configurar el objetivo de publicacién de SAP® HANA® ODBC

Configurar el objetivo de archivos de texto
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4. Conceda a los usuarios acceso al destino de publicacion. Consulte Conceder acceso a objetivos.

Agregar un destino de publicacion

Este tema describe cdmo agregar objetivos de publicacion.

Nota: La edicidn del software determina las salidas de destino disponibles.

1. Hagaclic en el icono del menu E y en Administracion.
2. Haga clic en la pestaia Destinos.
Se abre la pagina Configuracidn de Destino de Publicacion.
3. Haga clic en Agregar Destino de Publicacidn.
Se abre el cuadro de didlogo Crear nuevo objetivo de publicacion.

4. Ingrese el nombre del destino de publicacion en el campo Nombre de Destino. Haga clic en Tipo de Destino
y seleccione el tipo de salida de la lista.

5. Haga clic en Crear Nuevo Destino.

Configurar el destino de Amazon Kinesis Data Streams

Complete el procedimiento que se menciona abajo para configurar el destino de Amazon Kinesis Data Streams y
verifique que pueda escribir en Amazon Kinesis Data Streams.

e Asegurese de que la clave de acceso de AWS que introduzca en la configuracion de destino de Pl Integrator
for Business Analytics sea para un usuario de AWS que tenga los siguientes permisos en el objetivo de
Amazon Kinesis Data Streams: acciones ListStreams, DescribeStream, PutRecord/PutRecords.

¢ Cree el destino de Amazon Kinesis Data Streams antes de configurarlo. Para obtener mas informacién,
consulte Agregar un destino de publicacion.

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacién requerida. Haga clic en los botones a medida que se

habilitan.

Parametro Descripcion

ID de clave de acceso de AWS Se usa en combinacidn con la clave secreta de
acceso para autenticar solicitudes a la fuente.

Clave de acceso secreto de AWS Se usa en combinacidn con la ID de clave de acceso
de AWS para autenticar solicitudes a la fuente.

Secuencia de datos de Kinesis Nombre del flujo de datos de Amazon Kinesis en el
que se escriben los datos.
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Parametro

Descripcion

Regidn

Si la region deseada no estd incluida en la lista
desplegable, escribala de forma manual en el campo
de entrada.

Compruebe que el formato sea un cédigo de region
de Amazon valido y no el nombre de la regién. El
formato debe coincidir con el formato de las
regiones admitidas a continuacién:

Predeterminado: us-east-1
Compatible:
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1

us-east-1
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Parametro

Descripcion

us-east-2
us-west-1

us-west-2

Regiones no admitidas

Areas geograficas con las que no se comunica este
cliente:

AWS GovCloud (Este de EE. UU.)
AWS GovCloud (Oeste de EE. UU.)
Ohio, Este de ISOB, EE. UU.
Virginia Oriental, I1SO, EE. UU.
Colorado, Oeste de ISO, EE. UU.

No se admiten las zonas locales de AWS

Formato de almacenamiento de datos

(Opcional) Formato de archivo en el que se
almacenan los datos. El valor predeterminado es
Parquet. Otras opciones son JSON y JSON Indent.

Compresion

(Opcional) Tipo de compresidn en conjuntos de
mensajes. El valor predeterminado es Ninguno.
Otras opciones son gzip y Snappy.

Permitir valores nulos

(Opcional) Cuando se seleccionan, los valores nulos
son validos.
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3. Haga clic en Verificar escritor.
4. Haga clic en Guardar cambios.

5. Proporcione a los usuarios acceso al destino de Amazon Kinesis Data Streams. Para obtener mds
informacion, consulte Conceder acceso a objetivos.

Nota: Cualquier region no incluida especificamente en la lista anterior como regién admitida se considera
una regién no admitida (no se garantiza que la region se admita). AVEVA admite estas regiones admitidas en
el momento de esta version y no puede garantizar la compatibilidad con las regiones recién agregadas.

Instale y configure el controlador ODBC de Amazon Redshift.

Debe instalar y configurar el controlador ODBC de Amazon Redshift en el equipo donde Pl Integrator for Business
Analytics esta instalado antes de configurar el destino de Amazon Redshift.

1. Enla pagina Instalar y configurar el controlador ODBC de Amazon Redshift en sistemas operativos de
Microsoft Windows, descargue el archivo de instalacién segun la arquitectura de sistema de su herramienta
o aplicacién de cliente SQL:

¢ 64-bit — Amazon Redshift (x64)
2. Ejecute el archivo para instalar el controlador ODBC de Amazon Redshift.

3. Siga las instrucciones para configurar el controlador.

Configurar el objetivo de Amazon Redshift

Complete el procedimiento a continuacién para configurar el destino de Amazon Redshift y comprobar que
pueda escribir en la base de datos de Amazon Redshift.

¢ Asegurese de que el usuario de la base de datos que ingresa en la configuracién de destino de publicacion de
Pl Integrator for Business Analytics tenga los siguientes permisos minimos en la base de datos de Amazon
Redshift: SELECCIONAR, CREAR, SOLTAR, ACTUALIZAR, INSERTAR y ELIMINAR.

¢ Instale y configure el controlador ODBC de Amazon Redshift. Para obtener mas informacidn, consulte Instale
y configure el controlador ODBC de Amazon Redshift..

¢ Cree el destino de Amazon Redshift antes de configurarlo. Para obtener mds informacion, consulte Agregar
un destino de publicacion.

1. Enla pdagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su objetivo, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacidon requerida. Haga clic en los botones a medida que se
habilitan.
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Parametro

Descripcion

Controlador ODBC

(Opcional) Controlador ODBC que se conecta al
cluster de Amazon. La opcién predeterminada es

Amazon Redshift (x64).

Nombre del cltister

Nodo de cluster de Amazon al que se envian los

datos.

Puerto de la base de datos del clister

(Opcional) Puerto mediante el cual se conecta a la
base de datos del cluster. El valor predeterminado

es 5439,

Nombre de la base de datos del cluster

Base de datos del cluster en la que se guardan los

datos.

Nombre de usuario de la base de datos

Nombre de usuario de la base de datos utilizado
para conectarse al cluster.

Contrasefia

Contrasefia del nombre de usuario de la base de
datos utilizado para conectarse al cluster.

Haga clic en Verificar escritor.

4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino de Amazon Redshift. Para obtener mds informacién, consulte

Conceder acceso a objetivos.

Configurar el destino de Amazon S3

Complete el procedimiento a continuacién para configurar el destino de Amazon S3 y comprobar que pueda
escribir en la base de datos Amazon S3.

e Asegurese de que la clave de acceso de AWS que introduce en la configuracion de destino de Pl Integrator
for Business Analytics sea para un usuario de AWS que tenga los siguientes permisos en el destino de
Amazon S3: s3:ListBucket, s3:PutObject, s3:GetObject, s3:DeleteObject y s3:GetBucketLocation.

¢ Si utiliza la base de datos de Amazon Athena, asegurese de que la clave de acceso de AWS que introduce
en la configuracion de destino de Pl Integrator for Business Analytics sea para un usuario de AWS que
tenga los siguientes permisos en la base de datos: Athena, lectura y escritura. El usuario debe contar con
todos los permisos necesarios relacionados con la lectura y escritura.

Servidor Acciones Recursos Condiciones de la
solicitud
Athena * (todas las acciones) Cualquier recurso de Ninguno
tipo = grupo de trabajo
Pegamento * (todas las acciones) Todos los recursos Ninguno

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Page 39



AV=VA"

Pl Integrator for Business Analytics
Configurar los destinos de publicacién

e Athena: lectura y escritura. El usuario debe contar con todos los permisos necesarios relacionados con la
lectura y escritura. Lectura y escritura. El usuario debe contar con todos los permisos necesarios

relacionados con la lectura y escritura.

¢ Glue: lectura y escritura. El usuario debe contar con todos los permisos necesarios relacionados con la

lectura y escritura.

Nota: Para poder escribir en una base de datos de Amazon Athena, la base de datos debe encontrarse en la
misma region que el depdsito de Amazon S3. La escritura en una base de datos de Amazon Athena solo es
compatible cuando se utiliza el tipo de almacenamiento de datos Parquet.

¢ Cree el destino de Amazon S3 antes de configurarlo. Para obtener mds informacién, consulte Agregar un

destino de publicacion.

Complete el procedimiento a continuacién para configurar el destino de Amazon S3 y comprobar que pueda

escribir en el depdsito de Amazon S3.

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista

Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacion requerida. Haga clic en los botones a medida que se

habilitan.

Parametro

Descripcion

Formato de almacenamiento de datos

Formato de archivo en el que se almacenan los
datos. El valor predeterminado es Parquet. Otras
opciones son: JSON, JSON Indent y Text.

Compresion

Tipo de compresidn en conjuntos de mensajes. El
valor predeterminado es Ninguno. Otras opciones
son gzip y Snappy.

Nota: Elija un ajuste de compresion para obtener un
mejor desempefio.

ID de clave de acceso de AWS

Se utiliza en combinacion con la Clave de acceso
secreta para autenticar solicitudes al depésito.

Clave de acceso secreto de AWS

Se utiliza en combinacién con la ID de clave de
acceso de Amazon para autenticar solicitudes al
depésito.

Incluir encabezado

Cuando se seleccionan, los nombres de las
columnas se agregan al comienzo del archivo.

Delimitador de campo

Caracteres que separan los campos de datos en la
fila. De manera predeterminada, se usa una
tabulacidn (\t) para separar los campos.
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Regidn A continuacion, se indica el area geogrdéfica con la
gue se comunica este cliente; si la region deseada
no esta incluida en la lista desplegable, escribala de
forma manual en el campo de entrada.

Compruebe que el formato sea un cédigo de region
de Amazon valido y no el nombre de la regién. El
formato debe coincidir con el formato de las
regiones admitidas a continuacién:

Predeterminado: us-east-2
Compatible:
af-south-1
ap-east-1
ap-northeast-1
ap-northeast-2
ap-northeast-3
ap-south-1
ap-south-2
ap-southeast-1
ap-southeast-2
ap-southeast-3
ap-southeast-4
ca-central-1
ca-west-1
cn-north-1
cn-northwest-1
eu-central-1
eu-central-2
eu-north-1
eu-south-1
eu-south-2
eu-west-1
eu-west-2
eu-west-3
il-central-1
me-central-1
me-south-1
sa-east-1
us-east-1

us-east-2
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us-west-1

us-west-2

Regiones no admitidas

Areas geograficas con las que no se comunica este
cliente:

AWS GovCloud (Este de EE. UU.)
AWS GovCloud (Oeste de EE. UU.)
Ohio, Este de ISOB, EE. UU.
Virginia Oriental, I1SO, EE. UU.
Colorado, Oeste de ISO, EE. UU.

No se admiten las zonas locales de AWS.

Delimitador de filas

Caracteres que separan las filas de datos. De manera
predeterminada, una nueva linea separa las filas de
datos. Los caracteres que especifican una nueva
linea son especificos de la plataforma. La opcion
predeterminada proporciona automaticamente los
caracteres correctos para el entorno.

Nombre del depésito

Paquete de S3 en el que se cargan los datos.

Ruta de la carpeta

(Opcional) Especifique prefijos de nombre de clave y
barras diagonales (/) para organizar las vistas en S3.
Los prefijos de nombre clave deben existir en S3
antes de configurar el destino. Para obtener mas
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informacidon sobre cdmo crear una jerarquia légica
en S3, visiteClave de objeto y metadatos.

Permitir valores nulos Cuando se seleccionan, los valores nulos son
validos.
Maxima cantidad de filas/objetos (Opcional) Cantidad maxima de objetos en un

archivo. Predeterminado: 100 000 filas. Consulte la
nota siguiente.

Tamaio maximo de archivo (KB) (Opcional) Tamafio méximo de archivo en kilobytes.
Predeterminado: 10 000 KB Consulte la nota
siguiente.

Tiempo maximo de actualizacion (seg.) (Opcional) Tiempo maximo para actualizar la base

de datos, en segundos, antes de que se cierre la
sesidn del escritor por exceso de tiempo.
Predeterminado: 86 400 segundos (1 dia). Consulte
la nota siguiente.

Base de datos de Amazon Athena (Opcional) Nombre de la base de datos de Amazon
Athena a la que se escriben los datos.

Nota: Cualquier region no incluida especificamente en la lista anterior como regién admitida se considera
una region no admitida (no se garantiza que la region se admita). AVEVA admite estas regiones admitidas en
el momento de esta version y no puede garantizar la compatibilidad con las regiones recién agregadas.

Nota: Especifique uno de los tres parametros opcionales: Maxima cantidad de filas/objetos, Tamafio
maximo de archivo o Tiempo maximo de actualizacién. Si no se especifica ninguno, las vistas siempre se
publicaran en el mismo archivo y nunca se creard un archivo nuevo.

Los tres pardmetros tienen valores predeterminados y se aplican todos los valores predeterminados. El
primer pardmetro que se alcance activard la creacién de un archivo nuevo. Para estandarizarse en un
parametro para la creacidn de archivos nuevos, ingrese valores muy grandes que sean imposibles de alcanzar
para los pardmetros restantes.

Haga clic en Verificar escritor.
4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino de Amazon S3. Para obtener mds informacion, consulte Conceder
acceso a objetivos.

Configurar el objetivo de Apache Hive

Complete el procedimiento a continuacién para configurar el destino de Apache Hive y probar la conexidon a la
base de datos Hive.

Cree el destino de Apache Hive antes de configurarlo. Para obtener mas informacidn, consulte Agregar un
destino de publicacion.

Nota: Ingrese la informacidn de los campos en orden. Luego de haber especificado la informacién requerida en
los campos, se habilitan los botones. Haga clic en el botdn antes de continuar con el campo siguiente.
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1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista

Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacion requerida. Haga clic en los botones a medida que se

habilitan.

Parametro

Descripcion

HDFS URL

URL para acceder a HDFS mediante WebHDFS
directamente o a por la puerta de enlace de Apache
Knox o HttpFsS.

Ejemplos:
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Comprobacién del certificado TLS/SSL

Seleccione la casilla de verificacidn si esta utilizando
un certificado TLS/SSL.

Nombre de usuario

Nombre de usuario para conectarse a HDFS. El
usuario debe contar con permisos para leer y
escribir en HDFS.

Contraseiia

(Opcional) Contrasefia para autenticar al usuario o
conectarse a HttpFS. Si se proporciona una
contrasefia, se usa la autenticaciéon HTTP de
Hadoop. Si no se ingresa una contraseiia, Pl
Integrator for Business Analytics usa la autenticacion
simple de Hadoop.

Directorio

Directorio donde se crean los archivos de datos.
Haga clic en Buscar para desplazarse al directorio en
el que desea que se ubiquen los archivos. El formato
para especificar la ubicacién del directorio es:
[rootfolder/folderl/folder2.

Nombre de host de Hive

Nombre de host del equipo donde se ejecuta Thrift.
Este nombre puede ser un alias, una direccidn
interna o una direccién IP. El nombre
predeterminado es el nombre de host en la URL de
HDFS.

Puerto de Hive

(Opcional) Puerto mediante el cual se conecta a
Thrift.

Nombre de usuario de Hive

(Opcional) Nombre de usuario utilizado para
conectarse a HCatalog.
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Formato de tabla de Hive Formato en el cual almacenar tablas en Apache
Hive. Los formatos de archivo actualmente
admitidos son texto (ARCHIVO DE TEXTO) y ORC
(optimized row columnar).

Nota: ORC requiere Apache Hive 0.11 o posterior.

Base de datos de Hive Nombre de base de datos en Apache Hive en la cual
se crean las tablas.

3. Haga clic en Conectar a Apache Hive.

Pl Integrator for Business Analytics se conecta a Apache Hive, consulta la base de datos y completa los
campos de Hive Table Format y Hive Database con las bases de datos y los formatos de tabla admitidos.

4. Haga clic en Verificar escritor Apache Hive para verificar que el escritor Apache Hive pueda escribir en la
base de datos Hive.

Nota: Si no puede escribir correctamente en la base de datos de Hive, consulte Consejos para instalar
Apache Hive.

5. Haga clic en Guardar cambios.

Consejos para instalar Apache Hive

Para que Apache Hive funcione con Pl Integrator for Business Analytics, debe completar las siguientes tareas:

e Cree el usuario HDFS.

e Cree el usuario HCat.

¢ Cree el directorio de usuarios y conceda permisos.
e Desactive SASL.

El siguiente procedimiento describe como completar estas tareas.

1. Cree el usuario HDFS.
a. Cree el usuario HDFS en el nodo donde esta instalado WebHDFS.

b. Agregue el usuario HDFS a un grupo.

Nota: El usuario HDFS se puede agregar a cualquier grupo. Sin embargo, para este ejemplo, nos referiremos
a este grupo como el grupo HDFS.

2. Cree el usuario HCat.
(Opcional) Si HCat esta en un nodo diferente, debe agregar el usuario HCat.
a. Cree el usuario HCat en el nodo donde esta instalado HCat.
b. Agregue el usuario HCat al grupo HDFS.

3. Cree el directorio de usuarios y conceda permisos.

En el siguiente procedimiento, puede crear un directorio de usuarios y asegurarse de que esté configurado
correctamente a fin de que el usuario HDFS pueda escribir en él.

a. Cree un directorio de usuarios en HDFS.

b. Cambie el duefio de este directorio por el usuario HDFS.
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c. Cambie el grupo al que este directorio pertenece por HDFS.
d. Conceda permisos de lectura y escritura al duefio del directorio (es decir, al usuario HDFS).
e. Conceda permisos de lectura y de escritura al grupo que pertenece el directorio.

4. Desactive SASL.

Nota: Pl Integrator for Business Analytics solo admite destinos de Apache Hive que se configuran con la
autenticacion de NOSASL. Para obtener mds informacion sobre las opciones de autenticacidon de Apache
Hive, consulte Configuracion de HiveServer2.

Configurar el objetivo de Apache Kafka

Complete el procedimiento a continuaciéon para configurar el destino de Apache Kafka y comprobar que pueda
escribir en la base de datos Apache Kafka.

¢ Cree el destino de Apache Kafka antes de configurarlo. Para obtener mas informacion, consulte Agregar un
destino de publicacion.

¢ (Opcional) Compruebe que OpenTLS esté instalado en el equipo en el que estd instalado Pl Integrator for
Business Analytics. Este paso solo es necesario si esta utilizando TLS/SSL para conectarse a Apache Kafka.

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacién requerida. Haga clic en los botones a medida que se
habilitan.

Parametro Descripcion

Agentes de Kafka Lista separada con comas de agentes de Kafka.
Especifique con el formato Host:Puerto, Host:Puerto.

Codec Tipo de compresidn en los conjuntos de mensajes.
El valor predeterminado es Ninguno. Las opciones
validas incluyen gzip y Snappy.

Uso de TLS/SSL Use TLS/SSL (seguridad de la capa de transporte)
cuando se conecte con los agentes de Kafka.

Verificacion del nombre de host de TLS/SSL Algoritmo de verificacion del nombre de host del
agente de TLS/SSL (propiedad de Apache Kafka
ssl.endpoint.identification.algorithm) utilizado.
HTTPS o ninguno (sin verificacion de nombre de
host). El valor predeterminado es Ninguno.

Certificado del cliente Ruta completa al certificado del cliente (archivo
.pem). Es necesario solo si se utiliza TLS/SSL y no se
utiliza un mecanismo de SASL. Comuniquese con el
administrador de Apache Kafka para obtener un
certificado de cliente de OpenTLS de Pl Integrator
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for Business Analytics.

Clave del cliente Ruta completa al archivo de clave de cliente (archivo
.key). Es necesario solo si se utiliza TLS/SSL y no se
utiliza un mecanismo de SASL.

Contrasefa de clave Contrasefia del archivo de clave del certificado TLS/
SSL. Es necesario solo si se utiliza TLS/SSLy no se
utiliza un mecanismo de SASL.

Certificado de raiz de CA Ruta completa al certificado de raiz de CA utilizada
para firmar el certificado del cliente. Es necesario
solo si se utiliza TLS/SSL.

Mecanismo de SASL Mecanismo de SASL utilizado. El valor
predeterminado es Ninguno. Se admiten cuatro
mecanismos de autenticacién: GSSAPI (también
conocido como Kerberos), PLAIN, SCRAM-SHA-256 y
SCRAM-SHA-512. Es una practica recomendada
combinar PLAIN, SCRAM-SHA-256 o SCRAM-
SHA-512 con el cifrado TLS/SSL, de modo que las
contrasefias cifradas se envien por la red.

Nombre de usuario Nombre de usuario de Kafka para autenticacién de
SASL. No se utiliza con la autenticacidon de GSSAPI.

Contrasefa Contrasefia de Kafka de autenticacion SASL. No se
utiliza con la autenticacion de GSSAPI.

Haga clic en Verificar escritor Kafka.

4. Haga clic en Guardar cambios.

e Otorgue a los usuarios acceso al destino de Apache Kafka. Para obtener mas informacién, consulte Conceder
acceso a objetivos.

e Siestd utilizando TLS/SSL para conectarse a los agentes de Kafka Apache, debe convertir los certificados de
Windows para abrir los certificados de OpenTLS. Consulte al administrador de Apache Kafka si necesita
ayuda para convertir estos archivos.

Consejos para configurar el entorno de Azure Data Lake

Para poder configurar el objetivo de Azure Data Lake Storage Gen 1, debera configurar el entorno de
Azure Data Lake. Esto incluye lo siguiente:

e Obtener la ID del inquilino para Azure Active Directory

¢ Configure la aplicacion web para acceder a las APl web

Para comenzar con Azure Data Lake Storage Gen 2, consulte el siguiente sitio de Microsoft: Introduccion a Azure
Data Lake Storage Gen?2.
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A medida que crea el entorno de Azure Data Lake, recopilara la siguiente informacién:

¢ ID deinquilino: ID que identifica el Active Directory
¢ ID de cliente: ID que identifica la aplicacion de Azure Data Lake
¢ Clave del cliente: usada para autenticar Pl Integrator for Business Analytics

¢ |D de suscripcién: ID que identifica a Azure Data Lake Storage Gen 1

Nota: Recomendamos copiar estos valores en un archivo de texto para usar posteriormente como referencia.
Necesitard esta informacidn cuando configure el destino de Microsoft Azure Data Lake Storage. Pl Integrator
for Business Analytics utiliza esta informacidn para conectarse con Azure Data Lake Storage Gen 2.

Obtener la ID del inquilino para Azure Active Directory

Nota: Existen muchas maneras de obtener la ID de inquilino. Consulte la documentacién de Microsoft para
conocer otras alternativas.

1. Desde el portal de Microsoft Azure, inicie sesidén en la cuenta para conectarse al servicio de Azure Data Lake.
2. Seleccione el directorio activo de Azure en el que se creara la aplicacién web.

3. Haga clic en Propiedades.

Home > emoninoosisaft (default directory) - Properties

emoninoosisoft (default directory) - Properties

Azure Active Directory

* Mame
Name

i=| Custom domain names
Default Directory
2 Mobility (MDM and MAM)

Country or region

Password reset United States

Company branding Location
United States datacenters
a User settings

\otification language
Properties English ~
B MNotifications settings Global admin can manage Azure Subscriptions and Management Groups
Yes No
SECURITY
Directory 1D
Conditional access 73856c71-7490-401b-a076-f91dcd42c430 | E

Nota: Con las actualizaciones subsiguientes del portal, la pantalla puede tener una apariencia diferente y los
parametros pueden encontrarse en otro lugar.

La ID de inquilino es el valor del campo ID de directorio.

4. Copie esta cadena en un archivo de texto.

Configurar el objetivo de Azure Data Lake Storage Gen 2

Complete el procedimiento a continuacién para configurar el objetivo de Azure Data Lake Storage Gen 2.
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e Complete la configuracion del entorno de Azure Data Lake y retina la informacidn requerida para configurar
el objetivo. Para obtener mds informacion, consulte Consejos para configurar el entorno de Azure Data Lake.

¢ Cree el objetivo de Azure Data Lake Storage Gen 2 antes de configurarlo. Para obtener mas informacién,
consulte Agregar un destino de publicacion.

e Otorgue al usuario que se conectara a Azure Data Lake Storage Gen 2 los siguientes permisos minimos: en
Azure Active Directory, registre el nuevo acceso de la aplicacién con el secreto del cliente o use el acceso de
aplicacién existente. En su cuenta de almacenamiento, asigne el rol Propietario de datos blob en Storage
para el acceso a esta aplicacién.

1. Enla pdagina Administracidn, haga clic en la pestafia Objetivos. Luego, seleccione Azure Data Lake Storage
Gen 2 en la lista de objetivos de publicacién.

2. Configure el objetivo de Azure Data Lake Storage Gen 2 con los siguientes parametros:

Parametro Descripcion

ID del inquilino Identificador para su cuenta de directorio de Azure
Active.

ID de la aplicacién Identificador para la aplicacion Azure Data Lake

Storage Gen 2 que autentica la aplicacién Pl
Integrator for Business Analytics con Azure Data
Lake Storage Gen 2.

Clave secreta del cliente Clave utilizada para autenticar PI Integrator for
Business Analytics con su aplicacién AAD.

Nombre de la cuenta de Azure Storage Nombre de la cuenta de Azure que se esta
autenticando en los servicios Azure.

Formato de almacenamiento de datos Formato de archivo en el que se almacenan los
datos. El valor predeterminado es Parquet.

3. Haga clic en Autenticar para verificar que las credenciales provistas le permitan a Pl Integrator for Business
Analytics conectarse a Azure Data Lake Storage Gen 2.

Si la autenticacion es correcta, una lista de contenedores de Data Lake aparece en la lista de Azure
Container.

4. Continte configurando los siguientes parametros:

Parametro Descripcion

Contenedor de Azure Contenedor de Azure Data Lake Storage Gen 2
donde estdn almacenados sus datos.

Directorio ADLS Ubicacién en Azure Data Lake Storage Gen 2 en la
cual se escriben los datos.

Anexar marca de tiempo Al seleccionarlo, una marca de tiempo de la hora de
publicacion de la vista se anexa al nombre del
archivo y se crea un nuevo archivo cada vez que se
publica la vista. Se utiliza un nimero de secuencia

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 49



'AV EVA\TM Pl Integrator for Business Analytics

Configurar los destinos de publicacién

Parametro Descripcion

afiadido al final de los nombres de archivo
posteriores una vez sobrepasado el limite maximo
de filas/objetos. Si no se selecciona esta opcidn, se
utiliza una secuencia de GUID aleatoria en el
nombre de archivo y varios eventos de publicacién
pueden anexar datos al archivo existente hasta que
se alcanza el limite maximo de filas/objetos. Luego,
se genera una nueva secuencia de GUID para el
archivo subsiguiente.

Incluir encabezado Cuando se seleccionan, los nombres de las
columnas se agregan al principio de la tabla.

Delimitador de campo Caracteres que separan los valores de datos en el
archivo de Azure Data Lake Storage Gen 2. El valor
predeterminado es un espacio marcado.

Maxima cantidad de filas/objetos Cantidad maxima de objetos en un archivo.
Predeterminado: 100 000 filas. Rango permitido de
0 a 10 000 000.

Tiempo de espera de transferencia Tiempo de espera de transferencia de datos en
segundos. Predeterminado: 900 (s). Rango
permitido de 0 a 86 400 (1 dia) (Opcional)

Tamaiio inicial de transferencia Tamano inicial de transferencia de datos en bytes.
Predeterminado: 4 194 304 (4 MB). Rango permitido
0a 1073 741824 (1 GB). Este valor representa el
tamano del paquete, no el tamafio completo del
archivo. (Opcional)

Tamaiio maximo de transferencia Tamafio maximo de transferencia de datos en bytes.
Predeterminado: 4 194 304 (4 MB). Rango permitido
0a 1073 741 824 (1 GB). Este valor representa el
tamano del paquete, no el tamafio completo del
archivo. (Opcional)

Reintentos maximos de transferencia Reintentos maximos de transferencia de datos.
Predeterminado: Rango permitido de 0 a 100.
(Opcional)

5. Haga clic en Verificar escritor de ADL para verificar si Pl Integrator for Business Analytics puede escribir en la
ubicacidn especifica de Azure Data Lake Storage Gen 2.

Nota: Si tiene varios contenedores en la lista desplegable Azure Container, asegurese de que la estructura de
la carpeta del directorio ADLS coincida con el contenedor de Azure que selecciond.

Haga clic en Guardar cambios.

Proporcione a los usuarios acceso al objetivo de Azure Data Lake Storage Gen 2. Para obtener mas
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informacion, consulte Conceder acceso a objetivos.

Anexar marca de tiempo en ADLS Gen 2

Con la marca de tiempo, cada evento de publicacidn es una operacidn discreta. Los datos no se agregan a los
archivos y se crea y publica un nuevo archivo automaticamente con una marca de tiempo diferente. Esto
contrasta con el GUID, en el que la publicacién no se considera como una operacion discreta y solo crea un
nuevo archivo bajo el mismo evento de publicacién una vez que se cruza el umbral maximo de filas/objetos.

En la pagina de configuracién de ADLS Gen 2, si no se selecciona el cuadro Anexar marca de tiempo, el destino
publicado tendrd un nombre de archivo, un guion bajo vy, luego, un GUID aleatorio. La marca de tiempo se puede
configurar y el nimero predeterminado de filas/objetos de un archivo es 100 000.

Publish Target Configuration
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Configure el objetivo del Centro de eventos de Azure.

Complete el procedimiento a continuacién para configurar el destino de los Centros de eventos de Azure y
probar la conexidn a estos.

Cree los Centros de eventos de Azure. Cree o identifique la politica de acceso compartido de los centros de
eventos de Azure para Pl Integrator for Business Analytics. Se envia la cantidad de permisos minimos requeridos.

1. Enla pagina Administracion, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Recupere la cadena de conexidn de los centros de eventos de Azure. El formato de la cadena de conexion se
muestra a continuacion:
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Endpoint=sb.//<NamespaceName>.servicebus.windows.net/;SharedAccessKeyName=<KeyName>;SharedAccessKey=<

Pl Integrator for Business Analytics
Configurar los destinos de publicacién

Nota: Esta cadena de conexion se obtiene del propio centro de eventos, no del bus de servicio principal del
centro de eventos (que también tiene su propia cadena de conexién y que Pl Integrator no admite).

3. Configure los Centros de eventos de Azure con los siguientes parametros:

Parametro

Descripcion

Punto final

El punto final del centro de eventos en el que se
publican los datos; este es el valor del punto final en
la cadena de conexion del centro de eventos.

Nota: Aseglrese de que toda la cadena comience
con "sb://" y que la terminacion
" servicebus.windows.net" se use como entrada.

Nombre de clave de acceso compartido

Se usa en combinacién con la clave de acceso
compartido para conectarse al centro de eventos.
Este es el valor SharedAccessKkeyName de la cadena
de conexién del centro de eventos.

Clave de acceso compartido

Clave primaria o secundaria del centro de eventos
gue se usa en combinacién con el nombre de clave
de acceso compartido para conectarse al centro de
eventos. Este es el valor SharedAccessKey en la
cadena de conexion del centro de eventos.

Ruta de acceso de la entidad

La entidad del centro de eventos en la que se
publicaran los datos; este es el valor de EntityPath
en la cadena de conexidn del centro de eventos.

Codificacion de caracteres

Conjunto de caracteres en el que se codifican los
datos. Predeterminado: UTF-8. Otras opciones son
ASCII, UTF-7, UTF-32 y Unicode.

La siguiente captura de pantalla muestra dénde se pueden encontrar estos parametros en el Portal de

Microsoft Azure.
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SAS Policy: SendOnly

eventhub - Shared access policies

it Hub

Overview

¥ Diagnose and sclve problems
SendOnly Send
SETTINGE
Shared access policies
Primary key
i Metrics (preview) L i e itz | [T
Properties Secondary key E
8 Locks
Connection string—primary key
3 Automation script

Connection string-secandary key

ENTITIES (BB fiaranine e B E

£~ Consumer groups

SUPPORT + TROUBLESHOOTING

New support request

Nota: Puede utilizarse una politica existente de acceso compartido a Azure para los centros de eventos que
cumplan con los permisos minimos o se puede crear una nueva politica de acceso compartido para este fin.
Con las actualizaciones subsiguientes del portal, la pantalla puede tener una apariencia diferente y los
parametros pueden encontrarse en otro lugar.

4. Haga clic en Comprobar el escritor del Centro de eventos para verificar que los Centros de eventos sean
validos.

Haga clic en Guardar cambios.

6. Proporcione a los usuarios acceso al destino de los Centros de eventos de Azure. Para obtener mas
informacion, consulte Conceder acceso a objetivos.

Configurar el objetivo de Azure loT Hub

Complete el procedimiento a continuacién para configurar el destino de Azure 1oT Hub y probar la conexion a
este.

Cree Azure loT Hub. Cree o identifique la politica de acceso compartido de Azure loT Hub que usard

Pl Integrator for Business Analytics. Si crea un dispositivo en el que se escribiran todas las vistas de

Pl Integrator for Business Analytics mediante la especificacion del ID de dispositivo, el permiso “Lectura de
registro” es el permiso minimo requerido. Si Pl Integrator for Business Analytics crea automaticamente un
dispositivo para cada vista, el permiso “Escritura de registro” es el permiso minimo requerido.

Nota: La clave simétrica es la Unica autenticacién admitida en esta versién.

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Recupere la cadena de conexién del centro de loT. El formato de la cadena de conexién se muestra a
continuacion:

HostName=<Host Name>;SharedAccessKeyName=<Key Name>;SharedAccessKey=<SAS Key>

3. Configure Azure loT Hub con los siguientes parametros:
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Parametro Descripcion

Nombre de host El nombre de host del centro de loT en el que se
publican los datos. Este es el valor HostName de Ia
cadena de conexidn del centro de loT.

Nombre de clave de acceso compartido Se usa en combinacidn con la clave de acceso
compartido para conectarse al centro de loT. Este es
el valor SharedAccessKeyName de la cadena de
conexién del centro de loT.

Clave de acceso compartido Clave primaria o secundaria del centro de loT que se
usa en combinacion con el nombre de clave de
acceso compartido para conectarse al centro de loT.
Este es el valor SharedAccessKey de la cadena de
conexion del centro de loT.

Codificacion de caracteres Conjunto de caracteres en el que se codifican los
datos. Predeterminado: UTF-8. Otras opciones son
ASCII, UTF-7, UTF-32 y Unicode.

ID del dispositivo (Opcional) ID del dispositivo del dispositivo de 10T o
del dispositivo periférico de loT. Este nombre esta
asignado al dispositivo. La ID del dispositivo es
necesaria para los dispositivos periféricos de IoT. Es
opcional para los dispositivos de IoT. Si no se
especifica ninglin nombre, se crea un dispositivo de
loT para cada vista.

Nota: Solo se debe crear una vista por destino del centro de |oT si se proporciona la ID de dispositivo en la
configuracién de destino. La combinacién de la cadena de conexiéon y la ID de dispositivo debe ser Unica en
todos los destinos del centro de 10T creado. Pueden ocurrir errores de conexidén cuando varias vistas usan la
misma cadena de conexién e ID de dispositivo.

En la siguiente captura de pantalla, se muestra donde encontrar la cadena de conexién de loT Hub en
Microsoft Azure Portal. Recuerde que Pl Integrator for Business Analytics requiere la cadena de conexién de
las politicas de acceso compartido del centro de 10T (no la cadena de conexidn a nivel del dispositivo). La
politica seleccionada en esta pagina determina los permisos para la cadena de conexion. Por ende, debe
seleccionar o crear una politica que proporcione los permisos necesarios, si se selecciond el ID de dispositivo
0 no, y proporcionar la cadena de conexidn de la politica seleccionada para el destino de

Pl Integrator for Business Analytics. No se admiten cadenas de conexidn en el nivel de dispositivo.
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En la siguiente captura de pantalla, se muestra donde encontrar los parametros del ID de dispositivo y dénde
configurar el tipo de autenticacién en Microsoft loT Portal para el dispositivo de loT Hub.

B Activity log

sl Access control (JAM)

A Certificates
1= Properties
8 Lods

£ Automation script

I |oT Devices

& 10T Edge (preview

J ‘You can use this toal to view, create, update, and delete devices on your loT Hub.

Query®
SELECT * FROM devices
WHERE

optional (e.g. tagslocation="US)

Add Device

Enable | Disable

Nota: Con las actualizaciones subsiguientes del portal, la pantalla puede tener una apariencia diferente y los
parametros pueden encontrarse en otro lugar.

4. Haga clic en Comprobar el escritor de 1oT Hub para verificar que el loT Hub sea vélido.

Si se especifica un ID del dispositivo, Pl Integrator for Business Analytics intentara encontrar el dispositivo. Si
no se especifica ningln ID del dispositivo, se creara un dispositivo y, una vez que se haya completado la
verificacidn, se eliminara.

5. Haga clic en Guardar cambios.

6. Proporcione a los usuarios acceso al objetivo de Azure loT Hub. Para obtener mas informacién, consulte
Conceder acceso a objetivos.
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Configuracion del objetivo de la base de datos SQL de Azure o el
grupo SQL dedicado de Azure

Complete el procedimiento para configurar el objetivo de la base de datos SQL de Azure o el grupo SQL dedicado
de Azure.

1. Instale la base de datos en Azure y complete las siguientes tareas:

a. Establezca una regla de firewall en Azure para conceder permiso al servidor (en el que esta instalado

Pl Integrator for Business Analytics) para enviar solicitudes a estos destinos.
De forma predeterminada, los firewalls de Azure impiden que aplicaciones externas accedan a los servidores
de la base de datos SQL de Azure y de la base de datos del grupo SQL dedicado de Azure. Por lo tanto, debe
otorgar acceso explicitamente al servidor.

Consejo: Dirijase al portal de Microsoft Azure en el equipo donde estd instalado
Pl Integrator for Business Analytics. El campo ID del cliente que identifica a los clientes que obtienen acceso
a los servidores de la base datos se completaran automaticamente con la direccidn IP del equipo.

a. Otorgue al usuario de SQL que introduce en la configuracién objetivo de publicacidn de
Pl Integrator for Business Analytics que se conectard a la base de datos SQL de Azure o el grupo SQL
dedicado de Azure los siguientes permisos minimos en la base de datos SQL de Azure o el grupo SQL
dedicado de Azure: CONECTAR, SELECCIONAR, CREAR TABLA, MODIFICAR, INSERTAR, ELIMINAR.

2. Agregue el destino de publicaciéon a Pl Integrator for Business Analytics. Consulte Agregar un destino de
publicacién.
3. Configure el destino de publicacion. Haga clic a continuacién en el tema apropiado para su destino:
¢ Configurar el objetivo de la Base de datos SQL de Azure
¢ Configuracién del objetivo del grupo SQL dedicado de Azure

4. Conceda a los usuarios acceso al destino de publicacion. Consulte Conceder acceso a objetivos.

Configurar el objetivo de la Base de datos SQL de Azure

Complete el procedimiento a continuaciéon para configurar el objetivo del grupo SQL dedicado de Azure y pruebe
su conexion al grupo SQL dedicado de Azure.

e Cree el grupo SQL dedicado de Azure.

e Agregue el grupo SQL dedicado de Azure como objetivo. Para obtener mas informacién, consulte Agregar un
destino de publicacion.

1. Enla pagina Administracidon, haga clic en la pestafia Destinos. Luego, seleccione Base de datos SQL de Azure
en la lista Objetivos de publicacién.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Configure el objetivo del grupo SQL dedicado de Azure con los siguientes parametros:

Parametro Descripcion

Nombre de host Nombre del servidor que aloja la Base de datos SQL
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Parametro Descripcion

de Azure. El formato es:
server_name.database.windows.net.

Autenticacidon de nombre de usuario de SQL Nombre de usuario utilizado para conectarse con el
grupo SQL dedicado de Azure.

Autenticacidn de contrasefia de SQL Contrasefia utilizada para conectarse con el almacén
grupo SQL dedicado de Azure.

Tiempo de espera de publicaciéon Tiempo que aguarda Pl Integrator Framework
Service para que se complete la operacidn de
publicacién antes de que expire la sesion. El valor
predeterminado es 30 segundos.

Utilizar alta disponibilidad (Opcional) Conéctese a un SQL Server que admita
grupos de alta disponibilidad y de conmutacién por
error. La opcién Utilizar alta disponibilidad activa la
propiedad de conexidon MultiSubnetFailover en la
cadena de conexion. Para obtener mds informacién
sobre esta propiedad, consulte el sitio web de
Microsoft.

Base de datos Nombre de la base de datos en el grupo SQL
dedicado de Azure donde se ubican las tablas.

Esquema Esquema de SQL asociado con las tablas en las que
se almacenan datos.

Pulse Connect.
Seleccione la base de datos en la lista Base de datos.

Haga clic en Guardar cambios.

o v kW

Proporcione a los usuarios acceso al objetivo del grupo SQL dedicado de Azure. Para obtener mas
informacion, consulte Conceder acceso a objetivos.

Configuracion del objetivo del grupo SQL dedicado de Azure

Complete el procedimiento a continuaciéon para configurar el objetivo del grupo SQL dedicado de Azure y pruebe
su conexion al grupo SQL dedicado de Azure.

¢ Cree el grupo SQL dedicado de Azure.

e Agregue el grupo SQL dedicado de Azure como objetivo. Para obtener mds informacién, consulte Agregar un
destino de publicacion.

Nota: Microsoft ha cambiado el nombre de producto del almacén de datos de Azure SQL (grupo SQL
dedicado). A partir de la primavera de 2024, el nombre del producto actual de Microsoft para este servicio
en el Portal de Azure es Grupo SQL dedicado.
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1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Configure el objetivo del grupo SQL dedicado de Azure con los siguientes parametros:

Parametro Descripcion

Nombre de host Nombre del servidor que aloja la Base de datos SQL
de Azure. El formato es:
server_name.database.windows.net.

Autenticacidon de nombre de usuario de SQL Nombre de usuario utilizado para conectarse con el
grupo SQL dedicado de Azure

Autenticacién de contrasefia de SQL Contrasefia utilizada para conectarse con el grupo
SQL dedicado de Azure

Tiempo de espera de publicacion El tiempo asignado para publicar datos en el
objetivo antes de que se agote el tiempo de espera
de Pl Integrator Framework Service. El tiempo
predeterminado es de 30 segundos si se deja el
campo en blanco.

Utilizar alta disponibilidad (Opcional) Conéctese a un SQL Server que admita
grupos de alta disponibilidad y de conmutacién por
error. La opcidén Utilizar alta disponibilidad activa la
propiedad de conexidon MultiSubnetFailover en la
cadena de conexion. Para obtener mds informacién
sobre esta propiedad, consulte el sitio web de
Microsoft.

Base de datos Nombre de la base de datos en el grupo SQL
dedicado de Azure donde se ubican las tablas.

Esquema Esquema de SQL asociado con las tablas en las que
se almacenan datos.

3. Pulse Connect.
4. Seleccione la base de datos en la lista Base de datos.

5. Haga clic en Guardar cambios.

Proporcione a los usuarios acceso al objetivo del grupo SQL dedicado de Azure. Para obtener mas informacidn,
consulte Conceder acceso a objetivos.

Configurar el destino de Google BigQuery

Complete el procedimiento que se menciona abajo para configurar el destino de Google BigQuery y verifique
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que pueda escribir en el recurso de Google BigQuery.

2.
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En la consola de Google Cloud, debajo de IAM, otérguele a la cuenta de servicio de GCP los siguientes

permisos minimos en el proyecto:

Nota: Para obtener mas informacién sobre los roles y permisos de Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles y https://cloud.google.com/iam/docs/creating-

custom-roles.

e bigquery.datasets.create

e bigquery.datasets.get

e bigquery.datasets.update

e bigquery.tables.create

e bigquery.tables.list

e bigquery.tables.delete

e bigquery.tables.get

e bigquery.tables.update

e bigquery.tables.updateData
e bigquery.jobs.create

¢ Por otro lado, puede asignarle a la cuenta de servicio de GCP los roles roles/bigquery.dataOwner y roles/
bigquery.jobUser que incluyen los permisos minimos.

Cree el destino de Google BigQuery antes de configurarlo. Para obtener mas informacién, consulte Agregar

un destino de publicacidn.

En la pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista

Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

Consulte la siguiente tabla e ingrese la informacidn requerida. Haga clic en los botones a medida que se

habilitan.

Parametro

Descripcion

Archivo de claves de la cuenta de servicios de GCP

Archivo JSON que contiene las credenciales de la
cuenta de servicio de GCP.

ID de proyecto de BigQuery

ID Unica para su proyecto de BigQuery en
Google Cloud Platform (GCP)

Dataset de BigQuery

Contenedor de nivel superior que organiza y
controla el acceso a tablas y vistas. El dataset estd
contenido dentro un proyecto y debe crearse antes
de poder trasmitir los datos a BigQuery.

Cargar tamaiio de pagina

(Opcional) Cantidad de filas que se cargan en una
insercidon masiva. Se recomienda el tamafio
predeterminado de 500.

3. Haga clic en Verificar el escritor de almacenamiento de GCP de BigQuery.
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4. Haga clic en Guardar cambios.

5. Otorgue a los usuarios acceso al destino de Google BigQuery. Para obtener mas informacién, consulte
Conceder acceso a objetivos.

Nota: Ningun registro de una instancia de Google BigQuery puede modificarse en un plazo de 90 minutos
después de escribirse o actualizarse. Para que el servicio Pl Integrator Sync continle comportandose como se
espera (y no encuentre esta limitacidn en las vistas que escriben en BigQuery), se recomienda configurar
AFMonitorUpdateFrequency en %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config a

120 minutos de la siguiente manera: <add key="AFMonitorDataUpdateFrequency" value="120"/>.

El bufer de tiempo adicional (configuracion de 120 minutos en comparacion con la limitacién de 90 minutos)
proporciona una ventana lo suficientemente amplia como para que Google BigQuery vacie el bufer de
transmision. Sin este bufer, podria encontrarse accidentalmente con la limitacidon cuando establece
AFMonitorUpdateFrequency en el mismo tiempo que la limitacion (90 minutos). Si el bufer esta configurado
correctamente, vera el siguiente mensaje en el inicio de la aplicacién:

UnifiedAppConfig:AFMonitorDataUpdateFrequency: analizado correctamente.

Valor AFMonitorDataUpdateFrequency de ‘finalAppConfigFilePath'.

Use el valor AFMonitorDataUpdateFrequency, '120' (minutos).
Si el bufer no se configura correctamente y se encuentra la limitacidn, ya sea cuando hace clic en Actualizar
datos en la IU o cuando activa PI Integrator Sync Service sin configurar correctamente
AFMonitorUpdateFrequency, vera el siguiente mensaje de error:

La operacién UpdateData se detuvo debido a la restriccién PublishTarget (tiempo de

finalizacién maximo de *-9@ minutos).

PublishTarget, GcpBigQueryWriter, no admite la eliminacién/actualizaciodn de filas de

datos que han sido modificadas en los uUltimos 90 minutos.
Resultado: no se ha modificado ningun dato en PublishTarget.

Configure el destino de Google Cloud Storage

Complete el procedimiento que se menciona abajo para configurar el destino de Google Cloud Storage y
verifique que pueda escribir en el depdsito de Google Cloud Storage.

Nota: Para obtener mas informacion sobre los roles y permisos de Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles y https://cloud.google.com/iam/docs/creating-custom-
roles.

¢ Enla consola de Google Cloud, debajo de IAM, otdrguele a la cuenta de servicio de GCP acceso al proyecto
de Google Cloud Storage. Los permisos minimos son:

e storage.buckets.get
e storage.buckets.list
e storage.objects.create
e storage.objects.get
e storage.objects.delete

¢ Por otro lado, puede asignarle a la cuenta de servicio de GCP el rol roles/storage.admin, que incluye los
permisos minimos.

¢ Sise configura BigQuery, la cuenta de servicio de GCP requiere los siguientes permisos adicionales:

e bigquery.datasets.create
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e bigquery.tables.create
e bigquery.tables.list

e bigquery.tables.delete
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Por otro lado, si BigQuery esta configurado, puede asignarle a la cuenta de servicio de GCP el rol roles/

bigquery.dataOwner que incluye los permisos minimos.

Cree el destino de Google Cloud Storage antes de configurarlo. Para obtener mas informacidn, consulte

Agregar un destino de publicacién.

En la pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista

Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

Consulte la siguiente tabla e ingrese la informacidon requerida. Haga clic en los botones a medida que se

habilitan.

Parametro

Descripcion

Formato de almacenamiento de datos

Formato de archivo en el que se almacenan los
datos. Predeterminado: Parquet. Otras opciones son
JSON, JSON Indent y Text. Si se utiliza BigQuery, la
Unica opcidon compatible es Texto.

Compresion

Tipo de compresidn en conjuntos de mensajes.
Predeterminado: Ninguno. Otras opciones son gzip y

Snappy.

Archivo de claves de la cuenta de servicios de GCP

Archivo JSON que contiene las credenciales de la
cuenta de servicio de Google Cloud Platform (GCP).

ID de proyecto de BigQuery

(Opcional) ID unica para su proyecto de BigQuery en
GCP.

Incluir encabezado

(Opcional) Cuando se seleccionan, los nombres de
las columnas se agregan al comienzo del archivo.

Delimitador de campo

(Opcional) Caracter(es) que separa(n) los campos de
datos en las filas. De manera predeterminada, un
tabulador (\t) separa los campos.

Delimitador de filas

(Opcional) Caracter(es) que separa(n) las filas de
datos. De manera predeterminada, una nueva linea
separa las filas de datos. Los caracteres que
especifican una nueva linea son especificos de la
plataforma. La opcidn predeterminada proporciona
automaticamente los caracteres correctos para el
entorno.

Nombre del depésito

Depdsito de Google Cloud Storage donde se cargan
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los datos.

Ruta de la carpeta

(Opcional) Ruta a la carpeta de
Google Cloud Storage. El valor predeterminado es la
raiz del depésito especificado.

Permitir valores nulos

Cuando se seleccionan, los valores nulos son
validos. Predeterminado: se permiten valores nulos

Maxima cantidad de filas/objetos

(Opcional) Cantidad maxima de objetos en un
archivo. Predeterminado: 100 000 filas

Tamaiio maximo de archivo (KB)

(Opcional) Tamafio maximo de archivo en kilobytes.
Predeterminado: 10 000 KB

Tiempo maximo de actualizacion (seg.)

(Opcional) Tiempo maximo para actualizar la base
de datos, en segundos, antes de que se cierre la
sesion del escritor por exceso de tiempo.
Predeterminado = 86 400 segundos (1 dia)

Dataset de BigQuery

(Opcional) Contenedor de nivel superior que
organiza y controla el acceso a tablas y vistas. El
dataset esta contenido dentro un proyecto y debe
crearse antes de poder trasmitir los datos a
BigQuery.

Haga clic en Verificar el escritor de almacenamiento de GCP de BigQuery.

Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino de Google Cloud Storage. Para obtener mds informacién, consulte

Conceder acceso a objetivos.

Configurar el objetivo de Google Cloud Pub/Sub

Complete el procedimiento que se menciona abajo para configurar el objetivo de Google Cloud Pub/Sub y
verifique que pueda escribir en el recurso de Google Cloud Pub/Sub.

Nota: Para obtener mas informacién sobre los roles y permisos de Google IAM, consulte
https://cloud.google.com/iam/docs/understanding-roles y https://cloud.google.com/iam/docs/creating-custom-
roles.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

En la consola de Google Cloud, debajo de IAM, otérguele a la cuenta de servicio de GCP acceso al proyecto

de Pub/Sub. Los permisos minimos del proyecto son:
* pubsub.topics.list
e pubsub.topics.publish
* pubsub.topics.get

e pubsub.topics.create

Por otro lado, puede asignarle a la cuenta de servicio de GCP el rol roles/pubsub.editor, que incluye los

permisos minimos.
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¢ Cree el objetivo de Google Cloud Pub/Sub antes de configurarlo. Para obtener mas informacion, consulte
Agregar un destino de publicacién.

1. Enla pagina Administracion, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Consulte la siguiente tabla e ingrese la informacidn requerida. Haga clic en los botones a medida que se
habilitan.

Parametro Descripcion

Archivo de claves de la cuenta de servicios de GCP | Archivo JSON que contiene las credenciales de la
cuenta de servicio de GCP

ID del proyecto ID Unica del proyecto Pub/Sub en la consola de GCP

Codificacion de caracteres Conjunto de caracteres en el que se codifican los
datos. Predeterminado: UTF-8. Otras opciones son:
ASCII, UTF-7, UTF-32 y Unicode.

Compresion (Opcional) Tipo de compresidn en conjuntos de
mensajes. Predeterminado: Ninguno. Otras
opciones son gzip y Snappy.

Haga clic en Verificar escritor.
4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al objetivo de Google Cloud Pub/Sub. Para obtener mas informacion, consulte
Conceder acceso a objetivos.

Configure el objetivo del Sistema de archivo distribuido Hadoop
(HDFS)

Complete el procedimiento a continuacién para configurar el destino del Sistema de archivo distribuido Hadoop
y verifique que funcione el escritor HDFS.

Cree el destino del Sistema de archivo distribuido Hadoop antes de configurarlo. Para obtener mas informacion,
consulte Agregar un destino de publicacidn.

1. Enla pdagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Configure el destino del Sistema de archivo distribuido Hadoop con los siguientes parametros:

Parametro Descripcion

HDFS URL URL para acceder a HDFS mediante WebHDFS
directamente o a por la puerta de enlace de Apache
Knox o HttpFS.
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Parametro

Descripcion

Ejemplos:
HDFS — http://host:50070/webhdfs/v1
HttpFS — http://host:14000/webhdfs/v1

Apache Knox — https://host:8443/gateway/default/
webhdfs/v1

Comprobacion del certificado TLS/SSL

Seleccione la casilla de verificacion si esta utilizando
un certificado TLS/SSL. Seleccione la casilla si esta
utilizando un certificado autofirmado.

Nombre de usuario

Nombre de usuario para conectarse a HDFS. El
usuario debe contar con permisos para leer y
escribir en HDFS.

Contrasefna

(Opcional) Contrasefia para autenticar usuario. Se
utiliza al conectarse a Apache Knox o al conectarse a
HttpFS si esta habilitada la seguridad. Si se
proporciona una contrasefia, se usa la autenticacion
HTTP de Hadoop. Si no se ingresa una contraseiia, Pl
Integrator for Business Analytics usa la autenticacion
simple de Hadoop.

Directorio

Directorio donde se crean los archivos de datos.
Haga clic en Buscar para desplazarse al directorio en
el que desea que se ubiquen los archivos.

Anexar marca de tiempo

Al seleccionarlo, una marca de tiempo de la hora de
publicacién de la vista se anexa al nombre del
archivo y se crea un nuevo archivo cada vez que se
publica la vista. Si no se selecciona esta opcidn, los
datos se anexan al archivo existente.

Incluir encabezado

Cuando se seleccionan, los nombres de las
columnas se agregan al comienzo del archivo.

3. Haga clic en Verificar escritor HDFS para verificar que el escritor HDFS se pueda conectar a y escribir en

HDFS.

Nota: Si no puede escribir correctamente en HDFS, consulte Consejos para instalar el Sistema de archivos

distribuido de Hadoop (HDFS)

4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino del Sistema de archivo distribuido Hadoop. Para obtener mas

informacion, consulte Conceder acceso a objetivos.

Consejos para instalar el Sistema de archivos distribuido de Hadoop (HDFS)

Para que HDFS funcione con PI Integrator for Business Analytics, complete las siguientes tareas:
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e Cree el usuario HDFS.

e Cree el directorio de usuarios y conceda permisos.
El siguiente procedimiento describe cdmo completar estas tareas.

1. Cree el usuario HDFS.
a. Cree el usuario HDFS en el nodo donde esta instalado WebHDFS.

b. Agregue el usuario HDFS a un grupo.

Nota: El usuario HDFS se puede agregar a cualquier grupo. Sin embargo, para este ejemplo, nos referiremos
a este grupo como el grupo HDFS.

2. Cree el directorio y conceda permisos.
a. Cree un directorio en HDFS.
b. Cambie el duefio de este directorio por el usuario HDFS.
c. Cambie el grupo al que este directorio pertenece por HDFS.
d. Conceda permisos de lectura y escritura al duefio del directorio (es decir, al usuario HDFS).

e. Conceda permisos de lectura y escritura al grupo al que pertenece el directorio.

Configurar el destino de Microsoft SQL Server

Complete el procedimiento a continuacion para configurar el destino de Microsoft SQL Server y probar la
conexién a la base de datos SQL.

Cree el destino de Microsoft SQL Server antes de configurarlo. Para obtener mds informacion, consulte Agregar
un destino de publicacion.

Nota: Asegurese de que la cuenta de servicio que ejecuta Pl Integrator Framework Service (o el usuario de SQL si
esta utilizando la autenticacion de SQL) tenga los siguientes permisos en Microsoft SQL Server:

Nivel del servidor: CONECTAR SQL, VER CUALQUIER BASE DE DATOS
Nivel de la base de datos: CONECTAR, CREAR TABLA

Todos los esquemas, incluido el esquema dbo: SELECCIONAR, MODIFICAR, INSERTAR, ELIMINAR

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Configure el destino de Microsoft SQL Server con los siguientes parametros:

Parametro Descripcion

Nombre de host Nombre de host e instancia (Hostname\Instance) del
equipo donde se ejecuta SQL Server.

Autenticacidon de nombre de usuario de SQL Nombre de usuario utilizado para conectarse a SQL
Server (especifique Unicamente si utiliza la
autenticacion de SQL Server. Si utiliza la seguridad
integrada de Windows, se usa la cuenta de servicio
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Parametro Descripcion

de Pl Integrator for Business Analytics).

Autenticacion de contraseiia de SQL Contrasefia utilizada para conectar a SQL Server
(especifique Unicamente si utiliza autenticacién de
SQL Server. Si utiliza la seguridad integrada de
Windows, se usa la cuenta de servicio de PI
Integrator for Business Analytics).

Tiempo de espera de publicacion El tiempo asignado para publicar datos en el
objetivo antes de que se agote el tiempo de espera
de Pl Integrator Framework Service. El valor
predeterminado es 30 segundos.

Utilizar alta disponibilidad (Opcional) Conéctese a un SQL Server que admita
grupos de alta disponibilidad y de conmutacién por
error. La opcion Utilizar alta disponibilidad activa la
propiedad de conexién MultiSubnetFailover en la
cadena de conexidn. Para obtener mds informacién
sobre esta propiedad, consulte el sitio web de
Microsoft.

Base de datos Nombre de la base de datos en SQL Server donde se
ubican las tablas.

Esquema Esquema de SQL asociado con las tablas en las que
se almacenan datos.

Haga clic en Conectar para verificar que se pueda conectar a la base de datos SQL.
4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino de Microsoft SQL Server. Para obtener mas informacién, consulte
Conceder acceso a objetivos.

Configurar el destino de publicacion de la base de datos Oracle

Complete el procedimiento para configurar el destino de publicacion de la base de datos Oracle.

1. Instale los componentes de acceso a la base de datos Oracle. Para obtener mas informacidn, consulte
Instalar Oracle Database Access Components.

2. Agregue el objetivo de publicacidn en Pl Integrator for Business Analytics. Consulte Agregar un destino de
publicacién.

3. Configure el destino de publicacidn de la base de datos Oracle. Para obtener mas informacion, consulte
Configurar el objetivo de Oracle.

4. Otorgue al usuario de Oracle que ingresa en la configuracién de destino de publicacion de Pl Integrator for
Business Analytics los siguientes permisos minimos de Oracle:

* Privilegios del sistema: CREAR SESION, CREAR TABLA, ELIMINAR TABLA
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¢ Privilegios del espacio de tabla: cuota suficiente para crear tablas

5. Conceda a los usuarios acceso al destino de publicacién. Consulte Conceder acceso a objetivos.

Instalar Oracle Database Access Components

Nota: Este paso es opcional. Los componentes de acceso a la base de datos Oracle (ODAC) solo son obligatorios
si publica en la base de datos Oracle.

Complete este procedimiento antes de agregar y configurar la base de datos Oracle como destino de publicacién.

1. Instale el software de los componentes de acceso a la base de datos Oracle en el equipo donde esta
instalado Pl Integrator for Business Analytics.

Nota: Consulte Requisitos del sistema para ver la version especifica del software ODAC que debe instalar.

2. Ubique el archivo tnsnames.ora en \ODAC_install_directory\Network\Admin\Sample.
3. Edite el archivo thsnames.ora y agregue una entrada para la base de datos Oracle.

La sintaxis es la siguiente:

Net_Service Name =

(DESCRIPTION=
(ADDRESS=(PROTOCOL=protocol _name) (HOST=Oracle database_host_name) (PORT=port)
(CONNECT_DATA=

(SERVER=service_handler_type)

(SERVICE_NAME=(TNS_listener_service name)

Net_Service_Name es el alias para SERVICE_NAME. Cuando configura el destino de publicacién de Oracle,
puede configurar el pardmetro Data Source en Net_Service_Name. Para obtener mas informacién sobre el
archivo tnsnames.ora, consulte la documentaciéon de Oracle

4. Mueva el archivo tnsnames.ora al directorio \ODAC_install_directory\Network\Admin.
Agregue la ubicacion del software ODAC a la variable de entorno PATH.

6. Cree la variable de entorno del sistema TNS_ADMIN y seiialela al directorio donde se ubica el archivo
tnsnames.ora.

7. Continte agregando la base de datos Oracle como destino de publicacion. Para obtener mds informacion,
consulte Agregar un destino de publicacion.

Configurar el objetivo de Oracle

Complete el procedimiento a continuaciéon para configurar el destino de Oracle y probar la conexidn a la base de
datos Oracle.

¢ Instale los componentes de acceso a la base de datos Oracle.
Consulte Instalar Oracle Database Access Components.

¢ Cree el destino de Oracle. Para obtener mas informacion, consulte Agregar un destino de publicacion.

1. Enla pdagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista
Destinos de Publicacion.

Nota: Si ya seleccioné su objetivo, avance hacia el paso siguiente.
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2. Configure el destino de Oracle con los siguientes parametros:

Parametro

Descripcion

Fuente de datos

Nombre, descriptor de conexién o alias de Oracle
Net Services que identifica la base de datos Oracle

Nota: Consulte Instalar Oracle Database Access
Components para obtener informacion sobre coémo
se especifica el nombre de Oracle Net Services

Nombre de usuario

Nombre de usuario para conectarse a la base de
datos de Oracle

Contrasefa

Contrasefia para conectarse a la base de datos
Oracle

Haga clic en Conectar para verificar que se pueda conectar a la base de datos.

4. Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino de Oracle. Para obtener mas informacién, consulte Conceder acceso

a objetivos.

Configurar el objetivo de publicacion de SAP® HANA® ODBC

Instale el servidor de SAP HANA y el cliente de base de datos de SAP HANA.
Cree el objetivo SAP HANA ODBC antes de configurarlo. Para obtener mas informacién, consulte Agregar un

destino de publicacion.

Verifique los siguientes permisos para el objetivo SAP HANA ODBC:

¢ De manera predeterminada en SAP HANA, el acceso de ODBC a los datos de SAP HANA esta habilitado para
todos los usuarios. Puede limitar el acceso deshabilitando el acceso a ODBC en SAP HANA para usuarios
especificos. Sin embargo, asegurese de que el usuario de SAP HANA que ingresa en la configuracién de
destino de publicacién de Pl Integrator for Business Analytics tenga los siguientes permisos de acceso:

¢ Permiso exclusivo en SYS.SCHEMAS, SYS.TABLES y SYS.TABLE_COLUMNS.

¢ Los siguientes permisos en los esquemas donde se crearan las tablas:

e ALTER

e CREAR

e DELETE

* DROP

e EJECUTAR

e INSERTAR

e SELECCIONAR
e ACTUALIZAR

1. Configure el objetivo SAP HANA ODBC con los siguientes parametros:
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Parametro

Descripcion

Nombre de host

Nombre de host o direccién IP del servidor SAP
HANA.

Puerto

Numero de puerto para conectarse a la instancia de
SAP HANA.

Nombre de usuario

Nombre de usuario utilizado para conectarse a la
instancia de SAP HANA.

Contraseia

Contrasefia utilizada para conectarse a la instancia
de SAP HANA.

Base de datos

(Optional) Si existen multiples bases de datos en la
instancia, la base de datos a la cual se conecta.

Usar conector de TLS/SSL

Utilice TLS/SSL para conectarse al servidor de SAP
HANA.

Nota: Solo se admiten los certificados almacenados
en la tienda de certificados de SAP HANA.

2. Haga clic en Obtener esquemas para completar la lista de esquema.

Seleccione el esquema donde se escriben las tablas de la lista.

Nota: Si la lista esta vacia, uno o mas parametros son incorrectos.

4. Haga clic en Conectar para verificar que pueda abrir la conexién ODBC en SAP HANA.

Haga clic en Guardar cambios.

Otorgue a los usuarios acceso al destino SAP HANA. Para obtener mas informacién, consulte Conceder acceso a

objetivos.

Configurar el objetivo de archivos de texto

Complete el procedimiento a continuaciéon para configurar el destino de archivo de texto.

Cree el destino de archivo de texto antes de configurarlo. Para obtener mds informacidn, consulte Agregar un

destino de publicacién.

1. Enla pagina Administracidn, haga clic en la pestafia Destinos. Luego, seleccione el destino en la lista

Destinos de Publicacion.

Nota: Si ya seleccioné su destino, avance hacia el paso siguiente.

2. Configure el destino de archivo de texto con los siguientes pardmetros:

Parametro

Descripcion

Directorio

Directorio donde se crea el archivo de texto.

Anexar marca de tiempo

Al seleccionarlo, una marca de tiempo de la hora de
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Parametro Descripcion

publicacién de la vista se anexa al nombre del
archivo y se crea un nuevo archivo cada vez que se
publica la vista. Si no se selecciona esta opcidn, los
datos se anexan al archivo existente.

Incluir encabezado Cuando se seleccionan, los nombres de las
columnas se agregan al comienzo del archivo de
texto.

Delimitador de campo Caracteres que separan los valores de datos en

archivo de salida. El valor predeterminado es un
espacio marcado. Para elegir un delimitador de
pestafas, deje el campo en blanco o introduzca \t.

Nota: No utilice un cardcter que aparezca en sus
datos, por ejemplo, un punto. Si usa un punto como
delimitador, el punto en sus datos se eliminara antes
de escribirse en el archivo.

Extension de archivo Extension de archivo de archivos de salida. El valor
predeterminado es .txt.

Nota: A partir de

Pl Integrator for Business Analytics 2020 R2 SP2, las
extensiones de objetivo de archivos de texto estan
limitadas a .csv y .txt. En el caso de los objetivos que
se configuraron con diferentes extensiones antes de
actualizar a 2020 R2 SP2, la extensidn seguira
funcionando para el objetivo preconfigurado.

Si se modifica el objetivo preconfigurado y la
extension se cambia a .csv o .txt, en el futuro, la
extension guardada anteriormente ya no estara
disponible.

3. Haga clic en Guardar cambios.

4. Otorgue a los usuarios acceso al destino del archivo de texto. Para obtener mas informacién, consulte
Conceder acceso a objetivos.

Conceder acceso a objetivos

El siguiente procedimiento describe como un administrador concede permiso a los usuarios para publicar sus
datos en un objetivo de publicacion.

1. Haga clic en el icono del menu E y en Administracion.
2. Haga clic en la pestaia Destinos.

3. Haga clic en el objetivo de la lista Objetivos de publicacidn.
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4. Para conceder acceso al objetivo de publicacién seleccionado, haga clic en Agregar identidad en el panel
Acceso al objetivo.

5. Seleccione la identidad y haga clic en Aceptar.

6. Haga clic en Guardar cambios.

Migrar el destino de Pl View al destino de Microsoft SQL Server

A partir de Pl Integrator for Business Analytics 2020 R2 SP2, el destino de Pl View ha quedado obsoleto y todas
las vistas existentes que utilicen el destino de Pl View tendran la publicacién deshabilitada. Ya no se puede
acceder al destino de Pl View en la lista Publicar destinos de la pestafia Destinos de la pagina Administracion. En
el siguiente procedimiento, se describe como migrar una vista mediante el destino de publicacion de Pl View a
un destino de publicacidon de Microsoft SQL Server como alternativa.

Nota: Si ya no necesita que la vista existente se publique en el destino de Pl View, se recomienda eliminarla
mediante el botdn Eliminar vista. Esto eliminara las tablas de datos y metadatos de la vista en la base de datos
SQL PlintegratorDB en SQL Server; haga esto solo si ya ha migrado su vista a un destino de Microsoft SQL Server
o ha determinado que la vista se puede quitar.

1. Sino tiene configurado un destino de publicacién de Microsoft SQL Server, consulte Configurar el destino de
Microsoft SQL Server.

2. Cree una copia de la vista usando el destino de publicacion de PI View si la selecciona en la pagina Mis vistas
y hace clic en Modificar vista.

3. Compruebe que la vista copiada tenga la configuracion deseada en las paginas Seleccionar datos y Modificar
vista.

4. Una vez que esté lista para publicar, vaya a la pagina Publicar.

Haga clic en la lista Configuracion de destino y seleccione el destino de Microsoft SQL Server que creé en el
paso 1.

6. Seleccione el modo Ejecucidn y la hora de publicacion que desee. Si selecciond la opcidn Ejecutar segin una
agenda, especifique la frecuencia de publicacién para las ejecuciones posteriores.

7. Haga clic en Publicar para publicar la vista.
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Tareas de administracion

Existen varias tareas de administracidon que puede realizar en el sistema PI Integrator, como asegurar vistas para
usuarios especificos y recuperar flujos de salida.

Acerca del grupo de servicio de Pl Integrators

Cuando instala Pl Integrator, se crea el grupo de Windows del grupo de servicio de Pl Integrators y se agrega a
este grupo la cuenta de servicio de Windows o las cuentas virtuales que se especificaron para ejecutar el servicio
de Pl Integrator Framework. El grupo de servicio de Pl Integrators le asigna al servicio de Windows o a las
cuentas virtuales los privilegios minimos obligatorios para ejecutar el servicio de PI Integrator Framework. Por lo
tanto, se recomienda que no agregue la cuenta de servicio de Windows o las cuentas virtuales al grupo local de
administradores en el equipo donde estd instalado PI Integrator.

Eliminar servidores y bases de datos de Pl AF

Puede eliminar los servidores de Pl AF que ya no desee usar en las views.

1. Hagaclic en el icono del menu E y en Administracion.
2. Enla pagina Administraciéon, haga clic en la pestafa Bases de datos de AF.

Seleccione el servidor de Pl AF que desea eliminar de la lista Servidores AF.

Nota: Las bases de datos en el servidor seleccionado se muestran al lado de la lista Servidores AF en la lista
Bases de Datos AF.

4. Haga clic en Eliminar Servidor AF para eliminar el servidor de Pl AF seleccionado y sus bases de datos de la
lista de servidores y bases de datos disponibles.

El servidor de Pl AF ya no aparece en la lista Servidores AF.

Editar un destino de publicacion

En la siguiente seccion se describe como editar los parametros de configuracidn para el destino de publicacion.

Nota: Al editar la configuracién para un destino, los cambios se propagan a todas las vistas que se publican de
manera subsiguiente a ese destino. En adelante, las vistas programadas y las vistas de transmisién que ya estén
en progreso tomaran la nueva configuracion de objetivo en el préximo scan.

Haga clic en el icono del mendu E y en Administracion.
2. Enla pagina Administracion, haga clic en la pestaia Destinos.
Se abre la pagina Configuracion de Destino de Publicacion.

3. Seleccione un destino de publicacidon en la lista Destinos de Publicacion.
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Se abre el panel Configuracion de Destino.

Nota: Cada tipo de destino de publicacién tiene un conjunto Unico de pardametros de configuracién.

4. Edite los parametros en el panel Configuracién de Destino.

Haga clic en el vinculo del destino de publicacion para obtener una descripcién de los pardmetros de
configuracién:

¢ Configurar el destino de Amazon Kinesis Data Streams

e Configurar el objetivo de Amazon Redshift

¢ Configurar el destino de Amazon S3

e Configurar el objetivo de Apache Hive

e Configurar el objetivo de Apache Kafka

¢ Configurar el objetivo de Azure Data Lake Storage Gen 2

¢ Configure el objetivo del Centro de eventos de Azure.

¢ Configurar el objetivo de Azure loT Hub

e Configurar el objetivo de la Base de datos SQL de Azure

¢ Configuracién del objetivo del grupo SQL dedicado de Azure
e Configurar el destino de Google BigQuery

e Configure el destino de Google Cloud Storage

¢ Configurar el objetivo de Google Cloud Pub/Sub

e Configure el objetivo del Sistema de archivo distribuido Hadoop (HDFS)
¢ Configurar el destino de Microsoft SQL Server

e Configurar el objetivo de Oracle

¢ Configurar el objetivo de archivos de texto

5. Haga clic en Guardar cambios.

Eliminar un destino de publicacion

1. Hagaclic en el icono del menu E y en Administracion.

2. Enla pagina Administracion, haga clic en la pestaiia Destinos.
Se abre la pagina Configuracion de Destino de Publicacion.
Seleccione el destino de publicacién que desea eliminar en la lista Destinos de Publicacidn.
Haga clic en Eliminar Destino de Publicacion.

Verifique que el destino de publicacién seleccionado ya no aparezca en la lista Destinos de Publicacidn.

Agregar un registro de esquemas

Nota: Esta funcidn esta disponible en la edicién avanzada Pl Integrator for Business Analytics.

Esta versidon admite el Registro de esquemas confluentes. Solo se admiten los esquemas Avro.
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Haga clic en el icono del menu E y en Administracion.

2. Haga clic en la pestafia Navegador del registro de esquema.

3. En el panel Afiadir registro de esquema, introduzca un nombre y la URL del registro.
La URL debe estar precedida por http:// o https://.

4. Haga clic en Anadir registro de esquema.

El panel Esquemas disponibles se completa con los esquemas del registro. El panel Vista previa del esquema
muestra los pares de valores del nombre del esquema seleccionado.

Afadir un esquema al registro de esquemas

Haga clic en el icono del menu E y en Administracidn.
Haga clic en la pestafia Navegador del registro de esquema.
Seleccione el registro en el panel Registros de esquema.

En la seccidon Anadir o actualizar esquema, haga clic en Seleccionar archivo de esquemas.

i h N e

En la ventana Abrir, busque el archivo de esquema, seleccione el archivo y haga clic en Abrir.

Nota: Solo se admiten los archivos de esquema Avro.

El nombre del esquema se muestra en el panel Esquemas disponibles, y la estructura del esquema se
muestra en el panel Vista previa del esquema.

Administrar vistas

Como administrador, puede realizar las siguientes acciones en las vistas:

e |mportar y exportar vistas
¢ Eliminar vistas
e Agregar usuarios a las vistas

e Eliminar usuarios de las vistas

Administrar el acceso a una vista simple

Puede administrar el acceso a una vista simple

e Puede agregar o eliminar identidades de una vista simple.

¢ Puede cambiar los permisos de una identidad.

Para obtener informacién sobre como administrar el acceso a mas de una vista al mismo tiempo, consulte
Administrar el acceso a multiples vistas.

1. Hagaclic en el icono del menu E y en Administracion.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 74



'AV EVA\TM Pl Integrator for Business Analytics

Tareas de administracion

2. Haga clic en la pestaiia Vistas.
3. Haga clic en la casilla de verificacién para seleccionar una vista.

El panel Detalles muestra la etiqueta Acceso a la vista. Se puede modificar el acceso de cada identidad.
Consulte la seccién Ver permisos de acceso para obtener mas informacion.

Nota: Si la configuracidn de seguridad de suplantacion esta activada, también se mostraran las identidades
de acceso a los datos.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time = View Name
& Baller View 3sbdsh Assel Once B . B2 T-38 PM Boller View
O Compressor . Publshad Assel Onoe *8h . BRI 738 PR View Accass ©
j N TEnm— —
L o1 intagrater

Add
Data Access @
A Administrators 4 Engineers

4 Plimegrator Service 4 Assat Analytics

Import ard Export

Delete

Femove 3elected View

4. Realice cualquiera de las siguientes tareas:

a. Haga clic en la flecha junto a los permisos y seleccione de la lista para cambiar los permisos para la
identidad.

b. Haga clic en Agregar y siga las indicaciones para otorgar a una identidad especifica el acceso a la vista.

c. Seleccione una identidad y haga clic en Eliminar para eliminar el acceso de la identidad a la vista.

Administrar el acceso a multiples vistas

Puede seleccionar multiples vistas al mismo tiempo y agregarles identidades.

Nota: No puede eliminar identidades de multiples vistas. Solo puede eliminar identidades de una vista a la vez.

Las identidades que se agregan a las vistas reciben permiso de propietario de manera predeterminada.

La excepcion a esto es si ya se ha asignado una identidad a una vista. Si la vista es una entre otras vistas
seleccionadas y la misma identidad se asigna a dicha vista, esta conserva todos los permisos que se hubieran
configurado previamente. Por ejemplo, la identidad Ingenieros se asigna a la Vista ABC y recibe permiso de lector
a la vista. Luego, se selecciona la Vista ABC junto con otras vistas, y la identidad Ingenieros se asigna a todas las
vistas. En este caso, la identidad Ingenieros de la Vista ABC conserva su configuracién de permiso existente, es
decir, el de lector. Todas las demas vistas reciben el permiso de propietario predeterminado para la identidad
Ingenieros.

Si un nodo falla, el gerente del grupo reasigna las tareas que se habian asignado a este a los nodos de trabajador
restantes. Servicio de Pl Integrator Framework reinicia automaticamente el nodo de trabajador desconectado.
Una vez que se reinicia, las tareas existentes no se vuelven a equilibrar para incluir el nodo de trabajador
reiniciado. Sin embargo, se equilibran tareas nuevas en todos los nodos de trabajador. Si esto da como resultado
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una distribucion desequilibrada de tareas, puede volver a equilibrarlas a estas en forma manual.
1. Hagaclic en el icono del menu E y en Administracion.

2. Haga clic en la pestaia Vistas.

3. Haga clic en la columna izquierda de las vistas que desea seleccionar.

Views Details
Name Run Status Type Run Mode Start Time End Time Last Run Time View Name
B Boller View Publishec Assel Once 8 . 9/8/22 7:38 PM Multiple Views Selected
@ Compressor Publishe Once 8 : 0/B/22 7:39 PM

View Access ©

Data Access @

Multiple Views Selected

Import and Export

Delete

Remove Selected Views

4. Haga clic en Agregar identidades a las vistas seleccionadas bajo la etiqueta Acceso a la vista.

Nota: Si la configuracion de seguridad de suplantacion estd activada, también se mostraran las identidades
de acceso a los datos.

5. Enlaventana Afadir identidad, seleccione las identidades que desea afiadir y haga clic en Aceptar.

Nota: Si la configuracion de seguridad de suplantacion de la aplicacion estd activada, el acceso a los datos
también se mostrara con la nota “Multiples vistas seleccionadas” en lugar de las identidades.

Mover vistas entre entornos

Algunos navegadores usan como protocolo predeterminado Web Sockets, que aplica un limite de 64K al tamafio
de los paquetes de datos. Debe cambiar el tipo de transporte a Eventos enviados por servidor para los paquetes
de datos mas grandes que se envian al importar y exportar vistas. En la pagina Mis vistas, haga clic en el icono de

engranaje H de la esquina superior derecha y configure Tipo de transporte en Eventos enviados por servidor.
Esto solo se aplica a los navegadores Microsoft Edge.

Mientras trabaja en el desarrollo de sus vistas, es probable que las cree en un entorno de desarrollo y, luego,
compruebe que estas generen los resultados que desea en un entorno de prueba antes de moverlas finalmente
al sistema de produccién. Use Pl Integrator for Business Analytics para mover las vistas entre estos entornos,
exportarlas desde un sistema e importarlas en el otro sistema. Puede exportar vistas en forma individual o en
forma masiva en un archivo de configuracion de vistas.

El siguiente procedimiento asume que usted importa vistas desde el primer sistema y las importa en el segundo.
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Haga clic en el icono del menu E y en Administracion.
2. Enla pagina Administracion, haga clic en la pestaia Vistas.

La pagina Vistas muestra una lista de todas las vistas de la instancia de PI Integrator for Business Analytics.
3. Seleccione las vistas que desea exportar y haga clic en Exportar vistas seleccionadas.

Los archivos se exportan en el directorio de Descargas. Las vistas simples se exportan en un archivo con el
nombre de la vista, por ejemplo, Mi vista de activos.json. Las vistas multiples se exportan en un archivo
llamado archivo exportViews.json.

4. Mueva el archivo exportado a una ubicacion a la que se pueda acceder desde el segundo sistema, es decir, el
sistema en el que desea importar las vistas.

5. En el segundo sistema, en PI Integrator for Business Analytics, haga clic en el icono del menu vy, luego, en
Administracion.

En la pagina Administracidn, haga clic en la pestafia Vistas.
7. Haga clic en Importar vistas.
En la ventana Abrir, seleccione el archivo que exporté y haga clic en Abrir.

La pagina Importar vistas muestra la vista. Si importa un archivo de vistas exportadas, se extraeran las vistas
incluidas en el archivo.

Las vistas importadas pasardn por la validacién del nombre de la vista debido a los caracteres especiales. Si
se considera que un nombre de vista no es vélido, el textBox Nombre de vista se resaltara en rojo y no podra
importar esa vista. Para importar esa vista, puede realizar una de estas dos acciones:

e Cambie el campo ViewnameAllowedSpecialCharacters en C:\ProgramFiles\PIPC\Integrators\BA\
CAST.UL.WindowsService.exe.config para incluir caracteres especiales especificos y, luego, reiniciar los
servicios del integrador. Vuelva a importar las vistas para que ahora pasen la validacién.

¢ Modifique el nombre de la vista directamente en el textBox Nombre de vista. Si la nueva vista pasé la
validacion, el textBox Nombre de vista se resaltara en verde, lo que permitird que el nombre de la vista
pase la validacién y se pueda importar. Para obtener mas informacién, consulte Validacién del nombre

de vista.
Import Views
100%
View Name AF Server AF Database Start Time: End Time | Publish Target | Matches Autostart
Average Building || OAKPIAF v Facilities-16 v | & *-8h - | Apache Kafl ¥ | & 223 :
[ | Daily Temperature| OAKPIAF v | & [ Facilities16 » | & | *-8h [Apache Kafl v | = 223
Weekly Temperail| OAKPIAF v | & | Facilties-16 v | & -8 | Apache Kafl v | & 223

Cancel Import Selected Views

Pl Integrator for Business Analytics intentara ubicar el servidor y la base de datos de PI AF utilizados para
crear la vista en el primer sistema. Si no puede encontrar el servidor o la base de datos, estos campos
guedaran en blanco.

Nota: No se puede importar una vista utilizando el destino de publicacion de PI View, ya que esta en desuso.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 77



'AV EVA\TM Pl Integrator for Business Analytics

10.
11.

12.

13.

Tareas de administracion

Seleccione otro destino de publicacion para importar la vista correctamente.

Seleccione el servidor de PI AF, la base de datos de Pl AF y el destino de publicacién.

La columna Coincidencias le indica el nimero de coincidencias que encuentra de la figura, con el servidor y
la base de datos de PI AF especificados.

(Opcional) Haga clic en Nombre de la vista, Hora de inicio y Hora de finalizacidn para cambiar los valores.

(Opcional) Haga clic en Iniciar automaticamente para iniciar automaticamente la publicaciéon de la vista una
vez que esta se haya importado.

Nota: No puede iniciar automaticamente una vista que nunca se ha publicado.

Tenga precaucion al importar multiples vistas. Una vez que se importaron, comenzaran a ejecutarse
inmediatamente y pueden sobrecargar los recursos del equipo. Recomendamos que configure manualmente
el programa de publicacién si estd importando mas que algunas pocas vistas.

Seleccione las vistas que desea importar y haga clic en Importar vistas seleccionadas.

Las vistas se agregan al final de la lista de vistas. Una vez que se importaron, si Inicio automatico estd
activado, comenzaran a ejecutarse inmediatamente y pueden sobrecargar los recursos del equipo.
Recomendamos que programe manualmente las vistas.

Revierta el ajuste de Tipo de transporte al estado anterior. En la mayoria de los casos, el estado anterior es
Automatico.

Revisar los registros

Puede revisar los registros de cualquier vista en la pestafia Registros de la pagina Administracion.

Puede filtrar los registros al realizar lo siguiente:

¢ especificar el rango de tiempo en los campos Hora de inicio y Hora de finalizacidn;

seleccionar una vista con la lista Nombre de vista;

¢ especificar los tipos de errores (Depurar, Informacion, Advertir, Error).

Puede copiar en el portapapeles los registros que se muestran o puede descargarlos en un archivo.

Configuracion de ambitos de registro

Un ambito de registro define un conjunto de pardmetros configurables que controlan el comportamiento del
inicio de sesidn. Admite la configuracién de niveles de registro, el ajuste de la verbosidad y la limitacidn de la
longitud de los mensajes.

Existen tres tipos de dmbitos de registro:

Predeterminado: La configuracion del inicio de sesidn se aplica a todos los registros.
Espacio de nombre: La configuracion del inicio de sesidn se aplica al espacio de nombre especificado.

Vista: La configuracidn del inicio de sesidn se aplica a la vista seleccionada.

Nota: Se recomienda consultar al equipo de soporte técnico antes de configurar los ambitos de registro. Una
configuracidn incorrecta puede provocar la pérdida de datos de registro importantes o un inicio de sesién
excesivo, lo que puede afectar al rendimiento del sistema y consumir espacio en disco.
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Para establecer dmbitos de registro a fin de personalizar y filtrar el comportamiento de inicio de sesién desde la
pestafia Registros de la pdgina Administracion:

1. Haga clic en el botdn Configuracidn del ambito de registro en el panel del lado izquierdo.
2. Vaya al panel Configuracion.
3. Haga clic en Agregar ambito de registro.

¢ Siva acrear un dmbito de registro de tipo Espacio de nombre, escriba el Espacio de nombre para aplicar
la configuracién.

¢ Siva a crear un ambito de registro de tipo Vista, seleccione la Vista deseada en la lista desplegable.
Para eliminar ambitos de registro de la pestaina Registros de la pagina Administracién:

1. Seleccione el ambito de registro que aparece en Ambitos de registro.
2. Seleccione Eliminar ambito de registro.

¢ No se puede eliminar el ambito de registro Todo (predeterminado).

Consulte la tabla siguiente para configurar un ambito de registro con los siguientes parametros:

Pardmetro Descripcion

Level Informacidn, advertencia, depuracién o error. El nivel
predeterminado es Informacion.

Verbosidad Baja: Registrar el mensaje de excepcién de nivel
superior

Acumulada: Registrar el mensaje de excepcién de
nivel superior y todos los mensajes anidados

Traza: Registrar la excepcién de nivel superior y la
traza

Completo: Registrar el mensaje de excepcién de nivel
superior y todos los mensajes de excepcién anidados y
trazas con hasta 10 niveles de profundidad. El valor
predeterminado es bajo.

Longitud del mensaje Limita la longitud del mensaje. Debe ser mayor de
100. El valor predeterminado es ilimitado.

Configurar las politicas de retencion de registros

Cada vez que se publica una vista, se recopilan y almacenan datos de registros y estadisticas en las siguientes
bases de datos:

¢ Los datos de registro se almacenan en la base de datos SQL de PlintegratorLogs.

Nota: Si consulta la base de datos directamente, las marcas de tiempo se encontraran en formato GMT.

¢ Los datos estadisticos se almacenan en la base de datos SQL de PlintegratorStats.
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Con el tiempo, estos registros pueden ocupar mucho espacio en su servidor y, por lo tanto, Pl Integrator for
Business Analytics elimina peridédicamente los datos estadisticos y los registros. Los ajustes de las tareas se
configuran en el archivo %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config.

El archivo de configuracidn tiene las siguientes secciones separadas para configurar las politicas de los datos
estadisticos y los registros:

¢ La seccidon <maintenanceTasks> determina cuando se eliminaran los registros. Existen dos tareas: Politicas de
retencidn de registros y Politicas de retencidén de datos estadisticos.

¢ Las secciones <logRetentionPolicies>y <statsRetentionPolicies> determinan qué registros se eliminaran.

Politica de retencion de registros

Para obtener informacién general sobre las politicas de retencién de registros, consulte Configurar las politicas
de retencion de registros.

La tarea Politicas de retencidn de registros en la seccion Tareas de mantenimiento del archivo de configuracidn
de la aplicacion determina cuando se eliminardn los registros. De manera predeterminada, los registros se
eliminan cada 24 horas a las 7:00 a. m.

En la siguiente tabla, se describen los parametros de la tarea.

Parametros de la tarea Politicas de retencién de registros

Parametros Descripcion del parametro Valor predeterminado
taskName Nombre de la tarea de retencion de | add

registros. No cambie este valor. taskName="logRetentionPolicies"
runFrequency Frecuencia con la que se ejecuta la | runFrequency="24hours"

tarea Politicas de retencion de
registro. Use Pl Time para
especificar las unidades de tiempo.
runFrequency y timeOfDay en
conjunto determinan cuando se
realiza la tarea.

timeOfDay Tiempo en que se ejecuta latarea | timeOfDay="7:00"
Politicas de retencidon de registro.
Use PI Time para especificar las
unidades de tiempo. runFrequency
y timeOfDay en conjunto
determinan cudndo se realiza la
tarea.

Politica de retencion de registros

La politica en la seccién Politicas de retencién de registros determina qué registros se eliminaran. Los registros
mas antiguos se eliminan primero.

Nota: Si se elimina la politica, los registros se mantienen de manera indefinida.
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Puede eliminar los registros segun cualquier combinacién de las siguientes opciones:

¢ Laantigliedad de los registros

¢ La cantidad de registros

¢ Eltamafio total de todos los registros

La politica predeterminada elimina los registros de mas de dos meses de antigliedad, mantiene el nimero de
registros en 100 000 o menos, y mantiene el tamano maximo de los registros en 1000 MB 0 menos.

Nota: Cada vez que la eliminacidn programada elimine correctamente cualquier cantidad de registros, la politica
también realizard una operacidn de reduccidon automatica en la base de datos para reducir su tamafio.

Parametros de la politica Politicas de retencion de registros

Parametro

Descripcion del parametro

Valor predeterminado

uniquePolicyName

Nombre de la politica.

uniquePolicyName="LogsPolicy1"

maximumTableRecordAge

Antigliedad maxima de los registros
especificada en meses. Se utiliza
con maximumTableRowCount y
maximumTableSizeOnDisk para
determinar qué registros se
eliminan.

maximumTableRecordAge="2mont
hs n

maximumTableRowCount

Cantidad maxima de filas de datos
del registro. Se utiliza con
maximumTableRecordAge y
maximumTableSizeOnDisk para
determinar qué registros se
eliminan.

maximumTableRowCount="100000

n

maximumTableSizeOnDisk

Tamafio maximo de todos los
registros, especificado en
megabytes (MB). Se utiliza con
maximumTableRecordAge y
maximumTableRowCount para
determinar qué registros se
eliminan.

maximumTableSizeOnDisk="1000"

Politica de retencidon de datos estadisticos

Tarea Politica de retencion de datos estadisticos

Los datos estadisticos de cada vista se almacenan en una tabla diferente, en la base de datos SQL de
PlintegratorStats. El nombre de la tabla es la identificacidn de la vista.

La tarea Politicas de retencidn de datos estadisticos en la seccidon Tareas de mantenimiento del archivo de
configuracion de la aplicacidon determina cuando se eliminaran los registros de datos estadisticos. En la siguiente
tabla, se describen los parametros de la tarea Politicas de retencidn de datos estadisticos.
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Parametros de la tarea Politicas de retencion de datos estadisticos

Parametro Descripcion del parametro Valor predeterminado

taskName Identifica el nombre de la tarea de | taskName="statRetentionPolicies"
retencion de datos estadisticos. No
cambie este valor.

runFrequency Frecuencia con la que se ejecuta la | runFrequency="24hours"
tarea Politicas de retencién de
datos estadisticos. Use Pl Time para
especificar las unidades de tiempo.
runFrequency y timeOfDay en
conjunto determinan cuando se
ejecuta la tarea.

timeOfDay Tiempo en que se ejecuta latarea | timeOfDay="7:00"
Politicas de retencién de datos
estadisticos. Use Pl Time para
especificar las unidades de tiempo.
runFrequency y timeOfDay en
conjunto determinan cuando se
ejecuta la tarea.

De manera predeterminada, los registros de datos estadisticos se eliminan cada 24 horas tras el inicio.

Politicas de retencion de datos estadisticos

Las politicas de la seccién Politicas de retencién de datos estadisticos determinan qué registros de datos
estadisticos se eliminardn. Las politicas de retencién de datos estadisticos asumen que las vistas se publican en
intervalos programados, y la frecuencia de publicacién determina qué registros se eliminaran. En general, cuanto
mayor sea la frecuencia con se publique una vista, mas estadisticas se generaran, y usted deberd eliminar
registros con mas frecuencia. Esto es cierto para las vistas de activos, vistas de eventos y vistas de transmision
programada.

Las vistas de transmisidn que se publican en respuesta a los cambios en los valores clave no se publican en
intervalos regulares. Por lo tanto, para administrar eficazmente la cantidad de datos estadisticos en la base de
datos, Pl Integrator for Business Analytics asume que la transmisidn de datos en estas vistas se produce con la
mayor frecuencia posible, es decir, en intervalos de 30 segundos. Por lo tanto, la politica que incluye la
frecuencia de publicacion de 30 segundos se aplica a todas las vistas de transmisidon desencadenadas por valores
clave.

Nota: Las estadisticas de las vistas que solo se publican una vez se mantienen por tiempo indefinido hasta que la
vista se elimine.

Las siguientes politicas se definen de manera predeterminada:

e StatsPolicyl: define una politica para las vistas publicadas con una frecuencia de un segundo a cinco
minutos.

e StatsPolicy2: define una politica para las vistas publicadas con una frecuencia de mas de cinco minutos a una
hora como maximo.
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e StatsPolicy3: define una politica para las vistas publicadas con una frecuencia de mas de una hora.

Puede editar las politicas predeterminadas o crear politicas adicionales, y especificar el nivel de granularidad que
requiera. Compruebe que las politicas abarquen todos los intervalos de tiempo posibles. Si un intervalo de
tiempo no esta incluido, los registros de datos estadisticos de las vistas publicadas en el intervalo faltante se

mantendran por tiempo indefinido.

Para cada politica, puede eliminar los registros de una vista segln la combinacién de las siguientes opciones:

¢ laantigliedad de los registros de la tabla,

¢ el numero total de los registros de la tabla,

¢ el tamafio total de la tabla.

En la siguiente seccion, se describen los parametros de la politica statRetentionPolicies y se detallan los valores
predeterminados de una de las politicas: StatsPolicyl.

Parametros de la politica Politicas de retencion de datos estadisticos

Parametro

Descripcion del parametro

Parametros predeterminados de
StatsPolicyl

uniquePolicyName

Nombre de la politica. Los nombres
de la politica deben ser Unicos. Si
hay multiples politicas con el
mismo nombre, el archivo de
configuracidn no se ejecutard y se
generara un error.

uniquePolicyName="StatsPolicy1"

filterMinimumRunFrequency

El limite minimo de la frecuencia de
publicacion de la vista. Se utiliza
con filterMaximumRunFrequency
para determinar a qué vistas se
aplica esta politica.

filterMinimumRunFrequency="1sec
ond"

filterMaximumRunFrequency

El limite maximo de la frecuencia
de publicacién de la vista. Se utiliza
con filterMinimumRunFrequency
para determinar a qué vistas se
aplica esta politica.

filterMaximumRunFrequency="5mi
nutes"

maximumTableRecordAge

La antigliedad de los registros mas
antiguos que se conservan. Se
utiliza con
maximumTableRowCount y
maximumTableSizeOnDisk para
especificar qué registros se
eliminan.

maximumTableRecordAge="24hrs"

maximumTableRowCount

La cantidad maxima de filas que se
conservan en la tabla. Si la cantidad
de filas supera este numero, los

maximumTableRowCount="100000

1
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Pardmetros predeterminados de

Parametro Descripcion del parametro .
P P StatsPolicyl

registros mas antiguos se eliminan
primero. Se utiliza con
maximumTableRecordAge y
maximumTableSizeOnDisk para
especificar qué registros se
eliminan.

maximumTableSizeOnDisk El tamafio maximo de la tabla en maximumTableSizeOnDisk="200"
megabytes (MB). Los registros mds
antiguos se eliminan primero. Se
utiliza con
maximumTableRecordAgemaximu
mTableRecordAge y
maximumTableRowCount para
especificar los registros que se
eliminaran.

En la siguiente seccion, se describe la politica StatsPolicyl con sus valores predeterminados. La politica
StatsPolicy1 se aplica a las vistas que se publican con una frecuencia de un segundo a cinco minutos como
maximo. Para cada vista, se conservan los registros de datos estadisticos hasta 24 horas de antigliedad, la
cantidad de filas de la tabla de la vista no supera las 100 000, y el tamafio total de la tabla no supera los 200 MB.
Se eliminaran los registros que no cumplan con las tres condiciones. En todas las politicas de retencion, los
registros mas antiguos se eliminan primero.

Nota: Cada vez que la eliminacidn programada elimine correctamente cualquier cantidad de registros, la politica
también realizard una operacién de reduccién automatica en la base de datos para reducir su tamafio.

Licencia y flujos de salida

La pestaia Licencias en la pagina Administracién proporciona informacién sobre la cantidad de flujos de salida
usados y las views que usan los flujos de salida.

Un flujo de salida es una Pl tag (punto de datos) que se publica en un destino o al que solo se hace referencia en
una vista. A flujo de salida Unica es una PI tag Unica publicada en una o mas views.

El contrato de licencias y paquete especifico de software determina la cantidad maxima de flujos de salida Unica
gue puede tener a la vez.

Por ejemplo, supongamos que Pl Integrator estd configurado con tres views: ProcLab1, TestPrd y Fieldoutput.
ProcLabl usa 20 flujos de salida (15 flujos de salida Unica, 5 flujos de salida que no es Unica), TestPrd usa 2 flujos
de salida uUnica y Fieldoutput usa 22 flujos de salida (2 flujos de salida Unica y 20 flujos de salida que no es Unica).
La lista Flujos de salida segtn la vista muestra las 3 views con los flujos de salida totales usados en cada view. Se
muestran los siguientes totales:

¢ Flujos de salida tinica consumidos muestra 19 flujos de salida.

¢ Flujos de salida restantes muestra el equilibrio de los flujos de salida disponibles. La cantidad de flujos
totales disponibles depende de la cantidad maxima que se permite con su licencia.
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Aumentar los flujos de salida disponibles

Si la cantidad de flujos de salida es insuficiente para satisfacer sus necesidades, puede actualizar a una version
con una cantidad maxima mas elevada. Para obtener mas informacién sobre los recuentos maximos de flujos de
salida disponibles, comuniquese con su gerente de cuentas de AVEVA.

Recuperar flujos de salida

Recuperar flujos de salida de views eliminadas libera la cantidad de flujos de salida Unica disponibles para views
nuevas. Es importante comprender que eliminar una vista en la pagina Mis vistas no cambia de inmediato la
cantidad de flujos de salida Unica usados en referencia al limite de licencias. Los flujos de salida Unica no se
recuperan de inmediato cuando se elimina o borra una vista. Se recuperan una vez transcurridos 7 dias desde la
ultima publicacién de datos de la Pl tag.

Un servicio interno recupera de manera automatica el flujo de salida. La primera recuperacion tiene lugar en el
inicio de la aplicacion Pl Integrator y, de alli en mds, el servicio se ejecuta una vez cada 24 horas. Por lo tanto, ya
no es necesario hacer clic manualmente en el botén Recuperar todas las secuencias, ya que los flujos elegibles
se recuperan de manera automatica una vez por dia.

Cambiar la cuenta de servicio de Windows

Puede cambiar la cuenta de servicio que ejecuta Pl Integrator for Business Analytics. Puede especificar una
cuenta de servicio de Windows, una cuenta de servicios administrados grupal (gMSA) o cuentas virtuales de
Windows. Si cambia de una cuenta gMSA o cuentas virtuales o a una cuenta gMSA o cuentas virtuales, recuerde

lo siguiente:

¢ Sicambia de una cuenta de servicio de Windows con autenticacidon SQL a una cuenta gMSA o cuentas
virtuales, la cuenta gMSA o las cuentas virtuales deben utilizar la autenticacidon de Windows para realizar la
autenticacion con SQL Server backend que aloja Pl Integrator for Business Analytics. No se puede configurar
para utilizar la autenticacion SQL.

¢ Si cambia de una cuenta gMSA o cuentas virtuales o cambia a una cuenta gMSA o cuentas virtuales, una vez
gue se realiza el cambio, debe volver a ingresar las credenciales para cada objetivo de publicacion.

Compruebe que la cuenta de usuario que ha iniciado sesion o la cuenta de usuario que ejecuta la utilidad de
cambio de cuenta de servicio tengan los siguientes permisos:

¢ Privilegios de administrador local en el servidor de Microsoft Windows Server donde estd instalado
Pl Integrator for Business Analytics.

¢ Privilegios de administrador en el servidor de Pl AF donde estd instalada la base de datos de configuracién de
Pl Integrator for Business Analytics.

Nota: El servidor de PI AF se identifica en el archivo %PIHOMEG64%\Integrators\BA\
CAST.UL.WindowsService.exeen la seccion <appSettings> con la clave InstancePath.

También se requieren los siguientes permisos para la cuenta de usuario que ha iniciado sesién o la cuenta de
usuario que ejecuta la utilidad de cambio de cuenta de servicio:

e Permiso ALTERAR CUALQUIER INICIO DE SESION en SQL Server
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¢ membrecia de rol de base de datos db_owner en las bases de datos PlintegratorDB y PlintegratorLogs y
PlintegratorStats

Nota: La Unica excepcidn se da cuando se usa autenticacién de SQL y no se quiere cambiar la cuenta de SQL;
en este caso, no se necesitan estos permisos adicionales.

Si el usuario que realiza la instalacién no tiene los permisos requeridos en las bases de datos de SQL, un
usuario con privilegios de sysadmin debe ejecutar primero el archivo Go.Bat, que se encuentra en
%PIHOME64%\Integrators\BA\SQL.

Si usa autenticacidn de SQL y no quiere cambiar la cuenta de SQL, no necesita ejecutar estos archivos.

¢ La nueva cuenta de servicio de Windows que ejecutara Pl Integrator Framework Service debe contar con
derechos de “Inicio de sesién como servicio” en el equipo donde esta instalado Pl Integrator for Business
Analytics. Un usuario con privilegios de administrador puede asignar este derecho al servicio. El
procedimiento para realizar esta asignacidn varia en funcién del sistema operativo y la versidén de software
de su computadora.

¢ Lanueva cuenta de servicio de Windows también debe tener un perfil local. Inicie sesién con la nueva
cuenta de servicio para crear un perfil en Microsoft Windows Server, donde estd instalado PI Integrator for
Business Analytics.

Una vez hecho esto, continte con el procedimiento siguiente.

¢ Sicambia de una cuenta de servicio de Windows con autenticacidon SQL a una cuenta gMSA o cuentas
virtuales, la cuenta gMSA o las cuentas virtuales deben utilizar la autenticacidon de Windows para realizar la
autenticacion con SQL Server backend que aloja Pl Integrator for Business Analytics. No se puede configurar
para utilizar la autenticacion SQL.

¢ Si cambia de una cuenta gMSA o cuentas virtuales o cambia a una cuenta gMSA o cuentas virtuales, una vez
gue se realiza el cambio, debe volver a ingresar las credenciales para cada objetivo de publicacién.

1. En el directorio %PIHOME64%\Integrators\BA ejecute el archivo ChangelntegratorServiceAccount.exe
como Administrador.

2. Sigalas indicaciones y proporcione la contrasefia de la cuenta que esta ejecutando el servicio de
Pl Integrator Framework.

Nota: Primero debe proporcionar la contrasefa de la cuenta de servicio que esta ejecutando el servicio de
Pl Integrator Framework antes de poder cambiar la cuenta de servicio.

Si la cuenta es una cuenta gMSA o cuentas virtuales, no proporcione una contrasefia y omita este paso.

3. Siga las indicaciones y proporcione la cuenta de servicio y la contraseia de la nueva cuenta de servicio que
ejecutara los servicios de Pl Integrator for Business Analytics.

La utilidad Change Service Account agrega la nueva cuenta y sus permisos a Pl AF y SQL Server.

Nota: Si la nueva cuenta de servicio es una cuenta gMSA, indique el nombre de la cuenta de servicio y no
proporcione la contrasefia. Para las cuentas virtuales, no se necesitan el nombre ni la contrasefia de la
cuenta de servicio.

4. Presione Intro para salir de la utilidad.

Si cambia de una cuenta gMSA o cuentas virtuales o a una cuenta gMSA o cuentas virtuales, debera volver a
ingresar las credenciales para cada uno de sus objetivos de publicacion.
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Cambiar el puerto de Pl Integrator

Cuando cambia el puerto de PI Integrator, los usuarios que hayan iniciado sesién en la aplicacion web PI
Integrator for Business Analytics deberan reingresar la URL con el puerto nuevo. Las views que se ejecuten al
momento de cambiar el puerto se completaran correctamente.

1. En el Panel de control de Microsoft, navegue a Programas y caracteristicas.

2. Haga clic con el botén secundario en PI Integrator for Business Analytics de la lista y luego haga clic en
Cambiar en el mend.

Se abre la ventana Configuracién de Pl Integrator for Business Analytics 2020.
Haga clic en Modificar y luego haga clic en Siguiente.

4. En laventana Informacidén de inicio de sesidn, ingrese el nombre de usuario y la contrasefa para la cuenta de
servicio de Windows que ejecutard el Servicio de Pl Integrator Framework. Haga clic en Siguiente.

5. Enla ventana Configuracién de puerto y certificado TLS, ingrese un nimero de puerto diferente y haga clic
en Validar puerto para verificar la disponibilidad del puerto.

Haga clic en Siguiente.
7. Enlaventana Listo para modificar la aplicacién, haga clic en Instalar.

Una vez que se haya completado la instalacion, la aplicacion utilizard un puerto nuevo.

Cambie la configuracion del certificado TLS

En el Panel de control de Microsoft, navegue a Programas y caracteristicas.

2. Haga clic con el botdn secundario en Pl Integrator for Business Analytics de la lista y luego haga clic en
Cambiar en el menu.

Se abre la ventana Configuracién de Pl Integrator for Business Analytics.
Haga clic en Modificar y luego haga clic en Siguiente.

4. En laventana Informacién de inicio de sesidn, ingrese el nombre de usuario y la contrasefia para la cuenta de
servicio de Windows que ejecutara el Servicio de Pl Integrator Framework. Haga clic en Siguiente.

5. Enla ventana Configuracién de puerto y certificado TLS, elija un certificado TLS de una de las siguientes
fuentes:

¢ Certificado autofirmado que se genera durante la instalacion: esta es la opcidn predeterminada. Elija
Certificado autofirmado.

Nota: Si elige esta opcidn, los usuarios que inicien sesidn en equipos remotos pueden ver un mensaje de
advertencia de seguridad. Para evitar esta advertencia en los certificados autofirmados, el certificado
debe ser explicitamente confiable en el equipo cliente. Consulte la solucidn en el articulo de la Base de
conocimientos Se produce un error de certificado al navegar a un sitio web de Pl Vision o PI Web API con
un certificado autofirmado.

¢ (Recomendado) Certificado TLS de una entidad de certificacion: elija Importar certificado y haga clic en
Seleccionar certificado para elegir un certificado que haya sido emitido por una entidad de certificacién
e importado al equipo donde se esta instalando PI Integrator for Business Analytics.

6. Haga clic en Siguiente.

7. Enlaventana Listo para modificar la aplicacién, haga clic en Instalar.
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Una vez que se haya completado la instalacidn, la aplicaciéon utilizara un certificado TLS nuevo.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 88



'AV EVA\TM Pl Integrator for Business Analytics

Tipos de datos no admitidos

Tipos de datos no admitidos

Int16
Pl Integrator for Business Analytics no admite el tipo de datos Int16 en estas situaciones:

¢ Los datos guardados en destinos de AWS S3 o Azure Data Lake Gen 2 con el formato Parquet no se pueden
publicar como datos Int16.

¢ Los datos serializados de Avro que se publican en cualquier destino de transmisidon no pueden publicarse
como datos Int16.

En estos casos, Pl Integrator for Business Analytics convierte automaticamente los datos Int16 en tipo de datos
Integer.
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1.
2.

Abra un explorador web.
Ingrese la direccién URL para la aplicacion Pl Integrator for Business Analytics.

La direccidon URL sefala el equipo y puerto host para Pl Integrator for Business Analytics. La URL es
https://hostname:port number o FQDN:port number, donde FQDN es el nombre de dominio completo. Si usa
el puerto 443, puede omitir este nimero de puerto cuando especifique la direccion URL. Si instalé Pl
Integrator for Business Analytics en un host lab5 en el dominio prod.onet.com y lo configuré para usar el
puerto 7777, puede ingresar cualquiera de las siguientes opciones: https//lab5.prod.onet.com:7777,
https://lab5:7777.

Nota: Si no esta seguro de qué puerto se especificéd durante la instalacion de

Pl Integrator for Business Analytics, dirijase al equipo donde se instald Pl Integrator for Business Analytics.
Abra %PIHOMEG64%\Integrators\BA\CAST.Ul.SelfHost.exe.config y localice el valor de la clave
"SelfHostPort". Consulte la direccidn URL con el administrador del sistema Pl Integrator for Business
Analytics.

Se abre la aplicacién en la pagina Mis Views.

Haga clic en el icono E de menu para abrir el menu de Pl Integrator for Business Analytics.

Se abre el siguiente menu:
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™ My Views

Manage your data views

% Create Asset View

Build a data view starting with
your asset hierarchy

"4 Create Event View

Build a data view starting with
your event frame hierarchy

% Create Streaming View

Build a streaming view with a
custom output shape

/ Administration

Manage servers, users, and
targets

Pl Integrator for Business Analytics
Iniciar Pl Integrator for Business Analytics

Puede abrir este menu desde cualquier lugar de la aplicaciéon y realizar lo siguiente:

Desplacese a la pagina Mis vistas. Para obtener mas informacidn sobre la pagina La pagina My Views,
consulte lapdgina Mis vistas.

Cree una vista de activos. Para obtener mas informacidn sobre cémo crear vistas de activos, consulte
Crear una view con activos.

Cree una vista de eventos. Para obtener mas informacidn sobre cédmo crear vistas de eventos, consulte
Crear una view para eventos.

Cree una vista de transmision. Para obtener mas informacion sobre como crear vistas de transmision,
consulte Crear una vista de transmision. Esta funcion estd disponible en la edicion avanzada de PI
Integrator for Business Analytics.

Desplacese a la pagina Administracidn. Para obtener mas informacidn sobre las tareas que puede realizar
en esta pagina, consulte Tareas de administracion.
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Cuando ingresa la direccién URL para PI Integrator for Business Analytics, la aplicacidn se abre en la pagina Mis
vistas. En esta pagina, puede crear y editar vistas de activos, vistas de eventos y vistas de transmision. Esta
pagina también muestra la lista de views a las que tiene acceso. A continuacion, se incluyen una captura de
pantalla y una tabla para describir qué informacidn hay disponible sobre la view y como usar esta pagina.

m

Create Asset View @ + Create Event View @ + Create Streaming wwe [ Modify View @ % Remove View @ ‘ @
Name Run Status Run Moge A& Start Time =7 @' Last Run Time
Average Building Temperature :Iezruvg Streaming Out duled Stream & B Column A Apr 1 10°:27-38 P
Buil g 16% Assel il Autosize This Column Apr 15, 44 PM
Building HVAC Streaming Streaming Out led Stream Autosize ARl Columns 5, 2018 10:27-00 PM
Daily Temperature Fublished Asset 8 Sort Ascending Apr 15, 2018 3:36:31 PM
Floor One Temperature Scheduled Asset o Continuous ~8h Sort Descending Apr 15, 2018 10:27-35 PM
Floor Three Published Asset LFY once 8 Remove Sort Apr 15, 2018 3°55:53 PM
Floor Three AVAC Scheduled Asset Continuous 8h Columns. Apr 15, 2018 10:27-28 PM
Floor Two Temperature Pubisning34% LR COMINUCUS ~8n . Apr 15, 2018 10:27-33 PM
Weekly Temperature Stopped By User Asset Continuous ~8h ¥ Apr 15, 2018 10:26.55 PM
(8) 2
2 - ]
Overview Log Security View Cenfiguration Statistics
Run Status Publishing 16% Publish Actions Search Shape
S— Asset Shape
View Name Building AVAT P
4 @ vavee
Pl AF Database Facilities-1600 Alvarado “ # % cooling
Publish Target SOL Server # % heating
) . ore air signal (cooling)
& air signal (heating)
Run Mode Continuous
Run Frequeney 1 Minutes

Last Run Time

Apr 15, 2018 10:27:44 PM

Nimero

Descripcion

Todas las views a las que tiene acceso se enumeran en
la tabla. Solo puede editar views para las cuales tiene
permisos de acceso de escritura. Puede realizar una
copia de una view para la cual tiene permisos de
acceso de lectura y luego editar la copia.

Use Crear view con activos para crear una view con
activos. Para obtener mas informacioén, consulte Crear
una view con activos.

Use Crear view para eventos para crear una view para
eventos. Para obtener mas informacion, consulte
Crear una view para eventos.

Use Crear vista de transmision para crear una vista de
transmision. Para obtener mds informacidn, consulte
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Nimero

Descripcion

Crear una vista de transmision. Esta funcion esta
disponible en la edicién avanzada de Pl Integrator for
Business Analytics.

Para modificar una view, seleccione la view en la tabla
y haga clic en Modificar View.

Para eliminar una vista, seleccione la vista en la tabla y
haga clic en Eliminar lista. Al eliminar una vista,
elimina su nombre de la lista de nombres de vista
reservados. Tenga en cuenta que, al eliminar una vista,
no se liberan los flujos de salida disponibles
permitidos con su licencia hasta que no hayan
transcurrido siete dias.

Para obtener mas informacidn, consulte Recuperar
flujos de salida

Haga clic en las barras para abrir y cerrar el panel de
detalles con las pestafas Descripcion general,
Registro, Seguridad, Ver configuracion y Estadisticas.

Las pestafias Descripcion general, Registro,
Seguridad, Ver configuracion y Estadisticas
proporcionan los siguientes detalles sobre la vista:

¢ Descripcion General indica si la view ha sido
publicada. En esta pestafia también se resume
informacion sobre la vista, como la base de datos
de PI AF que usa, el momento en que se ejecutod la
vista por ultima vez y la figura que usa. Si la view
se estd publicando actualmente, la barra de
estado de ejecucidn indica el progreso y usted
tiene la opcidn de detener el proceso de
publicacion.

¢ La pestafa Registro muestra informacion de la
vista seleccionada. Puede ajustar las horas inicial y
final, y puede filtrar los mensajes para mostrar los
de determinada gravedad, por ejemplo, errores
criticos.

Nota: Para proteger el uso de recursos, las
descargas de registros se limitan a un maximo de
100 000 filas, independientemente de las horas de
inicio y finalizacidn del intervalo de recuperacion
de registros. Si necesita la tabla completa de
registros, puede recuperarla de la base de datos
sQlL.
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Nimero

Descripcion

e Seguridad muestra quién tiene acceso a la view y,
si tiene suficientes privilegios, le permite cambiar
el nivel de acceso.

¢ La pestafa Ver configuracion le ofrece una
descripcidn general rapida de sus vistas, incluidos
los elementos y los atributos de la vista, los
detalles acerca de los elementos y atributos, y los
filtros de registros que hubiera.

¢ La pestana Estadisticas muestra los datos
estadisticos de la vista seleccionada. Para obtener
mas informacidn, consulte Ver datos estadisticos.

Coloque el cursor en el encabezado de columna para

activar el icono de mend = vy haga clic en este para
abrir el menu. Desde este menu, puede cambiar el
tamafio de las columnas, clasificar los datos de la
columna y agregar o eliminar columnas de la tabla.

10

El icono de contador de mensajes rojo en la parte
superior derecha muestra la cantidad de mensajes de
advertencia y error registrados por Pl Integrator for
Business Analytics. Haga clic en el icono para abrir la
lista de mensajes. Haga clic en los comandos en la
parte superior de la lista de mensajes. Suprimir
alertas/Anular Supresion de Alertas activa y desactiva
las alertas. Agregacion desactivada/Agregacion
activada controla cuantas multiples instancias de un
mensaje se informan. Agregacidn desactivada informa
cada instancia de un mensaje. Agregacion activada
muestra el mensaje una vez e informa la cantidad de
instancias. Borrar todo elimina todos los mensajes de
la lista.

o

Alerts Aggregation: Off Clear

A critical error has occurred,

=]
(V3]
m
1K}
=
=
[ k]
X S

vent log for further details.
2272015, 15124 PM Details
[

11

Haga clic en el icono del engranaje E en la parte
superior derecha para ver la version de Pl Integrator
for Business Analytics y del servidor Pl AF y para
cambiar la configuracion regional y de idioma.
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Coémo utilizar
Pl Integrator for Business Analytics

Pl Integrator for Business Analytics proporciona una interfaz de usuario web facil de usar. Las caracteristicas
principales incluyen: Crear una view con activos, Crear una view para eventos y Crear una vista de transmision; y
Modificar una view, Copiar una view y Asegurar las views.

Vistas de PI Integrator for Business Analytics

Una view es una descripcion modelada de los datos de Pl System que desea analizar. Existen varios tipos de
vistas: vistas de activos, vistas para eventos y vistas para transmision. La pregunta que se haga determinara qué
tipo de vista es la mds adecuada para abordar su caso de uso. El siguiente es un ejemplo de cdmo puede usar
cada uno de los tipos de vistas para responder diferentes preguntas sobre su organizacion.

Las vistas con activos organizan datos en torno a sus activos y le permiten realizar comparaciones entre los
activos.

Por ejemplo, supongamos que desea analizar un conjunto de turbinas edlicas por potencia de megavatio y
ver los resultados por modelo de turbina y fabricante. Podria crear una view de activos basada en una
plantilla de elemento de turbina con los atributos de potencia de megavatio, modelo y fabricante. Esto le
permitiria comparar el rendimiento en su flota de turbinas edlicas.

Las vistas para eventos organizan datos en torno a los event frames y le permiten detectar patrones en los
event frames.

Nota: Pl Integrator for Business Analytics solo arroja event frames cerrados (con una hora de inicio y una
hora de finalizacidn validas). No puede publicar datos de event frame abierto.

Usemos el mismo ejemplo mencionado anteriormente y supongamos que ahora desea revisar el tiempo de
inactividad de las turbinas edlicas. Podria crear una view para eventos en la que se compare la duracidn de
los tiempos de inactividad y se incluyan los atributos de modelo y fabricante para ver si existe un patrén para
los marcos de evento de tiempo de inactividad.

Las vistas de transmisidn organizan los datos en torno a los activos y le permiten poner estos datos a
disposicion practicamente en tiempo real para realizar analisis predictivos.

Continuando con el ejemplo anterior, asuma que desea predecir la potencia de cada turbina edlica durante
la préxima hora segun los datos actuales. Podria crear una vista de transmision que incluya la velocidad del
viento, la densidad del aire y la potencia actual de la turbina en megavatios, y usar estos datos para crear un
modelo de analisis que prediga la potencia segun esta informacion.

;Qué es una figura?

Las vistas se construyen a partir de una figura, que es un patrén de busqueda de datos dentro de Pl System. La
definicion de forma proporciona la siguiente informacién que es fundamental para crear la vista:
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¢ qué datos se deben incluir; y

e como se estructuran los datos en la vista.

Las formas proporcionan la capacidad Unica de buscar relaciones entre elementos y atributos, asi como los
mismos elementos y atributos. Con Pl Integrator for Business Analytics, puede definir elementos primarios,
secundarios y su relacién como parte de la figura, asi como los parametros de busqueda por categoria, nombre y
plantilla mas tradicionales. También puede ampliar la figura para encontrar coincidencias para marcos de evento
o activos derivados de la misma plantilla.

Cada figura corresponde a una vista respectiva:

¢ Las figuras de activo contienen los activos, los atributos y sus relaciones en las vistas de activo.

¢ Las figuras de activo y de transmisidon se crean de la misma manera. Las vistas difieren en el Disefiador de
mensajes: las vistas de activos se presentan en un formato tabular, y las vistas de transmisidn se presentan
en el formato de pares de valores-atributos.

¢ Las figuras de evento contienen los event frames, los atributos de event frames, los elementos de referencia
y los atributos de elementos de referencia en las vistas del evento.

Descripcion general sobre como usar Pl Integrator for Business
Analytics

Aqui se describe como usar Pl Integrator for Business Analytics a fin de generar datos para la toma de decisiones
para la herramienta de BI.

Sugerencia: Si usa Pl Integrator for Business Analytics por primera vez, le recomendamos que comience con la
exploracion de cédmo crear una vista de activos y que continte con la creacién de vistas de eventos o de
transmision

1. Seleccione los datos de Pl System que desea incluir en el andlisis.

Determine si el andlisis requiere una vista de activos, una vista de eventos o una vista de transmision. Si
desea analizar los datos desglosados por activos, cree una view con activos. Si desea analizar los datos por
marcos de evento, cree una view para eventos. Si desea analizar sus datos desglosados por activos y necesita
que los valores se transmitan para el andlisis en tiempo real o algun otro tipo de analisis, cree una vista de
transmision.

¢ Vista de activos: comience creando una figura simple, por ejemplo, para encontrar un activo simple. El
panel Coincidencias es una vista previa de los elementos que se encuentran en la base de datos de PI AF
que coinciden con la figura.

¢ Vista de eventos: comience creando una figura de evento simple, por ejemplo, para centrarse en un
event frame simple y un elemento referenciado por el event frame. Agregue atributos del elemento que
puedan proporcionar mas contexto para los datos de evento a la figura de activos. El panel Coincidencias
realiza un seguimiento de los activos, atributos y marcos de evento que coinciden con la figura.

e Vista de transmision: comience creando una figura simple, por ejemplo, para encontrar un activo simple.
El panel Coincidencias es una vista previa de los elementos que se encuentran en la base de datos de Pl
AF que coinciden con la figura.

2. Obtenga una vista previa del conjunto de datos.

La vista previa muestra un subconjunto de la informacién. Se construye a partir de las primeras
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10 coincidencias y usa los primeros 100 registros para cada coincidencia. Por lo tanto, puede que no vea
todos los datos que espera. El objetivo de la vista previa es brindarle una idea de la apariencia de los datos,
de modo que pueda determinar los datos adicionales que incluira para proporcionar contexto o cémo excluir
registros y centrarse en los datos que le interesan.

3. (Vistas de transmisidon Unicamente) Especifique el esquema utilizado para enviar los mensajes y cdmo se
desencadena el mensaje.

4. Perfeccione el conjunto de datos.

Existe una gran flexibilidad en la manera en que se puede manipular el conjunto de datos finales para
generar los resultados deseados. Puede hacer lo siguiente:

¢ modificar la manera en que se muestran las columnas de datos/los campos de datos:
e agregar columnas de datos/campos de datos;

¢ agregar columnas de tiempo/campos de tiempo;

e agregar cdlculos en una columna o en un campo;

¢ filtrar los datos para incluir solo los datos que le interesan;

¢ especificar cdmo se recuperan los datos (valores resumidos, interpolados o exactos).

Nota: Las columnas se aplican a las vistas de activos o de eventos, y los campos se aplican a las vistas de
transmision.

5. Publique los datos en un destino de publicacion.
Los datos se pueden publicar una vez o seglin una agenda.

6. Vea los datos en la herramienta de Bl preferida.
Para obtener procedimientos mas detallados, comience con uno de los siguientes:

¢ Crear una view con activos
e Crear una view para eventos

e Crear una vista de transmision

Validacion del nombre de vista

La opcidn Validacién del nombre de vista permite a Pl Integrator crear, modificar e importar didlogos. Se
permiten todos los caracteres Unicode y de localizacidn internacional, pero no se permiten ciertos caracteres
especiales. Las vistas existentes que ya forman parte de la base de datos de Pl Integrator no deben verse
afectadas, a menos que el usuario intente modificar su nombre.

Si el usuario escribe un nombre de vista que no es valido, el cuadro de texto se resaltara en rojo y se mostrara un
mensaje de error que especifica que el nombre de la vista no es valido. Esta es la misma situacion para crear,
modificar e importar didlogos.

Los usuarios tienen la capacidad de anular el mapa de caracteres permitido predeterminado siguiendo estos
pasos:

1. Abra el archivo C:\Program Files\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config en un editor de
archivos.

2. Modifique el valor ViewnameAllowedSpecialCharacters para incluir los caracteres especiales.

Por ejemplo, si se utiliza'@','', o '!' en los nombres de vista, el valor seria "@!".
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Debido a la naturaleza de XML, ciertos caracteres reservados, como "&", necesitan una secuencia de escape.
Esto daria como resultado "&amp;", por ejemplo.

Reinicie los servicios del integrador.

4. Introduzca el nuevo Nombre de vista. Debe pasar la validacién debido a la modificacién de
ViewnameAllowedSpecialCharacters.

ForceCreateTable

La funcién ForceCreateTable permite forzar la creacién de determinadas tablas de publicacidn asociadas con
objetivos SQL (SQL, Azure SQL, Oracle, AWS Redshift, HANA). Fuerza la creacidn de una tabla de publicacién si
Pl Integrator no puede encontrar una tabla existente en un destino de publicacidn determinado. La funcién
ForceCreateTable afecta todas las vistas de publicacidon continua asociadas con objetivos SQL.

Se encuentra en C:\ProgramFiles\PIPC\Integrators\BA\CAST.Ul.WindowsService.exe.config.

Para editar la funcién ForceCreateTable, escriba lo siguiente:
<add key="ForceCreateTable" value="false" />

Nota: El valor predeterminado esta establecido en falso. Si el usuario establece la funcién ForceCreateTable en
verdadero, Pl Integrator creara una nueva tabla de publicacion si no se encuentra la tabla original
correspondiente a esa vista.

Crear una view con activos

Si desea analizar los datos desglosados por activos, cree una vista con activos. Si desea analizar los datos por
marcos de evento, consulte Crear una view para eventos. Si desea analizar sus datos desglosados por activos y
necesita que los valores se transmitan para el andlisis en tiempo real o algln otro tipo de analisis, consulte Crear
una vista de transmisién.

Haga clic en el icono del menu E y en Crear View con Activos.

2. Ingrese un nombre para la vista.

Nota: Cumpla con las convenciones de nomenclatura del destino en el que se publicara esta vista. Para
obtener mas informacion, consulte Ver nombres y puntos finales de destino.

3. Sisu cuenta de usuario estd asignada a multiples identidades de Pl AF con acceso a
Pl Integrator for Business Analytics, haga clic en el menu desplegable Propietario de la vista y seleccione la
identidad a la que desea dar acceso a la vista.

Si su cuenta de usuario esta asignada solo a una identidad de Pl AF que tiene acceso a Pl Integrator for
Business Analytics, esta identidad se asignard automaticamente a la vista.

Cuando crea una vista por primera vez, solo puede otorgar acceso a una identidad de PI AF. Después, puede
otorgar acceso a identidades de Pl AF adicionales. Para obtener mas informacidn, consulte Asegurar las
views.

4. Haga clic en Crear vista.

En el panel Activos de origen, haga clic en Crear una nueva figura.

Consejo: Puede usar la figura de una vista existente si hace clic en Importar una forma desde otra vista.

6. Use los campos Servidor y Base de datos para buscar la base de datos y el servidor de Pl AF deseados.
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Nota: Si la configuracion de seguridad de suplantacion de la aplicacion estd activada, vera un botén que le
permite ver las identidades de acceso a datos utilizados para la vista.

Explore el arbol de Pl AF para encontrar el activo que desea analizar.
8. Arrastre el activo al panel Figura de activo.

Arrastrar un activo al panel Figura de activo

Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches
T Asset Shape

Server CASTINT-CL v

Database Datacenter Demo

0

@ Assets Qo a rop and place
4 () Data Centers @ Calot
A @ Americas
- 8 Atlanta
| » &3 Colot —
» [ Colo2

» D Colo3

» ) Chicago

Attributes | x |

0 Select All

& ColoNumber

& Zonel.Capacity

& Zonel.CapacityPercent
& Zonel.DCIE

& ZonelPUE

& ZonelPWR

eocecococo

& ZonelRollingCost

4

El activo se agregé al arbol de Forma de activo.

Cuando selecciona un activo, se abre el panel Atributos y se muestran los atributos del elemento
seleccionado.

9. Arrastre atributos para incluir en la figura.

Nota: Puede ordenar, agrupar y filtrar los atributos.

Agregar un atributo mediante la funcion Soltar y colocar de manera automatica
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Consejo: Si arrastra un objeto fuera del arbol de Figura de activo, se muestra un tooltip con el texto Soltar y
colocar de manera automatica. El elemento se agrega automaticamente al arbol en una ubicacién légica.
Este elemento mantiene la misma relacidn en el arbol de Figura de activo que la que tiene en el arbol de PI
AF. Si ninguna ubicacion tiene sentido, se rechaza la caida.

Nota: También puede ubicar el objeto en el arbol de Figura de activo. Se muestra un tooltip que lo guia para
agregar el activo como una entidad primaria, una entidad secundaria o un elemento relacionado. Esto no le
impedird que suelte un objeto en una ubicacién que no coincida con la jerarquia de Pl AF.

Ubicar un elemento en el arbol de Figura de activo
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Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b Lisind Canacik P s b@t:ool
[ Assets ;x » & coor
4 [ Data Centers ;% »© coor
A 8 Americas ; x . @ ot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
» (D New York

3 @ San Leandro

10. Arrastre cualquier activo y atributo adicionales al panel Figura de activo.
En el panel Coincidencias se muestran los elementos que coinciden con la figura definida.

11. Para ver los datos de todos los activos que comparten la misma plantilla de Pl AF:

C

a. Hagaclic en elicono # allado del activo para abrir el cuadro de didlogo Editar filtros.
b. Borre la casilla de verificacidn Nombre de Activo.

c. Seleccione la casilla de verificacion Template de Activos y haga clic en Guardar.

En el panel Coincidencias se muestran datos de todos los activos que comparten esta plantilla.
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@ Source Assets T Search Shape ' Matches
. CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo (s 4 4 @ ColoTemplate 4 % > @coor
& Zonel.Capacity a » @ Colot
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 @ Americas & ZonelRollingCost " % > @ Colot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» & Colo2 » @ Colo2
» [ Colo3 » @ Colo2
4 [ chicago » @ Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» @ Colo3 » @ Coloz
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Para encontrar coincidencias para activos similares que tienen un conjunto diferente de atributos:

. . ' . . .
a. Hagaclicenelicono * allado del atributo que no es obligatorio.

b. En el cuadro de didlogo Editar Filtros, seleccione la casilla de verificacidon Atributo Opcional; luego, haga
clic en Guardar.

Por ejemplo, podria usar la opcién Atributo Opcional si adquirié equipamiento en un periodo determinado y
algunos atributos difieren entre el equipamiento mas nuevo y el mas antiguo.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Haga clic en Siguiente para obtener una vista previa de un subconjunto de los datos.
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Se muestran los primeros 100 registros de las primeras 10 coincidencias de la base de datos PI AF.

14. Para refinar los resultados, puede agregar mas datos, modificar columnas, filtrar datos o cambiar cémo se
recuperan los valores.

Para obtener mas informacion, consulte Modificar los datos de sus vistas de activos y de eventos.

Nota: Debido a que Pl Integrator for Business Analytics solo muestra las primeras 100 filas de las primeras
10 coincidencias de su figura, podria configurar los filtros, de manera que excluyan estos datos. En esta
situaciéon, no aparecerd ninguln dato en la pagina, aunque la vista configurada arroje coincidencias.

15. Haga clic en Siguiente.

e Asset View 1

Select Data > Modify View » Publish

Target Configuration Summary

S50L Server ¥ Shape and Matches

= There are 16 Matching Instances
® Run Once

Timeframe and Interval
Run on a Schedule

= our Start Time is *-8h

= Your End Time is *

= “Your Time Interval gets an interpolated
measurement Every 1 minute

16. Enla lista Configuracion de objetivo, seleccione un objetivo.

17. Haga clic en Ejecutar una vez para crear la vista una vez; o bien, en Ejecutar seglin una agenda para adjuntar
periddicamente datos nuevos a la vista.

Nota: Para obtener mas informacién sobre la publicacién de vistas, consulte Publicar una vista en un
programa.

18. Haga clic en Publish.

Desplazamiento de columna

1. Haga clic en la columna para abrir el panel Detalles de columna.
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® Column Details

Name

Flow Rate
N

Data Content

Value

Column Offset

Data Type
Single

Remove Column

Apply Changes

2. En el campo Desplazamiento de columna, desplace las columnas hacia arriba o hacia abajo en relacién con
las demas columnas utilizando los signos +y -. En funcién de la direccién, la primera o la tltima cantidad de
filas de la columna generaran un valor nulo.

3. Cuando haya finalizado, haga clic en Aplicar Cambios.

Crear una view para eventos

Si desea analizar los datos por marcos de evento, cree una view para eventos. Si desea analizar los datos
desglosados por activos, consulte Crear una view con activos. Si desea analizar sus datos desglosados por activos
y necesita que los valores se transmitan para el analisis en tiempo real o algun otro tipo de andlisis, consulte
Crear una vista de transmisién.

Nota: Pl Integrator for Business Analytics solo arroja event frames cerrados (con una hora de inicio y una hora de
finalizacién validas). No puede publicar datos de event frame abierto.

1. Haga clic en el icono del menu E y en Crear vista para eventos.

2. Ingrese un nombre para la vista.

Nota: Cumpla con las convenciones de nomenclatura del destino en el que se publicara esta vista. Para
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obtener mas informacion, consulte Ver nombres y puntos finales de destino.

3. Sisu cuenta de usuario recibe acceso a multiples identidades de Pl AF Pl Integrator for Business Analytics,
haga clic en Permisos de acceso y seleccione la identidad a la que desea dar acceso de vista.

Si su cuenta de usuario estd asignada solo a una identidad de Pl AF que tiene acceso a PI Integrator for
Business Analytics, esta identidad se asignard automaticamente a la vista.

Cuando crea una vista por primera vez, solo puede otorgar acceso a una identidad de Pl AF. Después, puede
otorgar acceso a identidades de PI AF adicionales. Para obtener mas informacion, consulte Asegurar las
views.

4. Haga clic en Crear vista.

En el panel Eventos de origen, haga clic en Crear una nueva forma.

Sugerencia: Puede usar la figura de una vista existente al hacer clic en Importar una forma desde otra vista.

6. Utilice los campos Servidor y Base de datos para seleccionar el servidor y la base de datos de Pl AF donde se
almacenan los event frames.

Nota: Si la configuracién de seguridad de suplantacidn de la aplicacion esta activada, vera un botén que le
permitird al usuario ver las identidades de acceso a datos utilizados para la vista.

7. Desde el panel Event Frames, arrastre el event frame y el elemento de referencia al panel Figura de evento.

Nota: Haga clic en el icono Y en el panel Eventos de Origen y configure los filtros para mostrar
Unicamente los marcos de evento que son de interés. Por ejemplo, puede filtrar por hora, activos, eventos y
plantillas de activos o eventos. En el panel Mas opciones, si selecciona Todos los descendientes, se busca
toda la jerarquia de PI AF. Si no lo selecciona, se realiza una buisqueda en los marcos de evento a nivel de la
raiz solamente.

Consejo: Para obtener consejos sobre la creacidén de figuras de evento, consulte Consejos para construir
figuras en views para eventos.

. . Q . o .
8. Hagaclicenelicono al lado del elemento para abrir la pestafia Activos e ir directamente a su
ubicacién en la jerarquia de PI AF.

9. Arrastre los activos y atributos del arbol de PI AF al arbol Figura de evento.

Para obtener consejos sobre la creacion de figuras de activo, consulte Consejos para construir figuras en
views para eventos.

10. Pararecuperar los datos de todos los event frames que comparten la misma plantilla de Pl AF:

-

a. Hagaclic en el icono s junto al event frame en el arbol de Figura de evento.

b. Borre la casilla de verificacidn Nombre de marco de evento.

c. Seleccione la casilla de verificacion Plantilla de marco de evento y haga clic en Guardar.
11. Haga clic en Siguiente para obtener una vista previa de un subconjunto de los datos.

La hora de inicio que se muestra es la hora del primer event frame que se agregé a la figura.

Pl Integrator for Business Analytics recupera solo los event frames cerrados.

12. Para refinar los resultados, puede agregar mas datos, modificar columnas, filtrar datos o cambiar cémo se
recuperan los valores. Para obtener mas informacion, consulte Modificar los datos de sus vistas de activos y
de eventos.

Nota: Debido a que Pl Integrator for Business Analytics solo muestra las primeras 100 filas de las primeras 10
coincidencias de su figura, podria configurar los filtros de manera que excluyan estos datos. En esta
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situacidn, no aparecera ningun dato en la pagina, aunque la vista configurada arroje coincidencias validas.

13. Haga clic en Siguiente para publicar los datos.

14. Enla lista Configuracion de Destino, seleccione un destino.

15. Haga clic en Ejecutar una vez para crear la vista una vez; o bien en Ejecutar segin una agenda para adjuntar
periddicamente datos nuevos a la vista.

16. Haga clic en Publicar.

Consejos para construir figuras en views para eventos

Usted selecciona los marcos de evento que desea incluir en su view para eventos en la pagina Seleccionar Datos.

La pagina Seleccionar Datos

Select Data > Modify View > Publish

"H Source Events

Server O’I DFPIAF v

Database

OSIPharmaCIP - v

l h ‘ Enter Event name or string match patterm @.\

) EPSHUTDOWN

Event Frames Assets

) EPRINSE

| -

) EPWASH
» ) CIP_422_SKID
» ) CIP_432_SKID
» [ Environmental

1 oo temnlate

- —m B
Attributes | Fitter @ * |
O Select All

v " Search Shape

4 CIP Flow Rate (to User)
4 CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low

# CIP Flow Rate (to User) Parameter

e ¢ ¢ 0 @

4 CIP Supply Pressure

- =

(4)
FH Event Shape @

4 ¥ CIP_SKID_EPRINSE:-1 &
4 FIEPRINSE % &
4 CIP Flow Rate (to User) &

4 CIP Flow Rate (to User) High s

& CIP Flow Rate (to User) Low 4

4 " CONNECTING 4

4 CIP_124_SKID @ l‘

& ACID SUPPLY FLOW Vg
4 ACID SUPPLY TANK LEVEL CON... &
& CIP Acid Tank Level s

& CIP caustic Tank Level V4

X %X X X X X X X M x X

+ Matches

&)

Found 62 Matches

»

»

v

v

v

v

v

v

v

v

hd

v

v

v

v

v

v

v

v

v

"4 CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
¥4 CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
"H CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1
" CIP_SKID_EPRINSE:1-1

¥ CIP_SKID_EPRINSE:1-1

En la siguiente tabla se describen las diferentes partes de esta pagina y como la usa para crear su figura de view

para eventos.

Numero Descripcion

1 Especifique el servidor y la base de datos donde se
encuentra la base de datos de PI AF.

2 Haga clic en la pestafia Marcos de Evento para
visualizar los marcos de evento. Haga clicen la
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Nimero

Descripcion

pestafia Activos para visualizar los elementos.

Para filtrar la lista de event frames, ingrese una
cadena de busqueda para el nombre del event frame.

Panel Buscar figura donde especifica el patrén de
busqueda para su vista para eventos.

El panel Figura de evento donde agrega los event
frames y sus atributos, y los elementos de referencia y
sus atributos.

El panel Atributos muestra los atributos que puede
agregar al panel Figura de evento.

Sugerencia: Haga clic en ° al lado del atributo
para abrir una ventana con datos sobre el atributo.

Vincule un elemento de referencia a su propia figura
de busqueda independiente. Haga esto solo si quiere
incluir elementos primarios y atributos para los
elementos vinculados.

El panel Coincidencias es una vista previa de los
activos y los marcos de evento definidos en la
busqueda de figura para los que se encuentran
coincidencias en la base de datos de Pl AF.

Cuando trabaje con la figura de evento:

¢ Puede agregar la cantidad de event frames que quiera, pero puede haber un solo event frame en cada nivel
en la jerarquia de event frames, como se muestra a continuacién. Por ejemplo, el nodo de figura de evento
puede tener un solo event frame secundario. Arrastre el event frame desde el panel Event Frames hasta el

panel Figura de evento.

Figura de evento: un nodo de figura de evento con un event frame secundario
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M4 Search Shape

¥ Event Shape

4 d CIP_SKID_EPRINSE:1-1 &S %
£ EPRINSE % & X

4 4 CONNECTING &S x
£ CIP_124_SKID % & x

¢ Cada event frame puede tener un solo elemento de referencia. Arrastre el elemento de referencia desde el
panel Event Frames hasta la figura de evento.

¢ Haga clic en el event frame en el panel Event Frames para mostrar sus atributos en el panel Atributos.
Arrastre cualquiera de sus atributos en la figura de evento.

¢ En el panel Eventos de origen, haga clic en la pestafia Event Frames, y haga clic en la lupa al lado del
elemento para cambiar al panel Activos y ver la ubicacidn del elemento en la jerarquia de PI AF.

Ubique un elemento en la jerarquia de Pl AF
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H4 Source Events v
<EUE DFPIAF v
el 0SIPharmaCIP o v

Y | Enter Event name or string match pattemn

Event Frames Assets

» "8 CIP_SKID_EFPRINSE:1-1
4 "4 CIP_SKID_EPRINSE:1-1

» " CONNECTING

» " DOWNLOADING

» "H STARTING

» " RUNNING

» "H UPLOADING

» "8 COMPLETE

FD EPRINSE Q
» D CIP_124_SKID Q

» "4 CIP_SKID_EPRINSE:1-1

» PH CIP_SKID_EPRINSE:1-1

¢ En el panel Atributos se ven los atributos del elemento seleccionado. Arrastre cualquiera de sus atributos en
la figura de evento.

¢ Los event frames y los elementos solo se pueden soltar en el arbol de Figura de evento usando Soltar y
ubicar automaticamente si esto tiene sentido légico. Si arrastra un elemento a un area vacia debajo de la
figura de evento, se mostrard un consejo de herramienta con el texto Soltar y ubicar automaticamente. Pl
Integrator for Business Analytics toma la relacion del objeto con otros objetos de la jerarquia de Pl AF e
intenta hacer coincidir esta relacion en la forma. La opcién Soltar y ubicar automaticamente solo puede
agregar el objeto arrastrado a la figura cuando el objeto es un elemento primario o secundario inmediato de
un objeto que ya aparece en su figura.

Soltar y colocar objetos de manera automatica
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M Search Shape
" Event Shape
4 by &S x
£0) EPRINSE G & x
FH CONNECTING & x
O,

Auto drop and place
&0 CIP_124_SKID

Consejo: Si utiliza Pl Integrator for Business Analytics por primera vez, comience con el uso de Soltar y
colocar de manera automatica.

¢ A medida que arrastra un event frame, elemento o atributo en alguna parte del drbol de Figura de evento,
un consejo de herramienta lo guia para soltar el objeto como elemento primario, elemento relacionado o
elemento secundario.

Nota: Esto no le impedira que suelte un objeto en una ubicacidn que no coincida con la jerarquia de PI AF.

CAmo arrastrar y soltar objetos en un arbol de figuras
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M4 Search Shape

" Event Shape

4 P CIP_SKID_EPRINSE:1-1 & %
£7) EPRINSE % &S x
4 " CONNECTING F x
Eﬁ&l; 124 SKID | %l x

Drop as child

# ACID SUPPLY FLOW

Cuando y como usar activos vinculados

En la mayoria de los casos, creara su figura en el panel Figura de evento y agregara el event frame, el event frame
secundario y los elementos de referencia, junto con sus atributos, como se ve en la siguiente captura de pantalla.
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M4 Search Shape

*H Event Shape

4 "4 CIP_SKID_EPRINSE:1-1
4 [ EPRINSE %
& CIF Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 P CONNECTING
4 FACIP_124_SKID %
& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL

& CIP Acid Tank Level

B 0% % % % % % %R N R
X X X X X X X X xXx x X

& CIP Caustic Tank Level

En la figura de evento, solo puede agregar elementos debajo del elemento al que se hace referencia en el event
frame de mas arriba. En el ejemplo anterior, no se pueden agregar elementos primarios por encima del
elemento CIP_124 SKID de la jerarquia de PI AF. Si necesita atributos o elementos de un elemento primario o de
referencia, haga clic en el vinculo Activos vinculados para abrir el panel de figuras de Activos. (Vea la captura de
pantalla siguiente).

Vinculo de activos vinculados
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*H Search Shape

*H Event Shape

4 WY ClP_SKID_EPRINSE:1-1

OO

4 FEPRINSE
& CIP Flow Rate (to User)
& CIP Flow Rate (to User) High
& CIP Flow Rate (to User) Low
4 Y COMNECTING

4 FACIP_124_SKID

CFee

B 0% % % % % % % R R R
X X %X X X X X X X X X

& ACID SUPPLY FLOW
& ACID SUPPLY TANK LEVEL CONTROL
& CIP Acid Tank Level

& CIP Caustic Tank Level

Al hacer clic en el icono Activos vinculados, se abre un segundo panel llamado Figura de activo. El elemento
vinculado, sus atributos y todos los elementos y atributos derivados de este se transfieren al panel Figura de
activo. En este ejemplo, el elemento CIP_124 SKID se copia al panel Figura de activo junto con los cuatro
atributos. La siguiente captura de pantalla muestra esto.

Figura de activo agregada a la figura de busqueda
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M Search Shape
¥ Event Shape

4 " CIP_SKID_EPRINSE:1-1
4 [ EPRINSE %
& CIP Flow Rate (to User)
& CIF Flow Rate (to User) High
& CIP Flow Rate (to User) Low

4 Fd COMNECTING

B O% % % R R K
X X X X X XN X

£ CIP_124_SKID Q

T= Asset Shape

4 ACIP_124_SKID G
4 ACID SUPPLY FLOW
4 ACID SUPPLY TAMK LEVEL CONTROL

& CIP Acid Tank Level

B % % % N
X X X X 2

4 CIP Caustic Tank Level

En el panel Figura de activo, puede agregar cualquier elemento y sus atributos, independientemente de su
ubicacion en la jerarquia de Pl AF. En este ejemplo, los elementos L1 HUMAB, NorthStreetPllant y Philadelphia se
agregan a la figura de activo.

Elementos agregados a la figura de activo
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Select Data > Modify View > Publish

"4 Source Events w " Search Shape
Server DFPIAF . "8 Event Shape
Database OSIPharmaCIP . 4 "4 CIP_SKID_EPRINSE:1-1 S %
4 FJEPRINSE % & X
I h & | Enter Event name or string match pattern & CIP Flow Rate (to User) & x
Event Frames Assets & CIP Flow Rate (to User) High a4
4 [ Data Centers & CIP Flow Rate (to User) Low S x
» € Americas 4 i CONNECTING S x
4 () PharmaCO KD CIP_124_SKID Y #x
4 ) North America
4 () Philadelphia
4 [ NorthstreetPllant
4 @ L1 HuMAB
&) CIP_000_SKID
» @ CIP_123_SKID
» @ CIP_124_SKID ‘ T Asset Shape
» ) CIP_422_SKID 4 [ Philadelphia & x
» € CIP_432_SKID 4 @) NorthstreetPllant # x
» (D Environmental 4 @ L1 HuMAB S x
&) no template 4 QcCIP_124_SKID %G S X
» (D syringe & ACID SUPPLY FLOW & n
» D T.STA 4P ACID SUPPLY TANK LEVEL CONTROL #x
e & CIP Acid Tank Level & x
» QT 4 CIP Caustic Tank Level & n
» @T112

Si hace clic en el vinculo de Activo vinculado de la figura de activo, desaparece el panel Figura de activo, y el
activo vinculado y todos sus atributos vuelven al panel Figura de evento.

Nota: El Unico motivo por el que se debe separar un elemento en el panel Figura de activo es para incluir
elementos y atributos que figuran por encima de este en la jerarquia de Pl AF. Segun la complejidad de la figura,
esto puede aumentar el tiempo que tarda en publicarse la vista.

Crear una vista de transmision

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved.

Nota: Esta funcidn esta disponible en la edicién avanzada Pl Integrator for Business Analytics.

La siguiente es una descripcién general de los pasos principales que debe seguir para crear una vista de
transmision. Haga clic en los enlaces para ir al procedimiento especifico.

1. Definir la figura de la vista de transmision.

2. Elija el esquema que utilizard con su vista, con una de las siguientes opciones:
e Utilizar un esquema importado de un archivo
e Utilizar un esquema importado de un registro de esquemas
e Utilizar un esquema generado

Para obtener mas informacidn sobre los esquemas, consulte Acerca de los esquemas.
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3. Configurar cudndo se enviaran los mensajes.

Para obtener mas informacion sobre los desencadenantes de mensajes, consulte Acerca de los activadores
de mensajes.

4. (Opcional) Rellenar datos.

(Opcional) Filtrar los datos.

Guardar un esquema en el registro de esquemas

Cualquier esquema importado desde un archivo o cualquier esquema generado se puede guardar en el registro
de esquemas. Todos los esquemas, independientemente de su origen, se guardan como esquemas Avro. Una vez
gue se guarda este, el esquema del panel Disenador de mensajes estara sujeto a las reglas impuestas por el
registro de esquemas. Por lo tanto, debe realizar los cambios necesarios antes de guardar el esquema en el
registro.

Nota: Siempre puede eliminar la conexién de su esquema en el panel Disefiador de mensajes del registro de
esquemas al hacer clic en Dejar de usar registro.

En esta versién, los esquemas solo se pueden guardar en un registro de esquemas. No se pueden guardar en un
archivo.

1. Enla pagina Modificar vista, haga clic en Guardar esquema en registro.

Nota: Opciones de esquemas debe seleccionarse para que aparezca este botdn.

Antes de guardar el esquema en el registro, puede editar y eliminar las propiedades del esquema. También
es posible reordenar las propiedades en caso de que el esquema no esté sincronizado con la figura del
activo, es decir, si se encuentra configurado como Formato libre. Arrastre y suelte las propiedades para
cambiar el orden.
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Message Designer

Schema Options Message Trigger Backfill Data Message Filters
Free-form mode Trigger a new measage when 1 key Do not backhll data 0 filters
values change

‘You are not syncing (free-form) your schema to the asset shape.

Import Schema Select Schema Structure
| Select Import Source - | | Fres-form - | Save Schema to Registry
“Timestamp": |@ TimeStamp ",

“Zonel.Capacity":

# Zonel.Capacity (Value) ¥ | s

"

“Zonel.CapacityPercent”:

 Zonel CapacityPercent (Value) v |",

%% % % %
X X X X X X

“Zonel.PWR": "|4 Zonel.PWR (Value) v,
“Zonel.RollingCost™: "|4 Zonel.RollingCost (Value) v,
“ColoTemplate™: "|@ Colo1 (Name) v

2. Enlaventana Guardar esquema en registro, especifique la ubicacion del registro de esquemas en el campo
URL del registro de esquemas.

Sugerencia: Comience a escribir en el campo y aparecerd una lista de registros de esquema disponibles.

3. Introduzca un nombre para su esquema en el campo Sujeto del esquema y haga clic en Guardar.

Aln podra editar algunas de las propiedades de las propiedades del esquema. Sin embargo, ya no podra
reordenar ni eliminar las propiedades del esquema.
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You are using the schema "ZoneSchema” from the schema registry at http:/10.4.200.128:8081.

Import Schema Select Schema Structure

{
"Timestamp”: "|(®) TimeStamp v, P
“Zonel.Capacity™: "|4 Zonel.Capacity (Value) v, SR
"Zonel.CapacityPercent™: "|JZnne‘1.CapacityF'er-:ent (Valug) v |", &S x
“Zonel.PWR": "|4 Zonel.PWR (Value) v |, S x
“Zonel.RollingCost": "|4p Zonel RollingCost (Value) v, PR
“ColoTemplate”: "|@ Colo1 (Name) v S x

¥

Nota: Puede hacer clic en Dejar de usar registro para eliminar la conexidn de este esquema al registro de
esquemas. Una vez que haga esto, puede volver para realizar los cambios que desee antes de guardar el
esquema.

Acerca de los activadores de mensajes

El activador de mensajes determina la frecuencia y las condiciones en las que se envia un mensaje al destino de
publicacion. Existen dos tipos de activadores: uno basado en un intervalo de tiempo y el otro basado en los
cambios que se realizan en los valores clave. Todos los valores clave deben ser atributos de Pl Point. Estas
opciones se muestran en la siguiente captura de pantalla.

9 Trigger a message in regular time inter'.'als,:| 1 b || minutess” |

#) Trigger a new message when the key value(s) selected below have changed

@ #) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data (@ Snapshot Data

¢ 1. Activador de mensajes basado en el tiempo

e 2. Activador de mensajes basado en un cambio que se realiza en los valores de los datos

En las siguientes secciones, se describe como usar estas opciones.
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Active un mensaje en intervalos de tiempo regulares.

Puede configurar el intervalo de tiempo entre 30 segundos y 12 meses como maximo. Se envia un mensaje en el
intervalo de tiempo especificado, independientemente de si hay cambios en los datos. Las vistas con este tipo de
activador de mensajes se denominan vistas de flujo programado.

Nota: Segun el tamafio y el almacenamiento en bufer del mensaje, puede haber una demora cuando los datos se
reciban en el destino. La latencia de extremo a extremo, el intervalo entre el momento en que un valor llega al Pl
System y el momento en que llega al sistema de destino, puede ser mayor que el intervalo entre los activadores
de mensajes.

Identifique las claves que activan el mensaje

Puede decidir qué cambios clave activaran un mensaje. Las vistas con este tipo de activador de mensajes se
denominan vistas de flujo activado por valor clave. En la siguiente captura de pantalla, se seleccionan dos claves
gue corresponden a Pl tags, Zonel.PWR y Zonel.RollingCost.

Trigger a message in regular time intervals:
#) Trigger a new message when the key value(s) selected below have changed
#) Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed

Trigger on Archive Data ® Snapshot Data

Q, Message Content

I
L

"Timestamp”: "|(¥ TimeStamp v\, SR
"Zonel.Capacity™: |4 Zonel.Capacity (Value) |, S X
"Zonel.CapacityPercent”: "|4 Zonel.CapacityPercent (Value) v |", -
< "Zonel.PWR": |4 Zonel PWR (Value) v, S X
¥ "Zonel.RollingCost": |4 Zone1 RolingCost (Valug) L P
"ColoTemplate™: "|Colol (Name) v | a4

Una vez que identifique las claves, podra personalizar ain mds las condiciones en las que se activa un mensaje.
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Trigger a message in regular time in'ten-'als:l 1 w || minutes vl

® Trigger a new message when the key value(s) selected below have changed A _T_

#® Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed A \.,_/

Trigger on Archive Data (® Snapshot Data [er2] v

Q‘. Message Content

I
L

“Timestamp”: *|(®) TimeStamp v, /%
"Zonel.Capacity": “|4 Zonel.Capacity (Value) v |"‘1 &%
“Zonel.CapacityPercent”: "[4 Zonel.CapacityPercent (Value) v |", P

4| "Zonel.PWR": [ Zonel PWR (Value) v, %

# | "Zonel.RollingCost": "[4 ZonelRollingCost (Value) v, , %
"ColoTemplate™: | Colo1 (Name) v e

Estas opciones se describen a continuacidn.

Active un mensaje cuando cambie cualquier valor clave.

La primera opcidn es activar un mensaje cada vez que cambien los datos de cualquiera de las claves
seleccionadas.

Trigger @ message in reqular time inter'.'als:l 1 bl ” minuies |

® Trigger a new message when the key value(s) selected below have changed

# Trigger a message when any of the selected key values have changed

Trigger a message when all of the selected key values have changed
Trigger on Archive Data (® Snapshot Data

A continuacion, se muestra una representacién grafica de esta opcién. Muestra dos claves: Clave A y Clave B. Los
mensajes se activan cada vez que hay un cambio en cualquiera de las claves indicadas por los puntos. Los
mensajes se envian a tl, t2, t3, t4 y t5, como lo indican las marcas de verificacion.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 120



'AVEVA\TM Pl Integrator for Business Analytics

Como utilizar Pl Integrator for Business Analytics

t1 t2 t3 t4 t5

Key A q\, —T

Key B Q\

(-] v v vv Vv

Active un mensaje solo cuando cambien todos los valores clave.

La segunda opcidn es enviar un mensaje solo cuando hayan cambiado los valores de todas las claves.

Trigger a message in regular time intervals: | 1 b ” minutess |

# Trigger @ new message when the key value(s) selected below have changed

Trigger a message when any of the selected key values have changed

#) Trigger a meszsage when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

El siguiente gréfico ilustra esto. Se envian tres mensajes a t2, t4 y t7. Los puntos verdes indican qué valores
modificados se registran. El valor en t5 no se envia, como lo indica el punto vacio.
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Key A Q‘. l

Key B Q..

t1  t2 t3 t4 t5 t6 t7

1 v v v

Tipo de datos que activan el mensaje

Ademas de identificar los datos mas criticos en los que debe centrarse, también puede especificar si desea usar
valores de archivo histérico o de snapshot para activar el mensaje.

Trigger a message in regular time intervals: | 1 W ” minuiess |

® Trigger 2 new message when the key value(s) selected below have changed
Trigger a message when any of the selected key values have changed

# Trigger a message when all of the selected key values have changed

Trigger on Archive Data (® Snapshot Data

Configurar cuando se enviaran los mensajes

Lea el tema Acerca de los activadores de mensajes. Proporciona el contexto que necesita para configurar el
desencadenante de mensajes.

Debe generar el esquema antes de configurar el desencadenante de mensajes.

1. Enla pdgina Modificar vista, haga clic en Activador de mensajes.

Opcion Descripcion
A Desencadenar un mensaje en Los mensajes se envian en el
intervalos regulares de tiempo intervalo especificado,
independientemente de si hay
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Opcion Descripcion

cambios en el valor clave.

B Desencadenar un mensaje nuevo | Los mensajes se envian segun los
cuando los valores seleccionados | cambios en los valores
a continuacion se modifiquen seleccionados.

¢ Elija una de las siguientes opciones: Si selecciond A, continle con el paso 3.
¢ Siselecciond B, continde al paso 4.
2. (A solamente) Haga clic en las listas para especificar el intervalo de tiempo entre mensajes.
Puede especificar intervalos entre 30 segundos y 12 meses.

Intervalo de tiempo del mensaje

# Trigger a message in regular time intervals: | 1 w | minutesw

Trigger a new message when the key value(s 1 seconds
2 minutes
3 hours
4 days
3 months
s}
7
8
-

3. (B solamente) Realice los siguientes pasos:
a. Seleccione las claves cuyos valores permitiran enviar el mensaje.

b. Elija una de las opciones siguientes:

Opcién Descripcion
Desencadenar un mensaje cuando haya Solo un valor clave debe modificarse para enviar
cambiado cualquiera de los valores clave un mensaje.

seleccionados

Desencadenar un mensaje cuando hayan Todos los valores clave debe modificarse para
cambiado todos los valores claves seleccionados | enviar un mensaje.

c. Elija si el mensaje se desencadenara sin cambios en el valor de snapshot o el valor del archivo histérico
de las claves seleccionadas.

Para obtener mas informacidn sobre cdmo estas opciones influyen en los datos que se enviaran, consulte
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Acerca de los activadores de mensajes.

;Qué datos se envian al destino?

Después de configurar cuando se envia un mensaje, especifique qué tipo de datos se envian. Para cada
propiedad, puede seleccionar de una lista de opciones de valores.

Nota: En los escenarios basados en claves, el tipo de datos que desencadena el mensaje (archivo histérico o
snapshot) estd separado de los datos que realmente se envian al destino. Por ejemplo, puede especificar que un
cambio en los datos de snapshot de una clave desencadene el mensaje. Sin embargo, puede especificar que se
envie al destino el valor de archivo historico de la clave (no el valor de snapshot). En la siguiente captura de
pantalla, se selecciona el Valor de la propiedad Zonel.Capacity.

ng Message Content
{

"Timestamp™: "|( TimeStamp ",

v "Zonel.Capacity": "|" Zone1 Capacity (Valueg) L

. ) . Template P
Zonel.CapacityPerc Category lue) + |7,
Path

Description

Guid

i "Zonel.RollingCost™ Y L

i "Zonel.PWR": |4 Zon

Last Recorded Value
"ColoTemplate™: "|@ WE

]. Average

finimum

faximum

Range

Standard Deviation

Standard Deviation (Population)

Count

Percent Good

Snapshot

Time optoens
TimeStamp
Year -

En los siguientes escenarios se describen las condiciones en las que se activa un mensaje.

e Escenario 1: datos de intervalo
e Escenario 2: cualquier cambio clave de los datos de archivo histdrico activa un mensaje

e Escenario 3: cualquier cambio clave de los datos de snapshot activa un mensaje

En cada situacién, se pueden configurar las propiedades con una opcidn de valor diferente. Los escenarios
describen el efecto de configurar las propiedades con las opciones de Valor, Ultimo Valor Registrado y Snapshot.
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Escenario 1: datos de intervalo

Los datos de intervalo se envian en intervalos especificados. En el siguiente ejemplo, t1 y t4 marcan el comienzo
y el final del intervalo de tiempo. La marca de tiempo del mensaje es el tiempo en t4. Los datos que se envian
dependen de la opcién de valor seleccionada para la propiedad:

¢ Sise configura el Valor de snapshot de la propiedad, se envia el valor de snapshot en t3 con la marca de
tiempo de t4. (1)

e Si se configura el Ultimo valor registrado de la propiedad, se envia el tltimo valor registrado antes de la
marca de tiempo del mensaje. En este ejemplo, el valor de archivo histérico en t2 se envia con la marca de
tiempo del mensaje de t4. (2)

¢ Sise configura el Valor de la propiedad, se utilizan los valores de archivo histérico y de snapshot en el
intervalo de tiempo para calcular el valor interpolado en t4. (3)

time interval

tl t2 t3 t4

2/
O O

message time stampJ

Key

Valor de archivo historico

Valor de Snapshot

Valor interpolado

Escenario 2: cualquier cambio clave de los datos de archivo historico activa un mensaje

Cuando una valor de snapshot ingresa en t3, desencadena el valor de snapshot en t2 que se archivara (en t2). El
valor de archivo histérico en t2 desencadena el mensaje, y la marca de tiempo es t2. En la siguiente ilustracion,
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se muestra qué datos se envian al destino segun la opcién de valor seleccionada:

e Si se configuraron los datos del Ultimo valor registrado de A, se envia el valor de archivo histérico en t2 (1).

¢ Sise configuraron los datos de valor de A, se envia el valor interpolado en t2 (1).
De igual manera, los datos que se envian para la propiedad B dependen de cémo estén configurados:

 El Ultimo valor registrado es el primer valor en Pl Data Archive antes de la marca de tiempo del mensaje o en
ella (t2). En este ejemplo, si se configuré el Ultimo valor registrado de B, se envia el valor de archivo histérico

que es el primer valor anterior a t2 (2).
¢ Sise configuran los datos de valor de B, los datos se interpolan en t2 usando el valor de archivo histérico en
t1y el valor de snapshot en t3 (3).

message time stampj’

tl t2 t3

v Key A

Key B

Key

Valor de archivo historico

Valor de Snapshot

Valor interpolado

Escenario 3: cualquier cambio clave de los datos de snapshot activa un mensaje

Un cambio en el valor de snapshot de cualquiera de las claves activa un mensaje. En este ejemplo, el mensaje se
desencadena en la clave A. Los datos de snapshot de la clave A activan un mensaje en t3, y la marca de tiempo
del mensaje es t3. Se devuelve el valor de snapshot en t3 para la clave A (1).
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La clave B no se selecciona como clave activadora. Los valores de una segunda clave, la clave B, se determinan
por su configuracién:

e Si se configuré el Ultimo valor registrado de la clave B, se envia el valor de archivo histérico en t1 con la
marca de tiempo del mensaje de t3. (2)

¢ Sise configura el valor de snapshot de la clave B, se envia el valor de snapshot en t2 con la marca de tiempo
del mensaje de t3. (3)

¢ Sise configura el valor de la clave B, se envia el valor interpolado en t3 con la marca de tiempo de t3. (4)

message time stamp

—

t1 12 t3

v Key A

Key B

Key

Valor de archivo historico

Valor de Snapshot

Valor interpolado

Si selecciona la opcién Activar un mensaje cuando hayan cambiado todos los valores de la clave seleccionada,
debe hacer un cambio en todas las claves antes de activar un mensaje. Se devuelven los valores de snapshot de
todas las claves seleccionadas, y la marca de tiempo de la ultima clave en devolver un valor de snapshot es la
marca de tiempo del mensaje.

Vistas previas de datos de la vista de transmision

Las vistas previas de los datos siempre muestran los valores de archivo histérico. Por lo tanto, si el resultado de la
configuracion del activador de mensajes es que los datos de snapshot se envian al destino, estos datos de
snapshot no aparecen en la vista previa. Usted vera valores de archivo histérico.
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Datos desordenados

Las vistas de transmisidn activadas por la clave no activaran un mensaje en un evento que tenga una marca de
tiempo anterior a la marca de tiempo del Ultimo evento.

Rellenar datos

Cuando publique sus datos, los valores actuales de la figura se enviaran al destino. Puede obtener valores
anteriores al rellenar sus datos.

Nota: El rellenado de datos es compatible con las vistas de flujo programado y habilita las actualizaciones de
datos automaticas. No es compatible con las vistas de flujo activado por el valor clave.

1
2
3.
4

En la pagina Modificar vista, haga clic en Rellenado de datos.
Haga clic en Rellenar datos a partir de.
Haga clic en el icono de calendario en el cuadro de texto para abrir el calendario.

Desplacese por el calendario y haga clic en la fecha de inicio.

Definir la figura de la vista de transmision

Si desea analizar los datos desglosados por activos, consulte Crear una view con activos. Si desea analizar los
datos por marcos de evento, consulte Crear una view para eventos.

Haga clic en el icono del menu E y en Crear vista de transmision.

Ingrese un nombre para la vista.

Nota: Cumpla con las convenciones de nomenclatura del destino en el que se publicara esta vista. Para
obtener mas informacion, consulte Ver nombres y puntos finales de destino.

Si su cuenta de usuario se asigna a multiples identidades de Pl AF con acceso a Pl Integrator for Business
Analytics, haga clic en Permisos de acceso y seleccione la identidad que recibira acceso a la vista.

Si su cuenta de usuario estd asignada solo a una identidad de Pl AF que tiene acceso a PI Integrator for
Business Analytics, esta identidad se asignard automaticamente a la vista.

Cuando crea una vista por primera vez, solo puede otorgar acceso a una identidad de Pl AF. Después, puede
otorgar acceso a identidades de PI AF adicionales. Para obtener mas informacidn, consulte Asegurar las
views.

Haga clic en Crear vista.

En el panel Activos de origen, haga clic en Crear una nueva figura.

Sugerencia: Puede usar la figura de una vista existente al hacer clic en Importar una forma desde otra vista.

Use los campos Servidor y Base de datos para buscar la base de datos y el servidor de Pl AF deseados.

Nota: Si la suplantacién estd activada, habra un botdn que le permitira al usuario ver las identidades de
acceso a datos utilizadas para la vista.

Explore el arbol de Pl AF para encontrar el activo que desea analizar.

Arrastre el activo al panel Figura de activo.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 128



AV=VA"

Arrastrar un activo al panel Figura de activo

Select Data > Modify View

) Source Assets

> Publish

T Search Shape

Server CAST-INT-CL

T Asset Shape

Database Datacenter Demo

0

@ Assets
4 fa Data Centers
- f:') Americas

- @ Atlanta

Thuto @ rop and place

@ Calol

| » & colof

» ) Colo2
» ) Colo3

» ) Chicago

Attributes |

0 Select Al

& ColoNumber

& Zonel.Capacity

# Zonel.CapacityPercent
& ZonelDCIE

& ZonelPUE

& ZonelPWR

4 ZonelRollingCost

eoeocooecoC

4

El activo se agrega al arbol de Figura de activo.

Cuando selecciona un activo, se abre el panel Atributos y se muestran los atributos del elemento

seleccionado.

9. Arrastre atributos para incluir en la figura.

Pl Integrator for Business Analytics
Como utilizar Pl Integrator for Business Analytics

v Matches

Nota: Puede ordenar los atributos, agruparlos por categoria o filtrar los atributos que se van a mostrar para
encontrar los que usted desea con mayor facilidad.

Agregar un atributo mediante la funcion Soltar y colocar de manera automatica
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Select Data > Modify View > Publish

Ea Source Assets T Search Shape + Matches
Server CASTANT-CL - T_Asset Shape Found 5 Matches
Database Datacenter Demo ooy & Colot s X & colot
@ Colot
Assets
CD ) @ Colot
A fa Data Centers Q‘ t | @ colof
L utoc drop and place
4 America -
Ea § & Zonel.Capacity @ Colol
4 (@ Atlanta
| » @ Colot
» @ Colo2
» @ Colo3
» @ Chicago
P+ S
Attributes ‘
O Select All
4 ColoNumber

‘ & Zonel.Capacity

& ZonelCapacityPercent
& ZonelDCIE
& ZonelPUE
& ZonelPWR

eocoo

# ZonelRollingCost

-

Nota: Si arrastra un objeto fuera del arbol de Figura de activo, se muestra un consejo de herramienta con el
texto Soltar y colocar de manera automatica. El elemento se agrega automaticamente al arbol en una
ubicacidn légica. Este elemento mantiene la misma relacion en el arbol de Figura de activo que la que tiene
en el drbol de PI AF. Si ninguna ubicacidn tiene sentido, se rechaza la caida.

También puede ubicar el objeto en el arbol de Figura de activo. Se muestra un consejo de herramienta que lo
guia para agregar el activo como una entidad primaria, una entidad secundaria o un elemento relacionado.
Esto no le impedira que suelte un objeto en una ubicacién que no coincida con la jerarquia de Pl AF.

Ubicar un elemento en el arbol de Figura de activo

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 130



'AV EVA\TM Pl Integrator for Business Analytics

Como utilizar Pl Integrator for Business Analytics

Select Data » Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTANT-CL v ToAsset Shape Found 5 Matches
Database Datacenter Demo oo 4 anitz;—ga\ert 7 % @ coo
b Lisind Canacik P s b@t:ool
[ Assets ;x » & coor
4 [ Data Centers ;% »© coor
A 8 Americas ; x . @ ot
| 4 e Atlanta .
» @ Colot
» @ Colo2
» [ Colo3
» D Chicago
» Ef) Houston
» (D New York

3 @ San Leandro

10. Arrastre cualquier activo y atributo adicionales al panel Figura de activo.
En el panel Coincidencias se muestran los elementos que coinciden con la figura definida.

11. Para ver los datos de todos los activos que comparten la misma plantilla de Pl AF:

C

. . g . . . )

a. Hagaclicenelicono * allado del activo para abrir la ventana Editar filtros.
b. Borre la casilla de verificacion Nombre de Activo.

c. Seleccione la casilla de verificacion Template de Activos y haga clic en Guardar.

En el panel Coincidencias se muestran datos de todos los activos que comparten esta plantilla.
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@ Source Assets T Search Shape ' Matches
GarEr CASTINTCL . T Asset Shape Found 16 Matches
Database Datacenter Demo [ 4 4 @ ColoTemplate s x> Qcoot
& Zonel Capacity /x> ©cool
@ Assets
& Zonel.CapacityPercent PR . » @ Colot
4 @ Data Centers @ Zonel PUR * % @ Colof
4 © Americas & Zonel RollingCost % @ Cobot
4 [ Atlanta » @ Colo2
» ) Colot » @ Colo2
» [ Colo2 » @ Colo2
» &) Colo3 » & Colo2
4 [ Chicago » & Colo2
» ) Colol » @ Colo3
» ) Colo2 » @ Colo3
» [ Colo3 » @ Colo3
» B Houston » @ Colo3
» B New York » @ Colo2
» @ san Leandro » @ Colod

12. Para encontrar coincidencias para activos similares que tienen un conjunto diferente de atributos:

. . ' . . .
a. Hagaclicenelicono * allado del atributo que no es obligatorio.

b. En el cuadro de didlogo Editar Filtros, seleccione la casilla de verificacidon Atributo Opcional; luego, haga
clic en Guardar.

Por ejemplo, podria usar la opcién Atributo Opcional si adquirié equipamiento en un periodo determinado y
algunos atributos difieren entre el equipamiento mas nuevo y el mas antiguo.

Edit Filters

# Attribute Name

Zonel.RollingCost

Attribute Category

Cost v

(+) Add Filter

¥ Optional Attribute (i

13. Haga clic en Siguiente.
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Se muestra la pagina Modificar vista. Consulte Pagina Modificar vista para obtener una descripcién general
de las tareas que realizarad para modificar la vista.

14. Elija el esquema de sus datos al completar uno de los siguientes procedimientos:
e Utilizar un esquema generado
e Utilizar un esquema importado de un archivo

e Utilizar un esquema importado de un registro de esquemas

Nota: Para obtener mas informacidén acerca de las opciones de esquemas, consulte Acerca de los esquemas.

Resultados de grupos con grupos comodines

Existen situaciones en las que puede ser conveniente agrupar atributos o elementos de figura; por ejemplo;
existe un patrén del atributo de Nombre de varios atributos y usted desea generar una tabla con una columna
para cada tipo de atributo en la tabla de salida. En el siguiente ejemplo, existen tres atributos de Zonal:
Zonal.Capacity, Zonal.PWR (Power), y Zonal.RollingCost. Estos atributos (Capacity, PWR y RollingCost) también
se comparten con Zona2, Zona3 y Zona4. (Por ejemplo, los atributos de Zona2 son Zona2.Capacity, Zona2.PWR, y
Zona2.RollingCost). Desea comparar estos atributos por zonas. La siguiente captura de pantalla es una view
parcial de esta estructura de Pl AF.
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[ Source Assets

Server

Database

@ Assets

Pl Integrator for Business Analytics
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CAST-INT-CL

Datacenter Demo

0
-

4 [P Data Centers

4 [ Americas

4 [ Atlanta

» ) Colot

» ) Colo2
L —

Attributes

x
—
LT

0O select All

& ColoNumber

 Zonel.Capacity

 Zonel.CapacityPercent

4 Zonel.DCIE

 ZonelPUE

& ZonelPWR

4 ZonelRollingCost

 ZonelStatus

& Zone2 Capacity

4 Zone2 CapacityPercent

 Zone2 DCIE

4 Zone2 PUE

 Zone2 PWR

& Zone2 RollingCost

 Zone2 Status

 Zone3 Capacity

& Zone3 CapacityPercent
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Si usé un comodin simple, obtendra el siguiente resultado con 64 coincidencias. Mientras que algunas
combinaciones son ldgicas (por ejemplo, los atributos de Zona4 agrupados), hay otras combinaciones con una
mezcla de diferentes zonas, y este no es el resultado deseado.

Select Data > Modify View > Publish

e Source Assets T Search Shape + Matches
Server CASTANT-CL . T.Asset Shape Found 64 Matches
Database PR . 4 [ Atlanta 9 4@ atlanta
4 @ Colol * 9 4 @ Colol
@ Assets & Zone" Capacity " % # Zone4 Capacity
4 (@ Data Centers T : % & Zonea PWR
0 @) A & Zone*RollingCost a2 # Zone4 RollingCost
4 e Atlanta 4 @ Allanta
‘ » © Colot 4 @ colot
» @ colo2 4 Zone3 Capacity
> @ cos # ZonedPWR
> @ chicago 4 Zone4 RollingCost
» @ Houston i @ Aflanta
» 67 New York — - 4 @ Colo1
Attributes | ® ‘ # Zone2 Capacity
O Select Al # Zone4PWR
S P # Zone4RollingCost
4 Zonel.Capacity (i ] 4 @ atanta
4 Zonel CapacityPercent [ ] ‘ @ Colo!
¢ G Py # ZonelCapacity
& Zonel PUE e Rz
T P 4 Zone4RollingCost
A= R T
# ZonelRollingCost i ]

En esta instancia, desea generar un conjunto de datos con una columna para cada atributo, en lugar de

12 columnas (tres para cada una de las cuatro zonas). Puede agregar grupos comodines a los atributos en el
arbol Figura de Activo para obtener los resultados deseados. El siguiente procedimiento a modo de ejemplo

ilustra el concepto de un grupo comodin y cdmo se puede usar.

1. Cree una figura con el activo y un conjunto de los atributos que le interesan.
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Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches
Server CASTINT-CL . T Asset Shape Found 1 Match
= 4 Atlanta 7 % 4@ Atanta
Database Datacenter Demo Sov @ 5
4 @ colot S n 4 @ Colot
@ Assets X
& Zonel.Capacity s 4 Zonel.Capacity
4 Data Centers
8 & ZonelPWR a3 # Zonel PWR
- Americas i
e & Zone1RollingCost a3 & Zone!RollingCost
4 @ Atlanta
‘ » &) Colol
» ) Colo2
» @ colo3
» fa Chicago
> @ Houston
» @ New York

» fa San Leandro

Attributes | x

0O Select All

4P ColoNumber

4 Zonel.Capacity

& Zonel.CapacityPercent
4 ZonelDCIE

& Zonel.PUE

& ZonelPWR

4 Zonel RollingCost

LI - - T - I - -]

Ll

2. Hagaclicen s al lado del primer atributo (Zonel.Capacity).
3. En el cuadro de didlogo Editar Filtros, reemplace la cadena en la que agrupa los resultados con un asterisco.

En este ejemplo, reemplazaria Zona 1 con un asterisco (*).
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Edit Filters

Show Wildcard Groups &
# Attribute Name

* Capacity

Attribute Category

Capacity r

(#) Add Filter

Optional Attribute o

Esto genera las siguientes coincidencias. Una coincidencia agrupa los atributos de la misma zona (Zonal),
pero las tres coincidencias restantes agrupan atributos de zonas diferentes.

[

4. Haga clic en Guardar.

SelectData > Modify View > Publish
@ Source Assets T Search Shape ' Matches
Server pR—— B % Asset Shape Found 4 Matches
Database Datacenter Demo oo © B 7 % | 4 Onana
4 @ Colol £ % 4 @ colol
@ Assets & “Capacity S 4 Zone4 Capacity
4 (D Data Centers & 7one1PUR S # ZonelPWR
4 § Americas & Zone1RolingCost £ xR # ZonelRollingCost
4 @ Atlanta 4 @ Atlanta
| » ) Colot 4 @ Colot
» @ colo2 # Zone3.Capacity
» @ Colo3 # ZonelPWR
» 8 Chicago 4 Zone1RollingCost
» & Houston 4 D Atlanta
» () New York 4 @ Colot
» ) San Leandro & Zone2 Capacity
# Zone1PWR
# Zone1RollingCost
4 @ Atlanta
Attributes ‘ x| P
4 ZonelCapacity
0O select All # ZonelPWR
& ColoNumber [ = # Zone1RoliingCost
4 Zonel.Capacity ]
& Zonel.CapacityPercent e
& Zonel DCIE (5]
# Zone1 PUE L]
& Zonel PWR [:]
# Zonel RollingCost i ]
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5. Hagaclicen 4 allado del segundo atributo (Zonel.PWR).
6. En el cuadro de didlogo Editar Filtros, reemplace la misma cadena (Zonal) con un asterisco.

El cuadro de didlogo Editar Filtros muestra lo siguiente:

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name

‘ You've added a wildcard symbol (*) to multiple nodes in the

‘ 1PuR Shape Tree:
Attribute Category  *.Capacity
& PWR

| Power r

Group Together Keep Wildcards

# Add Filter
OptionaIAttrl'bthe 6 mnatching gro 0 on these Shape ltems are — different gcaras that dont

Don't show this message again

7. Haga clic en Agrupar.

En el cuadro de didlogo Editar Filtros, se reemplaza el asterisco con Grupo 1. El panel derecho muestra los
atributos incluidos en el Grupo 1 (Group1.Capacity y Group1.PWR).

Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage
‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR

| Group 1 x PWR

Attribute Category

‘ Power r

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

8. Haga clic en Guardar.

Se muestran ambos atributos de la figura de activo con el comodin Grupo 1.
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Select Data > Modify View > Publish
@ Source Assets T Search Shape + Matches
Server Jp—— v Tz Asset Shape Found 4 Matches
Database Datacenter Demo oo = LG S @ pne
4 @ Colol S x 4 @ colot
@ Assets & B copeciy £ % # Zonea Capacity
4 [ Data Centers & [Grotplil FWR S n # Zone4 PWR
4 Q@ Americas # ZonelRoliingCost % # Zone1RollingCost
4 [ Atlanta 4 @ Atlanta
‘ » @ Colol 4@ calol
» @ Colo2 # Zone3 Capacity
» @ Colo3 # Zone3PWR
» € Chicago # Zone1RollingCost
» (@ Houston 4 @ Atlanta
» 6D New York 4 @ Colol

> San Leand
& San Leandro # Zone2 Capacity

# Zone2 PWR

# Zone1 RollingCost

4 [‘B Atlanta
Attributes | x| 4 @ colol
# Zone1.Capacity
O Select Al # Zone1PUR
O L] # ZzonelRollingCost
4 Zonel Capacity [ ]
4 Zonel CapacityPercent [ )
& Zonel.DCIE ;]
& Zonel PUE [:]
& ZonelPWR ;]
o

& ZonelRollingCost

9. Hagaclicen s al lado del tercer atributo (Zonel.RollingCost).
10. Elimine la cadena compartida (Zonel).

11. Haga clic en Grupo 1 en el panel derecho y arrastrelo al campo Nombre de Atributo.

Edit Filters

Hide Wildcard Groups €

¥ Attribute Name GroupNgme Group Usage

IRallinaCost Group 1 \ & Group 1 .Capacity
% Group 1 i & Group 1 .PWR
Attribute Category
‘ Cost T
& Add Filter
Optional Attribute @ (® Create New Wildcard Group (=) Delete Wildcard Group
Insert Wildcard Group 1 at cursor position

En la siguiente captura de pantalla se muestran los tres atributos con el comodin Grupo 1.
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Edit Filters

Hide Wildcard Groups €
¥ Attribute Name Group Name Group Usage

‘ Group 1 & Group 1 .Capacity
& Group 1 .PWR
Attribute Category & Group 1 .RollingCost

| Group 1 x .RollingCost

‘ Cost v

® Add Filter

Optional Attribute @ (#) Create New Wildcard Group

Save

12. Haga clic en Guardar.

Select Data > Modify View > Publish

@ Source Assets T Search Shape + Matches

Server CASTINT-CL . T Asset Shape Found 4 Matches

4 @ Atlanta
4 @ cCalot

& |Group 1 .Capacity

» [ Atlanta
Database Datacenter Demo

4]
-

» @ Atlanta
@ Assets

» @ Atlanta
4 e Data Centers

& Group1 PWR » @ Atlanta

4 eAmericas
4 [ Atlanta
| » ) Colot
» @ Colo2
» ) Colo3
» B Chicago

r e Houston

L S W
XX X X X

4 Group 1 RollingCost

» 6D New York -

Attributes | ®

O select All

3

4 ColoNumber

4 Zone! .Capacity

4 Zonel.CapacityPercent
4 Zonel.DCIE

& ZonelPUE

& Zonel PWR

eoecocCeQOoQQOQ

4 ZonelRollingCost

4

Con el comodin del grupo, las cuatro coincidencias muestran los atributos de Zonal, Zona2, Zona3, y Zona4
agrupados.
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v Matches

Found 4 Matches
4 @ Atlanta
4 @ Colo
& Zoned Capacity
& Zoned PWR
& Zone4 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone3.Capacity
# Zone3a PWR
& Zone3 Rol ngCost
4 @ Atlanta
4 @ Colo
L 4 Zone2 Capacity
& Zone2 PWR
4 Zone2 RollingCost
4 @ Atlanta
4 [ colat
L 4 Zonel.Capacity
& ZonelPWR

& ZonelRollingCost

Pagina Modificar vista

En la pagina Modificar vista, puede especificar el esquema que utilizard para enviar mensajes y especificar
cuando se envian estos mensajes. Opcionalmente, puede excluir datos y rellenar datos de un periodo anterior.
En la siguiente captura de pantalla, se identifican los diferentes paneles y las diferentes funciones y
caracteristicas clave.
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T Shapes o’ Message Designer @,
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Preview

o Asset Shape | Schema Options ” Message Trigger ” Backfill Data

©)

Preview Start Time
” Message Filters |

4 @ colol S X L ‘
& ColoNu.. & x You@cing yoursch@he asset sha@)\aﬂattened 3@. Preview End Time
0 Zonel.. 4 % Import Schema Select Schema Structure ) ‘
® Zonel.. & x | Select Import Source v| | Sync to Asset Shape (Flattened) v| {
"Colol": "Colol",
€ Zonel.. & x “ColoNumber™: "1.664574",
Save Schema to Registry "Zonel.Capacity™: "162",
"Zonel.CapacityPercent™: 171.21975703007812,
"Zonel.DCiE": "38.5215",
{ @ "Times‘tamp": "2@18-19-29T81:51:56.8603267-87:0¢
"Colol": "[& Colo1 (Name) v, & ‘}["
“ColoNumber™: "[4 ColoNumber (Valug) v, & "Colol": "Colol”,
"ColoMumber”: "1
"Zonel.Capacity”: "|O Zone1.Capacity (Value) v |"J & "Zonel.Capacity”
"Zonel.CapacityPercent™: 172.82561950683594,
N "Zonel,.CapacityPercent”: "|0 Zone1.CapacityPercent (Value) v 4 "Zonel.DCiE™: "37.82698",
"Timestamp”: “2018-18-29T@1:52:56.8603267-87:0¢
“Zonel.DCiE": |4 ZonelDCIE (Value) v, Vi 1
"Timestamp”: "|® TimeStamp v 4 ¢ "Colol": "Colol”,
"ColoMumber™: "
3 "Zonel.Capacity™: "
"Zonel.CapacityPercent™: 173.21989440891797,
"Zonel.DCiE": "37.55756",
"Timestamp”: " a7:e¢
b
{
"Colol": "Colol",
"ColoMumber™: "1.67812",
© Add Prope Schema "Zonel.Capacity": "162",
"ZFanael FanaritwPercent”: 177 7A73IA?AAACAARRR

Numero Descripcion

1 Figura de activo: puede arrastrar y soltar elementos y
atributos de la figura en las propiedades del esquema,
en el panel Disefiador de mensajes.

2 Disefiador de mensajes: en este panel, puede
seleccionar el esquema, especificar el desencadenante
de mensajes, modificar las propiedades del esquemay
rellenar datos.

3 Vista previa: muestra los primeros 100 mensajes en el
formato de esquema que se muestra en el panel
Disefiador de mensajes.

4 Esquema: muestra el esquema utilizado para enviar
mensajes.

5 Opciones de esquemas: selecciona el esquema
utilizado para enviar mensajes. Puede usar un
esquema generado segun la figura de activo o
importar un esquema desde un archivo o un registro.
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Numero Descripcion

6 Modifique las propiedades del esquema, cambie el
orden de las propiedades del esquema o elimine las
propiedades del esquema. No todas las opciones
estan disponibles con todos los tipos de esquemas.

7 Desencadenante de mensajes: especifica la frecuencia
y las condiciones en las que se envia un mensaje al
destino de publicacién.

8 Rellenado de datos: especifica los valores anteriores
para enviar al destino de publicacion.

9 Filtros de mensajes: especifica los resultados de los
datos que excluira.

Para obtener informacién sobre cémo completar las tareas de la pagina Modificar vista, consulte lo siguiente:

e Utilizar un esquema importado de un archivo

e Utilizar un esquema importado de un registro de esquemas
e Utilizar un esquema generado

¢ Configurar cuando se enviaran los mensajes

e Rellenar datos

Acerca de los esquemas

Nota: Esta funcidn esta disponible en la edicién avanzada Pl Integrator for Business Analytics.

¢ De manera predeterminada, la figura de busqueda se utiliza para generar el esquema para los mensajes de
transmision. Puede utilizar este esquema que se ha generado, o bien importar un esquema al cual se asignan
los valores de datos de la figura.

Esquemas importados
Los esquemas se pueden importar desde un archivo o desde un registro de esquemas.

¢ Esquemas importados desde un archivo: se pueden importar desde un archivo los esquemas en los
siguientes formatos: JavaScript Object Notation (JSON), Valores delimitados por comas (CSV) y Apache Avro.
Una vez que se importaron, usted asigna valores a las propiedades y las edita.

¢ Esquemas importados desde un registro de esquemas: esta version es compatible con el Registro de
esquemas confluentes mediante el uso de esquemas Apache Avro.

¢ Los esquemas Avro importados del registro de esquemas imponen reglas estrictas. Una vez importados, el
nombre de la propiedad y el tipo de datos se definen con el nombre y tipo de campo de Avro,
respectivamente, y no pueden modificarse. Si alguna de las siguientes opciones es verdadera, la vista no se
publicara.

¢ No se asignd un valor a la propiedad.
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¢ La propiedad tiene una incompatibilidad de tipo, y el campo de Avro correspondiente no admite el tipo
nulo.

¢ Si existe una incompatibilidad de tipo y el campo de Avro admite el tipo nulo, la vista se publica, pero el
campo se omite.

Esquemas generados

Los esquemas generados se sincronizan con la figura de activo en una estructura anidada, aplanada o de formato
libre. Los nombres de la propiedad del esquema coinciden con los nombres del activo y del atributo de la figura.
El valor de la propiedad se completa con los valores de los datos del activo relacionado o del atributo de la
figura. En el modo aplanado, el esquema se muestra en una estructura no jerarquica. En el modo anidado, la
jerarquia del esquema se preserva. Los esquemas aplanados y anidados le permiten cambiar los nombres de la
propiedad, los valores relacionados con las propiedades y los tipos de datos. Puede tomar un esquema anidado
o aplanado y convertirlo en un esquema de formato libre. El esquema de formato libre le proporciona la mayor
flexibilidad al poder modificar el esquema. Ademas de poder hacer todo lo que puede hacer con un esquema
aplanado o anidado, también puede realizar cambios en las propiedades al agregar, eliminar y reordenar
propiedades.

Utilizar un esquema importado de un archivo

Lea Acerca de los esquemas para obtener informacion sobre las diferentes maneras de usar un esquema.

En el panel Disefiador de mensajes, haga clic en Opciones de esquemas.
2. Haga clic en Seleccionar esquema y elija Archivo.
En la ventana Abrir, seleccione el archivo de esquemas y haga clic en Abrir.

Se admiten los esquemas en los siguientes formatos: JSON, CSV y Apache Avro. El archivo debe tener la
extension .json, .csv o .avsc para mostrarse en el Disefiador de mensajes.

4. Asigne el valor a las propiedades del esquema usando uno de los siguientes métodos:
¢ Arrastre un activo o atributo de la figura de activo al esquema.

¢ Haga clic en el icono del lapiz para abrir la ventana Editar propiedad. Seleccione un activo o un atributo
de la figura y, luego, seleccione un valor de la lista Contenido de datos de la propiedad. Haga clic en
Actualizar propiedad.

Arrastre y suelte una propiedad del esquema para moverla a otra ubicacion.
Haga clic en la x para eliminar la propiedad del esquema.

Haga clic en Agregar propiedad al esquema en la esquina inferior izquierda para agregar una propiedad al

esquema.

a. Ingrese el nombre de la propiedad y haga clic en Confirmar.

b. Asigne un valor a la propiedad arrastrando un atributo de la figura de activo o haciendo clic en el icono
de s .

8. Continue con el siguiente procedimiento Configurar cudndo se enviaran los mensajes.
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Utilizar un esquema importado de un registro de esquemas

Lea Acerca de los esquemas para obtener informacion sobre las diferentes maneras de usar un esquema.

1
2
3.
4

5.

En el panel Disefiador de mensajes, haga clic en Opciones de esquemas.
Haga clic en Seleccionar esquema de importacion y elija Registro de esquemas.
Seleccione el esquema del Navegador del registro de esquemas y haga clic en Usar esquema seleccionado.
Asigne el valor a las propiedades del esquema usando uno de los siguientes métodos:
e Arrastre un activo o atributo de la figura de activo al esquema.

¢ Haga clic en el icono del lapiz para abrir la ventana Editar propiedad, seleccione un activo o un atributo
de la figura y, luego, elija un valor de la lista Contenido de datos de la propiedad. Haga clic en Actualizar
propiedad.

Antes de continuar y publicar su vista, debe proporcionar valores validos para todas las propiedades del
esquema. Los esquemas Avro importados del registro de esquemas imponen reglas estrictas. El nombre y el
tipo de datos no se pueden modificar. Si se presenta una falta de coincidencia en los tipos de datos entre el
esquema y el valor seleccionado, Pl Integrator for Business Analytics intentara realizar una conversién del
tipo de datos. Si no puede convertir el tipo de datos, apareceran valores nulos para esa propiedad. Consulte
el panel Vista previa para conocer los valores nulos. Debe corregir todos los valores escritos
incorrectamente. Si hay valores sin corregir, la vista no se publicard. La excepcién a esto es si el esquema
permite valores nulos; en esta instancia, las inconsistencias en los tipos de datos sin corregir no necesitan
corregirse, y usted podra publicar la vista.

Continte con el siguiente procedimiento Configurar cuando se enviaran los mensajes.

Utilizar un esquema generado

Lea Acerca de los esquemas para obtener informacion sobre las diferentes maneras de usar un esquema.

En el panel Disefiador de mensajes, haga clic en Opciones de esquemas.

De manera predeterminada, el esquema que aparece se sincroniza con la figura de activo y se muestra en
una estructura aplanada.

Haga clic en Seleccionar estructura del esquema y elija una de las opciones.
¢ Sincronizar con la figura del activo (aplanada): el esquema se muestra en una estructura no jerarquica.
¢ Sincronizar con la figura del activo (anidada): se preserva la jerarquia del esquema.

¢ Formato libre: este formato se aplica a cualquier jerarquia que se muestre (anidada o aplanada) en ese
momento.

El esquema muestra las propiedades con los valores de datos de los atributos y activos de la figura
asignados. Puede elegir un valor de propiedad diferente de una lista de todas las propiedades disponibles del
atributo o elemento de PI AF.

Para asignar un valor diferente a la propiedad del esquema, haga clic en la flecha y seleccione una propiedad
de la lista.

Para realizar otros cambios en la propiedad del esquema, haga clic en el icono de |apiz para abrir la ventana
Editar propiedad.

Nota: Puede, por ejemplo, realizar cambios en el nombre de la propiedad del esquema o el tipo de datos
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predeterminado de la propiedad.

5. (Solo para esquema de forma libre) Arrastre y suelte la propiedad del esquema para moverla a otra
ubicacion.

Sugerencias: Las propiedades del mismo nivel de la jerarquia no se pueden reorganizar. Una propiedad solo
puede moverse a una posicion secundaria de una propiedad primaria diferente.

Todas las propiedades secundarias de una propiedad primaria dada deben tener nombres Unicos. Si no se
cumple esta regla, no se podra soltar la propiedad.

(Esquema de formato libre solamente) Haga clic en la x para eliminar la propiedad del esquema.
7. (Esquema de formato libre solamente) Haga clic en Agregar propiedad al esquema en la esquina inferior
izquierda para agregar una propiedad al esquema.

8. Continue con el siguiente procedimiento Configurar cuando se enviaran los mensajes.

Utilizar filtros para mejorar la forma de vista

En la pagina Seleccionar datos, a menudo usted comienza agregando un solo activo o event frame a la forma de
busqueda. Luego, puede utilizar los filtros para extender esa forma a otros activos o event frames. Haga clic en el

2

icono de < para abrir el cuadro de didlogo Editar filtros. La siguiente captura de pantalla es el cuadro de
didlogo Editar filtros de la forma de vista con activos.

Nota: El ejemplo de esta seccion analiza los filtros de edicién para la forma de vista con activos. Los filtros del
event frame tienen condiciones con nombres similares y el comportamiento de los filtros es el mismo que el de
los filtros de vista con activos.

Cuadro de didlogo Editar filtros de la forma de vista con activos

Edit Filters

¢ Asset Mame @J

MS301:Anne Morth:T1

@ —_— ¥ Asset Template @J

M5 Transformer r

Asset Category @J

MS Transformer r

(¥ Add Filter
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La captura de pantalla identifica el filtro y las condiciones que lo comprenden.

Numero Descripcion

1 Ejemplo de un filtro de vista con activo
2 Condicion del nombre del activo

3 Condicién de la plantilla del activo

4 Condicidn de la categoria del activo

Puede realizar la busqueda en funcién de una o mas de estas condiciones. Todas las condiciones seleccionadas
deben cumplirse para calificar como coincidencia. Por ejemplo, en la captura de pantalla, el Nombre del activo y
la Plantilla del activo estdn seleccionados y ambas condiciones deben cumplirse para encontrar una
coincidencia. Solo los activos cuyo nombre es MS301:Anne North:T1 y tienen como base la plantilla MS
Transformer apareceran en el panel Coincidencias.

Para las vistas con eventos, las condiciones de filtros reciben el nombre de Nombre del evento, Plantilla del
evento y Categoria del evento. Sin embargo, el comportamiento de los filtros es el mismo que el de los filtros de
vista con activos.

Puede expandir su busqueda para incluir mas coincidencias posibles al agregar filtros. Haga clic en el signo mas
(+) para agregar otro conjunto de filtros.

Nota: Utilice la barra de desplazamiento para desplazarse hacia abajo y ver los filtros adicionales.

Cada filtro consta de un conjunto de condiciones, como Nombre del activo, Plantilla del activo, Categoria del
activo que funcionan como condiciones AND. Cada condicién seleccionada en el filtro debe coincidir para que un
activo califique como coincidencia.

Si existen dos filtros 0 mas, deben cumplirse las condiciones de cada filtro para que un activo califique como
coincidencia.

Volviendo al ejemplo, se agrega un segundo conjunto de filtros y la condicién de Nombre del activo se configura
en DrillBit*.

Segundo filtro en la vista con activos
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Edit Filters

¥ Asset Name -

DrillEit*

Asset Template

ElementTemplate r

Asset Category

(=) Remove Filter

(+) Add Filter

El servicio de Pl Integrator Framework busca el servidor de Pl AF:

¢ Con este primer filtro, se busca cualquier activo cuyo nombre sea MS301:Anne North:T1 y tenga como base
la plantilla MS Transformer.

e Con el segundo filtro, se busca el activo cuyo nombre comience con DrillBit.

La busqueda devuelve los activos que cumplen con cualquiera de estas condiciones. Por lo tanto, multiples filtros
funcionan como un filtro OR.

Modificar los datos de sus vistas de activos y de eventos

Nota: Puede realizar cambios a una vista publicada. Para obtener mds informacion sobre cémo modificar una
vista publicada, consulte Modificar una view.

Antes de publicar una vista, puede refinar los resultados de los datos, lo que incluye:

e Cambiar cdmo se recuperan los datos.

Puede ajustar el intervalo de muestra o puede elegir usar una columna clave para organizar los datos en la
vista. Consulte Opciones de recuperacion de datos para obtener informacion sobre las diferentes maneras de
recuperar datos y las opciones que generardn las representaciones de datos que usted desea. Para obtener
mas informacién sobre cémo especificar el método de recuperacion de datos en sus vistas, consulte Ajustar
como se recuperan los datos.

e Agregar columnas de datos que muestran informacidn sobre atributos.
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Para obtener mas informacion, consulte Agregar una columna de datos.

e Agregar una columna de hora que muestra los datos de la hora en un formato diferente.
Para obtener mas informacidn, consulte Agregar una columna de horas.

¢ Modificar una columna.
Para obtener mas informacion, consulte Modificar una columna.

¢ Filtrar los datos en una view.

Para obtener mas informacion, consulte Filtrar los datos.

Opciones de recuperacion de datos

Puede controlar cémo se recuperan los datos en su view al ajustar el intervalo de muestra u organizar los datos
segun un atributo, como una columna clave.

¢ Enuna view de activos, los datos se recuperan de una de las siguientes maneras:
¢ Valores espaciados uniformemente en tiempo (también denominados interpolados)
¢ Valores seglin un tiempo de atributo de referencia (también denominado comprimidos)

¢ Las marcas de tiempo se toman del atributo de referencia; seguiin la opcidn que elija, todas las demas se
interpolaran o recibiran un valor nulo si no hay valor para ese atributo en la marca de tiempo exacta.

¢ Enuna view para eventos, los datos se alinean por marcos de evento y el formato es de una de las siguientes
maneras:

¢ Un registro de resumen para cada evento Esto es ideal para los diagramas de Pareto.

¢ Un diagrama de Pareto muestra barras y una linea. Las barras representan los valores individuales. Las
barras mas largas estan a la izquierda. La linea representa el total acumulado.

5.40
5.40 100%
o1l Duration
» Cumulative Percent
370 68.4%
g
a
=
&
g
= =
S 199 368% 32
o E
a 3
u |
0.00 0%
Pump Failure Power Unavailable Corrosion Rods Parted  Wax Deposition
5.40 210 1.40 070 0.60

Downtime Cause
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¢ Espaciados uniformemente o basados en una columna clave en el tiempo dentro de los event frames.
Esto es util para analisis de lote ideal.

200

F

/ N \
. A

Temperature

5 10 15 Minutes 25 30 35 40

Duration

Ajustar como se recuperan los datos

1. Enla pagina My Views, seleccione la view que desea modificar y haga clic en Modificar View. Luego, haga
clic en Siguiente para abrir la pagina Modificar View.

Nota: Si ya estd en la pagina Modificar vista, avance al paso siguiente.

2. Haga clic en Editar modo de valor y elija cdmo desea que se informen sus datos:

¢ (Vistas de eventos solamente). La opcidn Valores resumidos arroja una fila por event frame en el marco
de evento general especificado para la vista de evento. Use esta opcidn para generar resultados que se
puedan mostrar en un diagrama de Pareto. La opcidn Valores resumidos solo aparece si esta
modificando una vista de eventos.

Valores Resumidos

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 150



'AV EVA\TM Pl Integrator for Business Analytics

Como utilizar Pl Integrator for Business Analytics

Edit Value Mode

2 Summarized Values

Sampled Values

Save Changes

Los valores resumidos son los valores del marco de evento que ve en Pl System Explorer. De manera
predeterminada, este es el valor de Pl point en el extremo del marco de evento.

™

Nota: El valor del marco de evento se configura en Pl System Explorer a nivel de atributo. El pardmetro
Por intervalo de tiempo en el cuadro de didlogo Referencia de datos de PI Point , que se muestra a
continuacidn, es donde se configura el método de recuperacion de valores.

Pl Point Data Reference "
Data server: css-hi_pisys W
'ZEZ' Tag name: |E=255_TEI'~"IF' | y
() Atiribute: v

Lnit of Measure

Source Units: <Mone > W

Value retrieval methods

By Time: Automatic W

Relative time:

By Time Range: End Time W
Calculation basis: Time Weighted
Min percent good: a0

Read only

Pl Integrator for Business Analytics no admite el método de recuperacién de valores Por tiempo
configurado en No compatible. Para obtener mas informacidn, consulte el articulo de la base de
conocimientos Los valores de cdlculo de resumen de Integrator Event Frames estdn en blanco.

¢ Valores de muestra cada cambia el intervalo de muestra de modo que el valor se interpole en el
intervalo de tiempo especificado, por ejemplo cada 15 minutos.

Valores de muestra cada
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Edit Value Mode X

Summarized Values

* Sampled Values

® Sample values every | 1= || minutes =
® |nterpolate @
Exact @

Use Key Column|cdi158

Save Changes

Haga clic en Valores de muestra cada y establezca el intervalo de tiempo:
¢ Interpolar siempre devuelve un valor en el intervalo de tiempo especificado e interpola valores,
segun sea necesario.
¢ Exacto devuelve valores, si existen, en el intervalo de tiempo especificado. Si no existen valores,
devuelve un valor nulo.
¢ Usar Columna Clave usa un atributo para organizar cdmo se interpolan los datos.

Usar Columna Clave

Edit Value Mode x

Summarized Values

® Sampled Values
Sample values every | 1+ || minutes =

* Use Key Column | cdt158 ~
* Interpolate @
Exact @

Save Changes

Elija el atributo y luego elija una de las siguientes opciones:

¢ Interpolar encuentra los valores de la columna clave y sus estampas de tiempo registradas. Los
valores de las otras columnas se interpolan con las mismas estampas de tiempo que las estampas de

tiempo de la columna clave.
¢ Exacto encuentra los valores de la columna clave y sus estampas de tiempo registradas. Si un valor
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no existe en estas estampas de tiempo registradas en el resto de las columnas, se devuelve un valor
nulo.

3. Haga clic en Guardar cambios.

Como se calculan los datos de resumen

En la pagina Modificar vista, puede agregar una columna con datos de resumen de cualquier columna numérica
de la vista. Los siguientes son ejemplos de los valores calculados que puede especificar:

¢ Total: el total de todos los valores en el intervalo.

¢ Promedio: el promedio de todos los valores en el intervalo.
¢ Minimo: el valor minimo en el intervalo.

e Maximo: el valor maximo en el intervalo.

¢ Rango: el valor maximo menos el valor minimo en el intervalo.
El intervalo se determina usando marcas de tiempo en la vista:

¢ La horade inicio es la marca de tiempo de la fila anterior.

¢ La hora de finalizacion es la marca de tiempo de la fila actual.

La captura de pantalla y la tabla a continuacidn ilustran la relacidn entre las marcas de tiempo y los valores
calculados. En este ejemplo, se agregaron dos columnas: Volumen 1: minimo y Volumen 1: promedio. Ambos
tienen como base la columna Volumen 1. La fila actual es la fila cuya marca de tiempo marca el final del intervalo
de tiempo. La marca de tiempo de la fila anterior marca el comienzo del intervalo de tiempo. Volumen 1:
minimo toma todos los valores de datos entre esas dos horas, encuentra el valor minimo y completa la columna
Volumen 1: minimo de la fila actual (es decir, la fila de |la hora de finalizacién). De igual manera, calcula el valor
de la columna Volumen 1: promedio al promediar los valores de la columna Volumen 1 entre la hora de inicio y
la hora de finalizacion, y completa la columna Volumen 1: promedio de la fila actual.

— Asset View 1

Select Data > Modify View > Publish

< Add Column

& columns

Y Edit Row Filters 2= Edit Value Mode

0 Row Filters nterpolated Values

TimeStamp Volume1 Volume1 - Minimum Volume1 - Average

2M0/2017 6:13:04.514 AM
2M0/2017 6:14:04.514 AM
2M10/2017 6:15:04.514 AM

211012017 6:16:04.514 AM @)
2/10/2017 6:17:04.514 AM @)

2072017 6:18:04.514 AM
2M10/2017 6:19:04.514 AM
2M10/2017 6:20:04.514 AM

45.5642967224121
45.1628189086914
44.7613410949707
44 35986328125

43.9583892822266
43.5569114685059
43.1554336547852
42 7539596557617

45.5642949855283
45.1628183669969

44 7613417484654

44 359865129934
43.9583885114025 '@J
43.556911892871
43.1554352743396

42 7539586558081
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Numero Descripcion

1 Hora de inicio del intervalo

2 Hora de finalizaciéon del intervalo

3 Volumen minimo del intervalo entre las horas de inicio
y de finalizacion

4 Promedio de volimenes en el intervalo entre las horas
de inicio y de finalizacidn

5 Fila actual

Para obtener informacién sobre cémo agregar una columna de datos de resumen, consulte Agregar una columna

de datos.

Agregar una columna de datos

Puede agregar columnas de datos con informacién sobre atributos.

1. Enla pagina My Views, seleccione la view que desea modificar y haga clic en Modificar View. Luego, haga

clic en Siguiente para abrir la pagina Modificar View.

Nota: Si ya estd en la pagina Modificar vista, avance al paso siguiente.

2. Haga clic en Agregar Columna.

Haga clic en la pestafia Columna de Datos y seleccione el atributo que sea la fuente de datos.

Add Column

ata Column Time Column

Select Column Data Source

4 [ Floo*
4 @ Any
4 @ vav?
& Terminal Load
& Cold Deck Damper Position
Health Status
& Hot Deck Damper Position

Latitucle

=l 1 Acntine

4. Dé un nombre Unico a la columna.

L d

Column Mame

|UniC|L.eCo|umr‘Nar'1e |

Use Default Name

Column Data Content @

|Va|ue v |

ata Type

|Dc:-u|3|e v |

Add Column

5. Establezca un calculo (por ejemplo, un promedio) para el atributo en el campo Contenido de Datos de la
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Columna.

Nota: La funcidn Last Recorded Value se usa con datos que no deberian estar interpolados; por ejemplo, un
atributo de estado que estd activado o desactivado. Last Recorded Value busca en el pasado y devuelve el
valor mas reciente del cambio en el atributo de estado.

6. (Opcional) Cambie el tipo de datos en el campo Tipo de Datos.

7. Haga clic en Agregar Columna.

Agregar una columna de horas

Use Columna de Hora para mostrar informacién adicional de horas a sus views.

Nota: Algunos pasos varian segun esté creando una view con activos o una view para eventos. Cuando el
procedimiento varia, el paso se anota con el tipo de view al cual se aplica.

1. Enla pdgina My Views, seleccione la view que desea modificar y haga clic en Modificar View. Luego, haga
clic en Siguiente para abrir la pagina Modificar View.

Nota: Si ya estd en la pagina Modificar vista, avance al paso siguiente.

2. Haga clic en Agregar Columna.
(Views con activos) Haga clic en la pestaiia Columna de Hora.

Use la Columna de Hora para agregar columnas que muestren los datos con estampa de tiempo en un
formato diferente.

Add Column

Data Column Time Column

Select Time Column Options for

ocal
GMT

Year (2016)

Maonth

Month Name
Week of the Year
Day

TimeStamp

+ 1

Day of the Week
Haour

Minute

Second
Milliseconds

UTC Seconds
UTC Milliseconds
Ticks

Time Zone Offset

Display 1time column

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 155



'AV EVA\TM Pl Integrator for Business Analytics

Como utilizar Pl Integrator for Business Analytics

a. En lalista Seleccionar Opciones de Columna de Hora para, seleccione hora local u Hora media de
Greenwich (GMT).

Por ejemplo, si elige Hora y GMT, se agrega una columna a la view que muestra solo la hora de Pl point
en GMT.

b. Seleccione una unidad de tiempo en la columna izquierda y haga clic en la flecha derecha.
¢. Cuando haya terminado, haga clic en el botdon Mostrar columna de hora.
4. (Views para eventos) Haga clic en la pestafia Columna de Hora.

En la lista Seleccionar Opciones de Columna de Hora para se muestran los diferentes datos relacionados con
la hora que puede mostrar en la view para eventos, incluidas las horas inicial y final del marco de evento.
Puede mostrar esta hora en hora local del equipo que ejecuta el Servicio de PI Integrator Framework o en
Hora media de Greenwich (GMT).

Add Column
Data Column Time Column
Select Time Column Options for | Local v
Year 2 fl(_BOr\j'clp'll Stamp (Eve B
Month Sta
on _ Event Frame Local Start Time amp
Month Name (Cctobe Event Frame Local End Time Stamp (L
Week of the Year (< Event Frame GMT Start Time [ (Evertiamet
Day Event Frame GMT End Time
Day of the Weelk (wednesd: Event Frame Duration
Hour 112 Event Frame Relative Time
Minute (25
Second (24

Milliseconds (44

UTC Seconds (1476905734 446
UTC Milliseconds (1476205734447
Ticks (636125025344460000

Time Zone Offset (420

Display 4 time columns

a. En lalista Seleccionar Opciones de Columna de Hora para, seleccione los datos que desea mostrar en la
view.

En la siguiente tabla se describen las diferentes horas que se pueden mostrar en la view.
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Opciones de lista Descripcion

Local Cuando utiliza valores muestreados, estos
corresponden a la marca de tiempo de los datos en
hora local. Cuando utiliza valores resumidos, esta
hora es la hora de finalizacion local del event frame.

GMT Cuando utiliza valores muestreados, estos
corresponden a la marca de tiempo de los datos en
hora GMT. Cuando utiliza valores resumidos, esta
hora es la hora de finalizacién GMT del event frame.

Hora de inicio local del event frame Hora de inicio del event frame en hora local.
Hora de finalizacién local del event frame Hora de finalizacidn del event frame en hora local.
Hora de inicio GMT del event frame Hora de inicio del event frame en hora GMT.
Hora de finalizacion GMT del event frame Hora final del marco de evento en hora GMT
Duracion del event frame Hora de finalizacion del event frame: (menos) hora

de inicio del event frame.

Tiempo relativo del event frame Hora de registro: (menos) hora de inicio del event
frame.

5. Seleccione la unidad de tiempo en la columna izquierda y haga clic en la flecha derecha.

Por ejemplo, si selecciona Hora de inicio local del event frame y Hora, se agrega una columna Unicamente
con la hora de la hora de inicio del event frame en formato de hora local.

6. Cuando haya terminado, haga clic en el botdn Mostrar columna de hora.

Modificar una columna

Puede cambiar el nombre de una columna; establecer un célculo, como un promedio, en los valores de la
columna; cambiar el tipo de datos; cambiar la unidad de medida o eliminar la columna.

1. Haga clic en la columna para abrir el panel Detalles de columna.

¢ Pl Integrator Framework reserva la cadena que no distingue mayusculas de minusculas, ID, PlintTSTicks y
PlintShapeld, como nombres de columna. Usted puede usar estas cadenas para nombrar columnas en las
vistas con activos y eventos. Sin embargo, si lo hace, se agregara un guion bajo (_) al nombre de la columna
en los datos de destino, por ejemplo, ID_o Id_.

Nota: Esta restriccidn no rige para los siguientes objetivos: Amazon Kinesis Data Streams, Amazon S3,
Apache Kafka, Centro de eventos de Azure, Azure loT Hub, Google Cloud Storage, Google Pub/Sub, Sistema
de archivo distribuido Hadoop y Text File.

¢ Los nombre de la columna se vuelven a formatear segun las limitaciones de cada tienda de destino. Por
ejemplo, los nombres de la columna de Oracle se limitan a 30 caracteres y los nombres que superan los
30 caracteres se truncan.
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¢ Los destinos de la base de datos Oracle tienen cadenas reservadas; si estas aparecen en los nombres de la
columna, se agregara un guion bajo (_) a la cadena.

¢ Los nombres de columna deben ser Unicos.

¢ Lafuncién Last Recorded Value en el campo Contenido de Datos se usa con datos que no deberian estar
interpolados; por ejemplo, un atributo de estado que estd activado o desactivado. Last Recorded Value busca
en el pasado y devuelve el valor mas reciente del cambio en el atributo de estado.

@ Column Details

WEIulE

Forecasted Chance of Rain |

Reset Name to Default

Data Content @

Walue v |

Data Type

Double v |

Remove

Apply Changes

1. Realice los cambios necesarios en la columna.

2. Cuando haya finalizado, haga clic en Aplicar Cambios.

Filtrar los datos

Puede filtrar los datos de una view mediante el uso de varios pardmetros. Por ejemplo, puede especificar que
desea incluir registros si el contenido de la columna tiene un valor numérico determinado o coincide con un
patron de cadena.

Cuando aplica un filtro, Pl Integrator toma el conjunto de datos que coincide con la figura de activo, la une al
conjunto de datos que coincide con el filtro y genera el subconjunto de datos que cumple ambos criterios.

1. Enla pagina My Views, seleccione la view que desea modificar y haga clic en Modificar View. Luego, haga
clic en Siguiente para abrir la pagina Modificar View.

Nota: Si ya estd en la pagina Modificar vista, avance al paso siguiente.

2. Haga clic en Editar Filtros de Registros y elija el tipo de filtro que desea.

Nota: Los filtros usados con mas frecuencia son filtros numéricos y de cadena.
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Los filtros del event frame solo se aplican a views con activos. Por lo tanto, si crea una view para eventos,
este tipo de filtro no aparecera como opcion.

Row Filters x

Add Mew Row Filter

String Include rows based on whether the contents of a column match a
string pattern
Diqita Include rows based on whether the contents of a column contain
- certain digital values
NUmeric Include rows based on whether the contents of a column contain
certain numeric values
Null Values Include rows where the contents of a celumn contain a value
r ¥ L
Include rows where certain Event Frames are active
Event Frame

Close

Para obtener informacién sobre como aplicar un filtro de Marco de Evento , consulte Filtrar por marcos de
evento.

Cuando haya terminado de definir el filtro, haga clic en el botén Guardar.

4. En el cuadro de dialogo Filtros de Registros, haga clic en Cerrar.

Filtrar por marcos de evento

El siguiente procedimiento muestra cémo aplicar un filtro de registros de marcos de evento a una view con
activos.

Nota: Los filtros por marcos de evento solo se aplican a views con activos.

Cuando define una figura de activos, crea una coleccion de coincidencias que cumplen con los mismos criterios.
Cuando aplica un filtro de marco de evento a esta view, define una figura de evento que crea una coleccién de
coincidencias para un conjunto de marcos de evento. Pl Integrator luego une estas dos colecciones sobre la base
de un activo comun para obtener el subconjunto de datos que corresponde a las dos.

Por ejemplo, supongamos que tiene algunos pozos y que en cada uno de ellos se usan determinados equipos de
a uno por vez, y que se usan marcos de evento para registrar los datos recopilados por estos equipos. Cada
marco de evento tiene una hora inicial y una hora final diferentes y se aplica a un pozo diferente. Puede usar el
filtro de registros de event frame para incluir datos de la view con activos del pozo, solo para el periodo en que
se ejecutaba el equipo en ese pozo.
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1. Enla pagina My Views, seleccione la view que desea modificar y haga clic en Modificar View. Luego, haga
clic en Siguiente para abrir la pagina Modificar View.

Nota: Si ya estd en la pagina Modificar vista, avance al paso siguiente.

2. Use los campos Hora Inicial y Hora Final para ajustar el intervalo de tiempo a fin de incluir las horas cuando
se registraron los marcos de evento de interés.

Nota: Si la hora inicial y la hora final estdn fuera del intervalo de tiempo del event frame, no se encontraran
event frames.

3. Haga clic en Editar Filtros de Registros y elija Marco de Evento para el tipo de filtro.

Pl Integrator ahora busca event frames en la base de datos de Pl AF para esta vista y muestra un subconjunto
de los que encuentra.

Create New Event Frame Row Filter

Event Frames _ Shape Tree

4 (D) Catalytic Cracking

. . 4 () Boiler-210
» "4 Casing Temperature Excursion Roc T B o . s

» "§ Casing Temperature Excursion Roc & Fuel Gas Flow
» "§ Casing Temperature Excursion Roc @ Fuel Gas Volume
» ¥4 Casing Temperature Excursion Rog
» "4 Casing Temperature Excursion Roc
» "4 Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc
» "§ Casing Temperature Excursion Roc

» "4 Casing Temperature Excursion Roc ¥

Event Frame Related Asset Start Time =

4. Haga clicen el icono Y para abrir el menu. Haga clic en el corchete angular derecho (>) en una de las
categorias de filtro para abrir el panel relacionado.

Y

En los campos de filtro, especifique los parametros para reducir los marcos de evento a fin de encontrar los
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que busca. Por ejemplo, ingrese una cadena que coincida con el patrén en el campo Nombre de Evento o
seleccione una plantilla en Plantilla de Evento.

Event Frames

Y

Event Name

Event Template

Clear All Filters Apply Hiters

Haga clic en Aplicar Filtros.
6. De los marcos de evento encontrados, arrastre un marco de evento al panel del centro.
El filtro ahora incluye los registros por los cuales este marco de evento estd activo.

7. Opcionalmente, puede ampliar los criterios de busqueda del filtro de registro para incluir todos los marcos
de evento con la misma plantilla o categoria. Para hacerlo, use la lista desplegable para cambiar la busqueda
de Nombre de Evento a Plantilla de Evento o Categorias de Eventos.

Create New Event Frame Row Filter

By TS [ v | ‘ Include rows with this Event Frame Active
matches |EventFrameAnalysis 20150612 01:46:32 X+
Event Name

t is any. Drag an element from the Shape Tree to specify.

p» "H EventFrameAnalysis 20150612 01:46:32

Event Categories
» " EventFrameAnalysis 20150612 01:46:32 T AUOCVETTT COTTanTah

» "8 EventFrameAnalysis 20150612 01:46:32
» "H EventFrameAnalysis 20150612 01:46:32
L BH FusntFramsfnaheic 20RNA1D MR

v

Pl Integrator recupera los event frames que coinciden y los muestra en el panel de vista previa, en la parte
inferior de la ventana.

8. Hagaclicenelicono al lado de la condicién de evento.

9. Para alinear los event frames con el activo correcto, arrastre el activo o atributo del Arbol de figuras a los
criterios de filtro.

Este paso define la relacidn entre los dos conjuntos de datos (el conjunto de datos del marco de evento y el
conjunto de datos de atributos y activos). Esto es similar a la condicidon en una unién de tabla relacional que
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equipara un atributo en una tabla (o conjunto de datos) con un atributo en la otra tabla (conjunto de datos).
Aqui, equiparamos el activo "que posee" el marco de evento con el activo del Arbol de Figuras.

Pl Integrator actualiza la visualizacidn de los event frames que coinciden en la vista previa.

10. Cuando haya terminado de definir el filtro, haga clic en Guardar Filtro de Registros de Marcos de Evento.

Acerca de la publicacion de vistas grandes

Es probable que las vistas grandes con 100 o mas elementos y atributos combinados encuentren un limite con el
protocolo de transporte Web Sockets, que tiene un tamafio maximo de paquetes de datos de 64K. Antes de
publicar vistas grandes, es probable que deba cambiar el tipo de transporte a Eventos enviados por servidor para
adaptarse a los tamafios de paquetes mas grandes. Esto solo es obligatorio para los usuarios de navegadores
web Microsoft Edge.

En cualquier pagina, haga clic en el icono de engranaje H de la esquina superior derecha y configure Tipo de
transporte en Eventos enviados por servidor.

Acerca de las vistas publicadas de manera continua

Las vistas se pueden publicar de manera continua en un programa. Puede volver a publicar una vista en
intervalos de un minuto como minimo y de 12 meses como maximo. Por ejemplo, puede configurar su vista para
volverla a publicar a las 12:00 a. m. todos los dias.

Nota: Las vistas continuas se ejecutan en la hora local en la que Servicio de Pl Integrator Framework se esta
ejecutando. Por lo tanto, los usuarios que se encuentran en diferentes zonas horarias deben tener en cuenta
esto al programar sus ejecuciones.

Cada vez que se publica la vista, los datos nuevos se agregan a los datos existentes. Por lo tanto, el archivo o la
tabla objetivo siguen creciendo cada vez que se vuelve a publicar la vista en el programa. Al publicar vistas en un
programa, por el momento no existe la opcidn de sobrescribir los datos. Debe eliminar manualmente los datos
gue ya no necesita en el archivo o la tabla objetivo de publicacién.

Usted especifica el periodo que desea actualizar. Si tiene alguna inquietud acerca del consumo de demasiados
recursos, puede especificar intervalos de tiempo mas cortos y actualizar los datos al realizar las publicaciones
varias veces.

Puede especificar que desea que su vista se publique en un programa en la pagina Publicar. Para obtener mads
informacion, consulte Publicar una vista en un programa.

En la pagina My Views (Mis vistas), las vistas publicadas de manera continua tienen un Modo de ejecucién
continuo.

Pl Integrator admite actualizaciones automaticas de los datos publicados de Pl System en destinos seleccionados.
Para obtener mas informacion sobre esta funcion, consulte Como se actualizan los datos publicados.

Ver nombres y puntos finales de destino

Cuando PI Integrator publica una vista, el nombre de la vista se usa para crear el nombre del punto de destino.
Cada destino tiene sus propias convenciones y reglas de nomenclatura para determinar si el nombre es
aceptable. Si el nombre de una vista contiene un caracter que no se permite en el destino, Pl Integrator elimina
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ese caracter o lo reemplaza con un caracter de guion bajo (_).

Los destinos también tienen reglas sobre el largo de los nombres. Si el nombre del punto final supera estos
limites, Pl Integrator muestra una advertencia o un mensaje de error.

Consulte la documentacién del destino especifico para conocer las convenciones de nomenclatura y los limites
de largo de nombre correspondientes.

Publicar una vista una vez

Las vistas que se ejecutan una sola vez pueden publicarse de inmediato, o bien puede especificar que se
publiquen mas adelante.

Para obtener informacién sobre cémo publicar vistas en un programa, consulte Publicar una vista en un
programa. Para obtener informacién sobre cémo publicar vistas de transmisién, consulte Publicar una vista de
transmision.

En la pagina Publicar, seleccione el objetivo de la lista Configuracién de objetivos.
2. Haga clic en Ejecutar una vez.

3. (Opcional) Especifique la fecha y la hora en que quiere publicar la vista.

Nota: Las vistas programadas se ejecutan en la hora local del equipo que ejecuta el Servicio de Pl Integrator
Framework. Si se encuentra en una zona horaria diferente, es posible que deba convertir su hora local
programada a la zona horaria de Servicio de Pl Integrator Framework para obtener el resultado deseado.

4. Haga clic en Publicar.

Publicar una vista en un programa

Puede publicar una vista en un programa continuo. En la pagina Publicar, puede especificar la frecuencia con la
que desea publicar la vista. Los resultados de cada ejecucidn se agregan a los resultados anteriores. Para obtener
mas informacién acerca de las vistas publicadas continuamente, consulte Acerca de las vistas publicadas de
manera continua.

1. Enla pagina Modificar vista, ingrese la frecuencia de muestra y las horas de inicio y finalizacion.

Nota: Pl Integrator for Business Analytics arroja datos del rango de tiempo especificado por Hora de inicio y
Hora de finalizacion solo en la primera ejecucion.

Haga clic en Siguiente.
En la pagina Publicar, seleccione el objetivo de la lista Configuracion de objetivos.

Haga clic en Ejecutar en un programa.

vk W

Especifique la fecha y hora de la primera ejecucion.

Nota: Las vistas programadas se ejecutan en la hora local del equipo que ejecuta el Servicio de Pl Integrator
Framework. Si se encuentra en una zona horaria diferente, es posible que deba convertir su hora local
programada a la zona horaria de Servicio de Pl Integrator Framework para obtener el resultado deseado.

6. Especifique la frecuencia de las ejecuciones subsiguientes.

Nota: Puede especificar una frecuencia de un minuto como minimo y de 12 meses como maximo.

7. Haga clic en Publicar.
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Programacion de vistas para vistas de activos

Cuando las vistas de activos se publican en un programa, Pl Integrator for Business Analytics utiliza los siguientes
parametros para determinar los rangos de tiempo discrecionales en los que obtiene datos:

* Hora de inicio

* Hora de finalizacion

* Frecuencia de ejecucion
e Frecuencia de muestra

e Primera ejecucion

Pl Integrator for Business Analytics publica datos del rango de tiempo especificado por los pardmetros Start Time
y End Time solo para la primera ejecucion. En ejecuciones posteriores, Pl Integrator for Business Analytics evalua
la ventana de obtencion de datos con la siguiente férmula:

e Start Time = Ultima publicacién End Time + Sample Frequency

e End Time = End Time configurado, evaluado en el momento de ejecucién

Segln como se configuren los parametros, puede haber diferencias significativas en los datos obtenidos. Para ver
mas informacién, incluidos ejemplos que ilustran el efecto que tienen las distintas configuraciones sobre los
datos recuperados, consulte How does view scheduling work for Pl Integrator Asset Views?

Publicar una vista de transmision

Es probable que las vistas grandes con 100 o mas elementos y atributos combinados encuentren un limite con el
protocolo de transporte Web Sockets, que tiene un tamafio maximo de paquetes de datos de 64K. Antes de
publicar vistas grandes, cambie el tipo de transporte a Eventos enviados por servidor para adaptarse a los
tamafios de paquetes mas grandes.

En la pagina Mis vistas, haga clic en el icono de engranaje n de la esquina superior derecha y configure Tipo
de transporte en Eventos enviados por servidor.

Nota: Los destinos de transmisidn solo pueden transmitir 25 000 coincidencias de la figura de busqueda. Una vez
alcanzado este limite, no se transmiten mas coincidencias y aparece un mensaje de error en el archivo de
registro de vista.

En la pagina Publicar, seleccione un destino de la lista Configuracién de destino.

2. (Apache Kafka solamente) Seleccione un tema al que se enviard el mensaje.
De manera predeterminada, los mensajes se envian a un tema que tiene el mismo nombre que la vista.
También puede elegir enviar mensajes a temas existentes.

a. Haga clic en Obtener temas para completar la lista de temas disponibles entre los que puede
seleccionar.

b. Haga clic en la flecha para mostrar la lista de temas.
Especifique la hora de inicio para la primera publicacidn de la vista.

4. Haga clic en Publicar.
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La pestana Estadisticas muestra informacidon sobre el proceso de publicacidn de vistas. Esto es util para
solucionar dificultades durante la lectura de datos en el Pl System y al escribir datos en el destino. Los datos
estadisticos incluyen el tiempo de cada ejecucion publicada; esto puede ser Util en la programacion cuando las
aplicaciones posteriores leen los datos del destino.

Si no ve las estadisticas de un periodo anterior, es posible que Pl Integrator haya purgado estos registros del
servidor de SQL Server donde se guardan para evitar un consumo excesivo de espacio en disco. Consulte
Configurar las politicas de retencidn de registros para obtener mds informacion sobre cuando se eliminan estos
registros. Utilice el procedimiento a continuacidn para familiarizarse con la informacién de la pestafia

Estadisticas.

1. Enla pdagina Mis vistas, seleccione la vista en la que esta interesado.

2. Sino se abre el panel Detalles de la vista, haga clic en el botdn en la esquina inferior derecha para abrirlo.
Luego, haga clic en la pestafia Estadisticas.

Se mostraran los datos estadisticos de la vista seleccionada.

Overview Log

Security View Configuration Statistics

Run History Duration (seconds)
Run Instances + Duration Rows Written Rows Filtered Error Count All Runs
seconds ¥ 9
26
. 24
(EAATE 2= U i 9 WM Wﬂ.
% 1/22/20 7:18 AM ol WLV ,
1/22/20 7:28 AM 23.23 0 0 0 TE: | |
16 - ‘ ‘
1/22/207:38 AM 24.019 0 0 0 1] | |
12+
1/22/20 7:48 AM 22.291 0 0 0 ol ‘ |
Total 96 2,121.159 [ ] 0 | 7 |‘ ‘
4
24 L
| Download All Reports || Enable Full Reporting |

3. Haga clicy elija uno de los datos estadisticos

T T T T T T T T T T T T T T T n
10PM 11PM Wed2z 01AM DZAM O0ZAM O4AM O05AM 0BAM OTAM 08AM ODAM 10AM 1AM 12PM 01PM

en el encabezado de tabla para ver datos sobre las tendencias.

Qverview Log Security View Configuration Statistics
Run History [ Duration (seconds)
Run Instances + Duration Rows Written Rows Filtered Error Count All Runs
seconds ¥ 9
26|
o 24
(DT e3Ta) u I 9 VN RWM ,’M\A.M—..A-j\--.a.
¥ 1/22/20 7:18 AM o] ,
1/22/20 7:28 AM 23.23 0 0 0 TE: | |
16 - ‘ ‘
1/22/207:38 AM 24.019 0 0 0 1] | |
12+
1/22/20 7:48 AM 22.291 0 0 0 o] ‘ |
Total 96 2,121.159 0 ] 0 | 7 |‘ ‘
2
24 *-
| Download All Reports || Enable Full Reporting |

T T T T T T T T T T T T T T T n
10PM 11PM Wed2z 01AM DZAM O0ZAM O4AM O05AM 0BAM OTAM 08AM ODAM 10AM 1AM 12PM 01PM

4. Haga clic en una fila de la tabla para ver datos estadisticos adicionales de la ejecucién seleccionada en el
panel derecho.

5. Haga clic en Mostrar todas las ejecuciones para volver a la vista de tendencias.
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Qverview Log Security View Configuration Statistics

Run History Duration (seconds)
ZD:

1/22/20 7:18 AM 22.327 0 0 [} -
1/22/20 7:28 AM 23.23 0 0 [:} 15
1/22/20 7:38 AM 24.019 0 0 [:}

10
1/22/20 7:48 AM 22.291 0 0 0

5
Total 96 2,121.159 0 0 0 |
Download Selected Report || Enable Full Reporting o 1

| View Logs for Run

T T
Reading from FI Filtering & Caleulating Wiriting to MSSQL

6. Seleccione una parte del grafico de tendencias para acercarla.

Duration (seconds)
All Runs

26 |23.7 01/22/20 05:43:47 AM|

o R e L. ey 8
224 i
20 -

L}.
T T T T T T T T T T T T T T T T1
10PM 11 PM Wed22 01AM O2AM 03 AM 04AM 05 AM OHAM OF AM OB AM CBAM 10AM 11AM 1ZPM 01FPM

El drea seleccionada se expande para llenar el eje X del grafico.
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Duration (seconds)
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7. Hagaclic en la lupa para alejar la imagen.

Duration (seconds)

All Runs
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8. Haga clic en un nodo del gréfico de tendencias para ver los detalles de esa ejecucion.
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Duration (seconds)

All Runs
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9. Haga clic en Ver registros para ejecutar para ver los registros que desea ejecutar.

Pl Integrator lo llevara a la pestafia Registro de la ejecucion seleccionada.

Habilitar por completo la generaciéon de informes

Nota: El Soporte técnico usa Habilitar por completo la generacion de informes para recopilar estadisticas
completas que ayudan a solucionar problemas con la publicacién de vistas. No active esta funcidn, a menos que
el Soporte técnico se lo indique. Si activa la funcién de informes completos, es posible que el espacio disponible
en disco se llene rapido.

1. Identifique la vista que esta teniendo problemas de rendimiento.

2. Vaya a la pestafia de estadisticas de la vista y haga clic en el boton Habilitar por completo la generacion de
informes.

Espere a que se ejecute la siguiente publicacién programada para la vista.

4. En la pestaia de estadisticas, despldcese para ver las instancias de ejecucion que se produjeron después de
habilitar por completo la generacién de informes.

5. Haga clic en la instancia de ejecucidn y seleccione Descargar informe seleccionado. La instancia de vista
debe tener un icono de grafico de barras junto a la marca de tiempo, lo que indica que se habilité por
completo la generacién de informes durante esa instancia de ejecucion.

6. Haga clic en el botdn Desactivar por completo la generacidn de informes.

Como se actualizan los datos publicados

Pl Integrator Sync supervisa los activos en el Pl System, en relacidn con las vistas de activos, las vistas de flujo
programado y las vistas de flujo activado por el valor clave. Mantiene actualizados sus datos publicados de las
siguientes maneras:
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¢ Pl Integrator Sync monitorea la figura de la vista y registra los cambios en Pl AF que afectan las coincidencias
en su vista. Por ejemplo, asuma que tiene una vista de bombas y hay 10 coincidencias. Se agrega una nueva
bomba a Pl AF que tiene como resultado 11 coincidencias de la figura de su vista. Pl Integrator Sync publica
los datos de las 11 coincidencias futuras y, para las vistas de activos y las vistas de flujo programado, rellena
los datos de la nueva bomba.

¢ Pl Integrator Sync monitorea los cambios que tienen lugar en los datos en Archivo de Datos y actualiza los
datos publicados. Por ejemplo, cuando un valor de datos en Archivo de Datos se actualiza con un nuevo
valor, Pl Integrator Sync publica el nuevo valor en el destino.

Nota: Para obtener una definicién de los diferentes tipos de vistas de transmision, consulte Acerca de los
activadores de mensajes.

Pl Integrator Sync monitorea los datos fuera de orden y rellenados, y actualiza los datos publicados previamente
una vez cada 30 minutos. Por lo tanto, cuando se produce un cambio en Pl AF o Archivo de Datos, el cambio
puede demorar hasta 30 minutos en verse reflejado en sus datos. Si los datos llegan tarde a Pl Data Archive y

Pl Integrator for Business Analytics ya ha publicado los datos para el intervalo de tiempo de estos datos que
llegaron tarde, los datos demorados no se actualizardn automaticamente en la tabla de destino. Para cerciorarse
de que se publiquen todos los datos, configure una demora en el parametro Hora de finalizacién de la vista (por
ejemplo, *-1 hora), o bien rellene con los datos en forma manual una vez que estos llegan a Pl Data Archive. Para
obtener mas informacion, consulte Actualizar datos manualmente.

Para sacar provecho de las caracteristicas de sincronizacién de Pl Integrator Sync, debe utilizar Archivo de
Datos 2017 o una version posterior.

En la siguiente tabla, se muestran cada uno de los destinos y el tipo de sincronizacién compatible.

Tioo Destino Admite sincronizacion Admite sincronizacion
P con PI AF con Archivo de Datos
Base de datos relacional Base de datos SQL de
Azure

Microsoft SQL Server

Base de datos Oracle

SAP HANA

Almacén de datos Amazon Redshift

Apache Hive

Grupo SQL dedicado de
Azure

Google Big Query

ANENA N NENANANEN
ANEANA N NE N NENEN
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Tipo

Destino

Admite sincronizacion
con PI AF

Admite sincronizacion
con Archivo de Datos

No estructurado

Archivo de texto

*

Data Lake

Amazon S3

*

Azure Data Lake Storage G
en 2

*

AN

Google Cloud Storage

*

Sistema de archivos
distribuido Hadoop
(HDFS)

*

Message Hub

Flujos de datos de
Amazon Kinesis

Apache Kafka

*
*

Centros de eventos de
Azure

*
*

Azure loT Hub

*
*

Google Cloud Pub/Sub

RN DN N N

ANANENE NN

Nota: En el caso de destinos de Data Lake y del archivo, Pl Integrator Sync supervisa los cambios en la figura de
vistas de activos y publica los datos de las coincidencias futuras. Sin embargo, no se admiten los cambios en Pl
Data Archive. Por lo tanto, Pl Integrator Sync no rellena los datos en estos destinos ni actualiza los cambios en los
datos publicados. La excepcion a esto es Azure Data Lake Storage Gen 2, que admite la figura de vista con activos

y los cambios en los datos.

Nota: Los destinos de transmisidn ofrecen compatibilidad de sincronizacion con la transmisidn programada
solamente. Las vistas de flujo activado por la clave no tienen compatibilidad de sincronizacion.

Como se sincronizan los datos publicados con PI AF

A continuacion, se describe de qué manera se sincronizan los datos publicados con los cambios en la jerarquia PI

AF:

¢ Se agrega un elemento a Pl AF

Nota: Aseglrese de que se hayan marcado todos los cambios realizados en Pl System Explorer/AF Server
antes de crear una vista que esté destinada a esos cambios. Los elementos que no coinciden con la figura de
vista al crearse y que se modifican posteriormente para coincidir con la figura de vista, no se agregaran
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automaticamente a sus vistas existentes. Ademas, si la figura de vista contiene atributos que no estan
marcados como opcionales en la configuracion de vista, estos atributos deberan estar presentes en el
elemento desde la creacion del elemento para ese elemento y los atributos correspondientes que se

agregaran a sus vistas existentes.

¢ Vistas de activos y vistas de transmisidn programadas: si se agregan un elemento o una combinacién de
elementos y atributos a Pl AF, esto tiene como resultado una nueva coincidencia en su vista, se publican
datos para el nuevo elemento de alli en mas y se rellenan los datos con la hora de inicio de la vista
original.

e Vistas de transmisidn desencadenadas por valor de clave: si se agregan un elemento o una combinacidn
de elementos y atributos a Pl AF, esto tiene como resultado una nueva coincidencia en su vista, y se
agregan los datos del nuevo elemento solo de alli en mas. No se rellenan los datos publicados
anteriormente.

¢ Eliminacion de un elemento de Pl AF: si se elimina un elemento de Pl AF, se modifica la cantidad de
coincidencias en su vista y los datos del elemento no se publican de alli en mas. Sin embargo, se conservan
los datos publicados anteriormente.

e Cambio de nombre de un elemento en PI AF: si se cambia el nombre de un elemento en Pl AF, se le cambia el
nombre al elemento de manera automatica en la vista. El nombre nuevo aparece en los datos publicados en
lo sucesivo, pero los datos publicados anteriormente conservan el nombre del elemento antiguo.

Nota: Pl Integrator Sync no realiza un seguimiento de los cambios en los permisos de identidad de AF en los
elementos existentes. Por ejemplo, si se agregan permisos de seguridad de AF a un elemento que una vista
no estd publicando actualmente, los datos de este elemento no se publicaran de forma automatica en el
futuro, ni se incluirdn en los rellenados de datos. Si se eliminan los permisos de seguridad de AF de un
elemento, las publicaciones posteriores podran seguir accediendo a los datos del elemento a pesar de los
permisos revocados. Para reflejar los cambios en los permisos de identidad de AF en un elemento existente,
las vistas que hagan referencia a ese elemento deberan volver a publicarse o se debe volver a crear el propio
elemento. Para obtener mas informacién sobre la identidad de AF que utiliza PI Integrator Sync, consulte
Seguridad de datos.

A continuacion, se describe de qué manera se sincronizan los datos publicados con datos fuera de orden y
rellenados de Archivo de Datos para cada tipo de vista:

¢ Vistas de activos: cuando hay cambios en los datos de Pl Data Archive, los datos de destino se actualizan
automaticamente. Pl Integrator Sync sobrescribe los datos en el destino.

¢ Vistas de flujo programado: si hay un cambio en el valor de los datos, el nuevo valor se publica en el destino.
Sin embargo, el valor publicado anteriormente no se elimina. Se debe configurar la opcién Rellenar datos de
la pagina Modificar vista para habilitar esta funcionalidad.

e Vistas de flujo activado por el valor clave: no se admite la actualizacidn de los datos para estas vistas.

¢ Vistas de eventos: las vistas de eventos no capturan automaticamente datos de cambio ni datos fuera de
orden, pero ese tipo de datos se puede publicar manualmente usando la funcién de actualizacién de datos
(botdn). El intervalo de tiempo que especifique en su actualizacion manual de datos capturara todos los
event frames que tengan una hora final dentro de ese intervalo.

Actualizacion manual

Puede actualizar datos de forma manual, independientemente de su versién de Pl Data Archive.

Sin embargo, si utiliza Pl Data Archive 2016 R2 o una version anterior, Pl Integrator for Business Analytics no
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admite la actualizacién automatica de datos. Por lo tanto, la Unica opcion disponible es actualizar manualmente
los datos que han cambiado desde la publicacion.

Solo puede actualizar datos manualmente en las vistas de activos, las vistas de eventos y las vistas de
transmision programadas en destinos compatibles. No puede actualizar datos de vistas que se publiquen solo
una vez o se publiquen en un destino del archivo o del HDFS, y no puede actualizar las vistas de flujo activado

por el valor clave.

Solo debe actualizar los datos manualmente si los datos cambiaron desde que se publicaron por ultima vez en la
tienda de datos de destino. Los cambios realizados a los datos, que se producen antes de una publicacidn
programada, se escriben en la tienda de datos con los ultimos valores.

Estas son algunas circunstancias que pueden provocar que cambien los datos:

¢ Los datos se estaban almacenando en bufer en un nodo interfaz en el momento en que se publicaba la vista.

¢ Los datos se rellenan o recalculan. Esto suele tener lugar con etiquetas de analisis Pl AF.

¢ Los datos se ingresan manualmente después de que se publica la vista.

Actualizar datos manualmente

1. Seleccione una vista en la pagina Mis vistas cuyo estado de Modo de ejecucion sea Continuo o Flujo

programado.

2. Haga clic en la barra horizontal de la esquina inferior derecha de la pagina My Views para abrir el panel de

detalles.

My Views

= A OShlasato £

+ Create Asset View

iew starting with your

+ Create Event View

Build 2 data view starti

ing with t

& Modify View

Medify existing data view

¥ remove View

Remove selected viev

& Name Run Status Type Run Mode Start Time
Pump A19375X1 Not Yet Published Asset Continuous *8h
‘Pump C97534X2 Not Yet Published Asset ‘Once *-8h
‘Pump G27834V3 Not Yet Published Asset ‘Once *-8 hours
‘Pump B90853V1 Not Yet Published Asset ‘Once *-8h
-Pump G78359X2 Not Yet Published Asset ‘Once *-8h
-Pump U57328X2 Not Yet Published Event ‘Once
-Pump X75132X3 Not Yet Published Asset ‘Once *-8h
——
— m [l
3. Haga clic en la pestaia Descripcidon General.
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1 OSNasato £

Qverview Log

Run Status
View Name

Pl AF Database
Publish Target
View Type

Run Mode

Last Run Time

Security

Scheduled
Pump A19375X1
Datacenter Demo
SQL Server
Asset
Continuous

Never

Publish Actions

Stop

Update Data

¢ En el panel Acciones de publicacién, haga clic en Actualizar datos.

Search Shape
Asset Shape
4 [ Atlanta
4 [ colol
& ColoMumber
& Zonel Capacity
& Zonel CapacityPercent

L 7 i

i a Name Run Status Type Run Mode Start Time EI v=
Pump A19375X1 Scheduled Asset Continuous *
‘Pump C97534X2 Not Yet Published ‘Asset ‘Once 5
\Pump G27834V3 Not Yet Published Assel ‘Once
-Pump B90853V1 Not Yet Published Asset ‘Once
‘Pump G78359X2 Not Yet Published Asset ‘Once
{Pump U57328X2 Not Yet Published {Event ‘Once
{Pump X75132X3 Not Yet Published Asset ‘Once =8n
13
—mE

Nota: Si el botdn Actualizar datos esta desactivado, significa que no se admite la actualizacién manual
en esta vista. Para obtener informacidn sobre qué vistas se pueden actualizar, consulte Cémo se
actualizan los datos publicados.

4. Especifique el periodo de los datos que desea actualizar.

Nota: Solo puede actualizar datos por un periodo en el pasado.

5. Haga clic en Confirmar.

Nota: Pl Integrator primero elimina los datos existentes especificados en el intervalo de tiempo y, luego,
publica los datos nuevos.

Modificar una view

Cuando modifica una vista, hay implicaciones en cuanto a cdmo se manejan los datos existentes:

¢ Cuando se modifica y se vuelve a publicar una vista de activo o de evento publicada, los datos existentes se
eliminan. No se preservan los datos publicados anteriormente. La vista de activo o de evento modificada
utiliza la hora de inicio de la primera publicacién como su hora de inicio. Cuando se vuelve a publicar una

vista que se publica en un destino de publicacidn basado en archivo, los archivos de datos publicados

existentes se eliminan. En el caso de destinos de publicacion basados en tablas, la accidn de volver a publicar
elimina la tabla de destino existente. En cualquiera de los casos, no se preservan los datos publicados con
anterioridad. La vista de activo o de evento modificada utiliza la hora de inicio de la primera publicacién
como su hora de inicio.
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¢ No se modificardn los datos que se lean de un destino de transmision en otro sistema. Deberd reconciliar las
diferencias en los datos que se envien de la vista original y la vista modificada. En la mayoria de los casos,
probablemente eliminard los datos almacenados existentes antes de publicar la vista modificada.

Como alternativa, puede realizar una copia de una vista y editarla; esta vista se considerard una vista nueva.

1. Enla pagina Mis vistas, seleccione la vista que desea modificar y haga clic en Modificar vista.
2. En el cuadro de didlogo Modificar vista, realice una de las siguientes opciones:
¢ Para editar la vista, haga clic en Editar esta vista.

¢ Para editar una copia de la vista, seleccione Editar una copia de la vista, introduzca un nombre Unico
para la vista y haga clic en Editar vista.
La view seleccionada se muestra en la pagina Seleccionar Datos. Puede continuar realizando cambios en la
figura de datos, modificar la view y publicar los datos.

Para obtener mas informacion sobre como editar una vista, consulte Crear una view con activos, Crear una
view para eventos y Crear una vista de transmision.

Nota: Si la configuracion de seguridad de suplantacion de la aplicacidon esta activada, la vista que haya
modificado o copiado utilizara las identidades de AF asignadas al usuario que copid o modificd la vista para
obtener acceso a los datos en lugar de las identidades de AF asociadas con el usuario que publicé la vista por
ultima vez. Consulte la seccién Seguridad de datos para obtener mas informacién.

Copiar una view

Puede crear una copia de cualquier vista si la selecciona en la pagina Mis vistas y hacer clic en Modificar vista.

Cambiar el nombre de una view

Puede cambiar el nombre de una view desde la pagina My Views.

1. Enla pdagina My Views, haga clic en una de las barras en la esquina inferior derecha para abrir el panel de
detalles.
Se abre el panel con la pestaina Descripcidn General seleccionada.

-

. + .
2. Hagaclicen “ allado del nombre de la view.

Nota: El cambio de nombre de vistas no es compatible con objetivos de Amazon Kinesis Data Streams,
Amazon S3, Apache Kafka, Centro de eventos de Azure, Azure loT Hub, Azure Data Lake Storage Gen 2,
Google BigQuery, Google Cloud Pub/Sub, Google Cloud Storage, Sistema de archivo distribuido Hadoop y
Text File.

3. Edite el nombre de la view y haga clic en Cambiar nombre.

Aseqgurar las views

Puede controlar el acceso a las vistas para las cuales tiene permisos de propietario. Consulte la seccién Ver
permisos de acceso para obtener mds informacion.
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Haga clic en el icono del menu E y en My Views.
2. Enla pagina My Views, seleccione una view de la lista.
Los detalles de la view aparecen debajo de la lista en el panel Detalles.

3. Haga clic en la pestafia Seguridad.

+ Create Asset View + Create Event View 1 + Create Streaming View H [ Mndif-
Name Run Status Start Time Run Mode Creatiod
Bailer Wiew Published *-Bh Once QB22
Compressor View Pubdished *.fh Onice O/ar22 3
Pump View Published “_gh Onca 0/12/22
| EE

Qverview Log Security View Configuration Statistics
ldentities
View Access @ Data Access

1 4 @Qrator Sary B

Pl Imtegrat rvice & At 2 World

A erqnees

) Add (= Remove

Nota: Las identidades de acceso a datos son las identidades de AF que se utilizan para acceder a los datos de
origen cuando la configuracion de seguridad de suplantaciéon de la aplicacidn estd activada y solo se
muestran cuando el ajuste esta activado.

4. Puede realizar las siguientes acciones en la vista seleccionada en Ver acceso.
e Cambiar los permisos de una vista
¢ Agregar una identidad nueva y conceder permiso a la vista

e Eliminar el acceso a una vista
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Seqguridad de PI Integrator Framework

Existen tres areas generales que se deben tener en cuenta en el momento de planificar la seguridad de
Pl Integrator for Business Analytics:

¢ Seguridad de las aplicaciones: define las mejores practicas para proteger los servicios de Pl Integrator for
Business Analytics, como las medidas de defensa contra ataques de denegacién de servicio (DoS).

¢ Seguridad de datos: determina qué usuarios reciben acceso a los datos en Pl AF y de qué manera se
administra la seguridad.

Nota: La seguridad de los datos publicados que residen en el destino designado debe tenerse en cuenta. La
seguridad de los datos publicados se maneja y administra en el propio destino de publicacion. Para obtener
mas informacién sobre cdbmo administrar el acceso a los datos del destino, consulte Secure views for an
identity.

e Seguridad de acceso de usuario: define qué usuarios reciben acceso a la aplicacién web PI Integrator for
Business Analytics, su nivel de acceso (administrador) y los permisos para acceder, configurar vistas
especificas y objetivos de publicacion en la interfaz de usuario (IU) de Pl Integrator for Business Analytics.

Seqguridad de las aplicaciones

Medidas defensivas sobre el ataque de denegacion de servicio (DoS)

Para maximizar la seguridad de Pl Integrator for Business Analytics, recomendamos instalar Pl Integrator dentro
de una arquitectura de intranet, para que esté protegido por la seguridad de su red.

En casos en los que es necesario escribir en destinos basados en Internet, como una plataforma en la nube,
Pl Integrator debe configurarse para publicar en estos destinos a través de un proxy HTTP. Para obtener mas
informacion, consulte: Como conectar Pl Integrator para publicar destinos a través de un proxy HTTP.

Seguridad de datos

El acceso a los datos de Pl AF en la interfaz de usuario de Pl Integrator for Business Analytics y los datos que
pueden publicar los servicios de Pl Integrator depende de la configuracidn de suplantacion de Pl Integrator for
Business Analytics. El modo de suplantacion permite a los usuarios acceder a los recursos de Pl AF desde la
interfaz de usuario de Pl Integrator segun los permisos de AF Security de una cuenta de Active Directory.

La configuracién de suplantacién de la aplicacion esta desactivada de forma predeterminada:

¢ Cuando configura una vista, los usuarios de los equipos cliente realizan solicitudes a Pl AF a través de PI
Integrator Framework Service. El usuario hereda los permisos de Pl AF y Pl Data Archive que se han otorgado
a la cuenta de servicio de Pl Integrator for Business Analytics.

¢ Todas las publicaciones y actualizaciones programadas por servicio de Pl Integrator Sync utilizan los permisos
otorgados a la cuenta de servicio de Pl Integrator for Business Analytics.

¢ Cuando el modo de suplantacidn esta desactivado, Pl Integrator usa los permisos de SEGURIDAD de AF de la
cuenta de servicio de Pl Integrator para acceder a los recursos de PI AF.
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La configuracién de seguridad de suplantacién de la aplicacién esta activada:

¢ Al configurar una vista para publicacidn, un usuario realiza solicitudes de datos a un servidor Pl AF mediante

Pl Integrator Framework Service. Pl Integrator Framework Service solo devuelve datos al usuario final al que
se otorgd acceso de datos de lectura dentro de los servidores de Pl AF.

Cuando la suplantacién estd activada, se utilizan los permisos de seguridad de AF de un usuario de inicio de
sesion autenticado actualmente. La alternacidon del modo de suplantacién permitira al usuario acceder a los
recursos de Pl AF con los permisos de seguridad de AF del usuario actual de inicio de sesién autenticado.
Todas las publicaciones y actualizaciones programadas por el servicio de Pl Integrator Sync utilizan los
permisos otorgados al usuario de inicio de sesién autenticado actualmente.

A partir de Pl Integrator for Business Analytics 2020 R2 SP2, se usa una lista de identidades de AF asignadas
al creador de vistas en el momento de la primera publicacidn para cada vista a fin de determinar qué datos
puede publicar una vista en cada publicacién posterior. Especificamente, el acceso del usuario a los objetos
de AF del servidor de Pl AF de origen (como elementos, atributos y plantillas) para una vista estd
determinado por los permisos de seguridad de AF que estan definidos para las identidades de AF asignadas a
ese usuario concreto de una cuenta de usuario de Active Directory. Cuando se publica una vista, las
identidades de AF asignadas al usuario que publica la vista se guardan con la configuracion de la vista.

Asegurar el acceso a los datos

Limite los permisos de Pl AF para la cuenta de servicio de Pl Integrator a los permisos minimos requeridos
para ver y publicar los datos que se deberian poder ver. Consulte Tareas posteriores a la instalacion para
obtener mas informacion.

Limite los permisos de Pl Data Archive para la cuenta de servicio de Pl Integrator a solo los permisos minimos
requeridos para publicar los datos en Pl Integrator for Business Analytics. Consulte Tareas posteriores a la
instalacion para obtener mas informacion.

Permisos de acceso del usuario

Un usuario puede acceder a la interfaz de usuario (IU) de Pl Integrator for Business Analytics cuando una
identidad de AF a la que estd asignado estd presente en la pagina Usuarios de administracion de Pl Integrator for
Business Analytics. Existen dos roles de permiso de acceso a nivel de la aplicacion: Administrador de Pl Integrator
y Usuario de Pl Integrator.

Administrador: los usuarios asignados a una identidad de AF con la casilla de verificacion seleccionada en
administrador pueden realizar todas las funciones administrativas con la interfaz de usuario de Pl Integrator
for Business Analytics, como agregar o modificar identidades, vistas y destinos de publicacidon existentes,
ademas de agregar y configurar permisos para otros usuarios. También pueden ver y modificar todas las
vistas, independientemente de si una identidad de AF tiene permisos de Lector o Propietario.

Usuario: los usuarios que no estan asignados a una identidad de AF con la casilla de verificacién en
administrador seleccionada no pueden acceder a la pagina Administracidn. El acceso a vistas individuales a
través de la interfaz web depende del permiso de vista que se asigne al usuario para esa vista (propietario,
lector de vista). Los administradores tienen acceso total a las vistas creadas por cualquier usuario,
independientemente del permiso de vista. Consulte la seccién Ver permisos de acceso para obtener mas
informacion. Los permisos de acceso de usuario se pueden modificar en la pestafia Usuarios de la pagina
Administracién, como se describe en Agregar y configurar identidades.

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 177



'AV EVA\TM Pl Integrator for Business Analytics

Seguridad de PI Integrator Framework

Ver permisos de acceso

Cuando se crea una vista, se asigna a la identidad de Pl AF del usuario que estd creando la vista el permiso de
Propietario de la vista. Si el usuario que crea la vista se asigna a varias identidades de Pl AF con acceso a PI
Integrator for Business Analytics, puede seleccionar una de estas identidades en la lista desplegable Propietario
de la vista para que sea el propietario de la vista. Solo estan disponibles las identidades de Pl AF que recibieron
acceso a Pl Integrator for Business Analytics. Si el usuario que crea la vista no elige una identidad de AF como
Propietario de la vista, se asigna una identidad de Pl AF de manera predeterminada en el siguiente orden:

¢ Sise asigno el usuario a una sola identidad de Pl AF, se utiliza esta identidad.

¢ Sise asignod el usuario a multiples identidades, se asignard la identidad con la menor cantidad de
asignaciones. Las identidades de un solo usuario y las identidades de grupo se tratan de la misma manera. Si
multiples identidades tienen la misma cantidad de asignaciones, se asigna el primer nombre de la identidad
en orden alfabético.

Después de crear una vista, puede asignar identidades de Pl AF adicionales a la vista. Para obtener mas
informacion, consulte Asegurar las views.

Las identidades de Pl AF pueden recibir los siguientes permisos en una vista:

¢ El propietario concede acceso de escritura a la configuracion de la vista y le proporciona a la identidad la
capacidad para cambiar los permisos de la vista y conceder el acceso a esta.

¢ Ellector concede acceso de lectura a la configuracion de la vista.
¢ Los lectores pueden detener y reanudar una vista
¢ Los lectores pueden ejecutar una actualizacién manual de datos mediante el botdn Actualizar datos
¢ Los lectores pueden hacer una copia de una vista
¢ Los lectores no pueden eliminar una vista

¢ Los lectores no pueden editar una vista

Nota: Los permisos de vista se pueden modificar en la pestafia Usuarios de la pagina Administracion,
como se describe en Agregar y configurar identidades.

Administrar permisos

En la pagina Usuarios, puede administrar todos los usuarios y su acceso a las vistas y objetivos de publicacidn.
Debe ser un administrador de Pl Integrator para acceder a esta pagina.
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User Access Permissions @ Users and G-oap-.o
Idantity Deseription

L world World security sccess

L Piintegrator Service Coeated by Pi integrator Setup K

& Cwrer Orwmee security sccese

La tabla describe las tareas que usted puede realizar. Los nimeros corresponden a los nimeros de la captura de
pantalla e identifican en qué parte de la pagina se realiza la tarea.

Numero Tarea de seguridad

1 Crear identidades de PI AF

2 Asignar usuarios y grupos a una identidad

3 Especificar en qué objetivos puede publicar datos la

identidad seleccionada

4 Especificar a qué vistas la identidad seleccionada tiene
permiso para acceder y el nivel de su acceso

5 Otorgar privilegios de administrador de la identidad
seleccionada en la interfaz de usuario de Pl Integrator
for Business Analytics

Para obtener mas informacidn sobre cdmo completar estas tareas, consulte Agregar y configurar identidades.

How to secure views

Asegurar que solo los usuarios apropiados puedan obtener acceso a una interfaz de usuario y privilegios de
administrador limitados es importante para mantener la supervision y seguridad adecuadas de los datos.

¢ Sihay identidades de AF en Permisos de acceso de usuario a las que no desea proporcionar acceso a la
interfaz de usuario de PI Integrator for Business Analytics, use el botén Eliminar para eliminar el acceso.

¢ Solo seleccione la casilla de verificacion Administrador para las identidades de AF que desee a las que
otorgarles privilegios de administrador de PI Integrator.

Existen dos maneras de asegurar las views:

¢ Puede configurar el acceso a las vistas asignadas a una identidad con permisos de propietario en la pagina
Mis vistas.
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¢ Sj usted es un administrador de Pl Integrator for Business Analytics, puede configurar el acceso a las vistas
por identidad o por vista en la pagina Administracion:

¢ Sidesea configurar a qué vistas tiene acceso una identidad, consulte Secure views for an identity.
¢ Sidesea configurar las identidades de una sola vista, consulte Administrar el acceso a una vista simple.

¢ Sidesea configurar las identidades de varias vistas al mismo tiempo, consulte Administrar el acceso a
multiples vistas.

Para obtener mas informacion, consulte Asegurar las views.

Migrar a seguridad de datos basada en identidades de AF

La migracién a la seguridad de datos basada en identidades de AF solo es necesaria cuando la configuracién de
seguridad de suplantacidn de la aplicacidn estd activada para Pl Integrator for Business Analytics y usted se estd
preparando para actualizar a Pl Integrator for Business Analytics 2020 R2 SP2. Si los usuarios y los recursos, como
los servidores de Pl AF, se encuentran en un dominio Unico o en un entorno de dominio de confianza del bosque
bidireccional, la migracién se incluye como parte del proceso de actualizacién regular en el instalador de Pl
Integrator for Business Analytics para las actualizaciones interactivas y silenciosas. La mayoria de las
actualizaciones no requieren pasos fuera del instalador para migrar a la seguridad de datos basada en
identidades de AF.

Si Pl Integrator for Business Analytics esta instalado en un entorno de dominio de confianza del bosque en un
solo sentido en el que los usuarios creadores de vistas estdn en un dominio de usuario y la cuenta de servicio de
Pl Integrator for Business Analytics y los recursos, como PI AF, estdn en un dominio de recurso independiente,
deberd realizar un paso adicional antes de ejecutar el instalador. Ejecute la herramienta de migracién de
identidades por separado en un equipo del dominio de usuario para preparar las vistas existentes a fin de utilizar
el modelo de seguridad de datos basada en identidades de AF.

La herramienta de migracion de identidades prepara las vistas de Pl Integrator for Business Analytics para utilizar
el nuevo modelo de seguridad de datos basada en identidades de AF.

e AVEVA recomienda ejecutar la herramienta primero en un modo de solo vista previa, que genera un informe
de los resultados esperados, pero no modifica la plantilla de elementos de vista ni los elementos de vista.

¢ Los archivos de copia de seguridad, registro e informe generados tienen la fecha y hora anexadas para que
las nuevas ejecuciones no sobrescriban los resultados de las anteriores, por ejemplo,
SetupPlintegratorSetup_ldentityMigration_Report_Preview 2022-08-02_07-34-44-188.html.

Cuando se encuentra en el modo que no es de vista previa, la herramienta de migracién de identidades hara lo
siguiente:

1. Realizar un backup XML de los elementos de la vista existente especificados por InstancePath que usted pasa
a la herramienta.

2. Modificar la plantilla de elementos PI_INTEGRATOR_VIEW.

Modificar los atributos existentes en la base de datos de configuracién de AF incluida en InstancePath que
usted especifica a fin de prepararlos para la actualizacién con el objetivo de utilizar el modelo de seguridad
basado en identidades de AF.
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Como ejecutar la herramienta de migracion de identidades

Antes de ejecutar la herramienta de migracion de identidades:

Pl Asset Framework (AF) Client y Pl System Explorer deben estar instalados en el equipo donde ejecuta la
herramienta de migracién de identidades.

Se debe agregar una entrada en la tabla de servidores conocidos en Pl System Explorer para el servidor AF
que aloja la configuracidn de Pl Integrator for Business Analytics. (Consulte Adicion de un servidor de PI AF a
la lista de conexiones). Ademas, debe haber una entrada para cada servidor AF fuente que use su instancia
de Pl Integrator for Business Analytics para publicar datos de vistas. Debe poder conectarse a cada uno de
estos servidores mediante Pl System Explorer a través del mismo equipo que ejecutard la herramienta de
migracion de identidades.

Cree una asignacion a la identidad de AF de administradores en el servidor AF que aloja la configuracion de
Pl Integrator for Business Analytics.

El usuario que ejecuta la herramienta de migracion de identidades necesita permisos de acceso de lectura en
el servidor AF para identidades de seguridad, asignaciones de seguridad, bases de datos y objetos de
seguridad de AF para todos los servidores de AF de origen que su instancia Pl Integrator for Business
Analytics usa para publicar datos para vistas. La identidad de World AF integrada abarca el acceso necesario.

El usuario que ejecuta la herramienta de migracion de identidades necesita permisos para crear y escribir
archivos en la carpeta %PIHOME%\dat. Los privilegios de administrador local abarcan el acceso necesario.

La herramienta de migracion de identidades estd comprimida y se empaqueta con Pl Integrator.

Copie el archivo comprimido descargado en un equipo en el mismo dominio que los usuarios de Pl Integrator
for Business Analytics.

Descomprima el archivo comprimido copiado en un directorio local.

Ejecute la herramienta de migracién de identidad con una de las siguientes opciones: Ejecutar la
herramienta de migracién de identidades de manera interactiva o Ejecutar la herramienta de migracién de
identidad utilizando argumentos de la linea de comandos.

Ejecutar la herramienta de migracion de identidades de manera
Interactiva

Ejecute la herramienta de migracién de manera interactiva para realizar selecciones mientras se estd ejecutando
la herramienta. Si prefiere, puede ejecutar la herramienta usando argumentos de la linea de comandos.

1.

En el equipo donde descomprimié la herramienta de migracién de identidades, abra un simbolo del sistema
y dirijase al directorio donde se encuentran los archivos descomprimidos.

Para ejecutar la herramienta, escriba IdentityMigrationTool y presione Intro.

Cuando se le solicite, especifique si debe migrar las vistas, lo que incluye modificar la plantilla
PI_INTEGRATOR_VIEW y ver elementos.

¢ No (N): escriba N o presione la tecla Intro para ejecutar solo en el modo de vista previa; esto no realizara
ninguna modificacion en la plantilla PI_INTEGRATOR_VIEW ni en los elementos de la vista. Avance al
paso 5.

e Si(Y): escriba Y para modificar el elemento y la plantilla de la vista segln sea necesario.
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4. Enlapregunta “éDesea que esta herramienta intente realizar un backup XML del elemento InstancePath?”,
especifique la opcidn de backup:

¢ No (N): escriba N. Esto no hara nada; debe realizar un backup manualmente. Si no tiene un backup y la
herramienta modifica las vistas, no podra volver por completo al estado anterior de la base de datos de
AF. Realice un backup manual de Pl System Explorer con las opciones Incluir todos los objetos
referenciados e Incluir cadenas de sequridad marcadas. (Consulte Opciones de exportacion a XML).

e Si(Y): escriba Y o presione la tecla Intro si desea que la herramienta intente realizar un backup XMLy
finalizar si el archivo de backup no se ha creado correctamente.

5. En “Si el valor de la lista de identidades de AF (atributo IDList) de una vista no esta vacio, ¢desea que la
herramienta sobrescriba el valor existente?”, especifique la opcion de sobrescritura:

¢ No (N): escriba N o presione la tecla Intro para omitir cualquier vista cuyo valor de atributo IDList no esté
en blanco.

e Si(Y): escriba Y para sobrescribir el valor IDList existente.

6. Ingrese el valor InstancePath de %PIHOME64%\Integrators\BA\CAST.Ul.WindowsService.exe.config. Por
ejemplo, \\MyAFServer\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel.

7. Lasvistas ahora se cargaran. Seleccione las vistas que desea migrar. La herramienta solo procesa vistas no
eliminadas (vistas cuyo valor de atributo IsDeleted es falso), independientemente de la opcidn seleccionada.

¢ (A): escriba A o presione la tecla Intro para migrar todas las vistas.
¢ (B): escriba B para especificar el dominio de los creadores de la vista cuyas vistas desea migrar.

¢ (C): escriba C para ingresar una ruta de archivo ID de vista de entrada para migrar un conjunto de vistas
especifico.

Cuando ejecuta la herramienta, crea un archivo
SetupPlintegratorSetup_ldentityMigration_FailedViews_TimeStamp.txt que contiene las ID de las vistas
que fallaron.

8. En “Sino se puede encontrar una identidad de AF en la base de datos y el servidor AF de origen de la vista
para el creador de la vista, ¢desea que la herramienta utilice las identidades de AF de la cuenta de servicio si
son vdlidas?”, especifique qué opcién desea usar:

¢ No (N): escriba N o presione la tecla Intro si desea que la herramienta omita cualquier vista cuyo creador
no pueda asignarse a identidades de AF con acceso de datos de lectura en la base de datos de AF de
origen de la vista.

e Si(Y): escriba Y para usar las identidades de AF de la cuenta de servicio en lugar de esas vistas.
9. Cuando se le solicite, especifique si debe continuar con la migracion:

¢ No (N): escriba N.

e Si, (Y): escriba Y para ejecutar la herramienta.

10. Después de ejecutar la herramienta de migracion de identidades, los siguientes archivos estaran presentes
en la carpeta %/PIHOME%\dat .

¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: lista de ID de vista a las que no hemos
podido agregar identidades de AF. Este archivo se puede utilizar como entrada de la herramienta para
una ejecucién posterior.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv: da como resultado el formato CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html: da como resultado el formato HTML, que se
puede visualizar en un navegador web.

¢ SetupPlintegratorSetup_ldentityMigration_Logs.txt: ver registros de migracion.
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¢ *SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml: backup de los elementos, los
atributos y las plantillas de AF de InstancePath; este archivo no esta presente si la herramienta se ejecuta
en el modo de vista previa.

Ejecutar la herramienta de migracion de identidad utilizando
argumentos de la linea de comandos

1. En el equipo donde descomprimid la herramienta de migracién de identidades, abra un simbolo del sistema
como administrador y dirijase al directorio local donde se encuentran los archivos descomprimidos.

2. Para ver el texto de ayuda de los argumentos de la linea de comandos de la herramienta, ingrese:
IdentityMigrationTool /?

3. Para ejecutar la herramienta de migracion de identidades, ingrese: IdentityMigrationTool /l:InstancePath
[/D:ServiceAccountSAM] [/M [/N]] [/O] [/S:SAMDomain /U:UPNDomain] [/V:pathTolnputViewlIDsFile].

donde:

¢ /l:InstancePath: el valor InstancePath del archivo %PIHOMEG64 \Integrators\BA\
CAST.UL.WindowsService.exe.config.

* /D:ServiceAccountSAM: (opcional) si se especifica, la herramienta tendra el valor predeterminado de las
identidades de AF de UPN de la cuenta de servicio. Las identidades no se pueden determinar o no se
asignan a ninguna identidad de AF que tenga acceso a datos de lectura en la base de datos de AF de
origen de la vista. Si no se especifica, la herramienta omitird esas vistas. Especifique ServiceAccountSAM
en formato SAM (dominio\usuario).

¢ [/M: (opcional) si se especifica, la herramienta modificara la plantilla de elementos
PI_INTEGRATOR_VIEW o verd los elementos. Si no se especifica, la herramienta se ejecutard en el modo
de solo vista previa y no realizara ninguna modificacion.

¢ /N : (opcional) si se especifica con o sin /M, la herramienta no intentara realizar un backup XML del
elemento enumerado en el valor /l:InstancePath y sus elementos secundarios. Si no se especifica /M, la
herramienta intentara realizar esta copia de seguridad y finalizara si no puede confirmar que el archivo
de copia de seguridad se haya creado correctamente.

e [O: (opcional) si se especifica, la herramienta procesara vistas independientemente de si el valor de
atributo IDList esta en blanco. Si no se especifica, la herramienta omitira las vistas cuyo valor de atributo
IDList no esté en blanco.

¢ /S:SAMDomain /U:UPNDomain: (opcional, no se puede especificar si se especifica /V) si se especifica, la
herramienta procesara solo vistas cuyo dominio de cuenta SAM de sus creadores coincida con el dominio
de SAM especificado. Si se especifica la opcién /U:UPNDomain, la herramienta utilizara el valor
UPNDomain como dominio de nombre principal del usuario (UPN) cuando cree identidades de Windows
para aquellos creadores de vistas o, si /U:UPNDomain no esta presente, la herramienta configurara el
valor UPNDomain igual al valor SAMDomain en su lugar.

« /V:PathTolnputViewlDsFile: (opcional, no se puede especificar si se especifica /S) si se especifica, la
herramienta leera las ID de vista de entrada de la ruta de archivo especificada y solo procesara las vistas
cuyas ID estén presentes en el archivo.

4. Después de ejecutar la herramienta de migracidon de identidades, los siguientes archivos estardn presentes
en la misma carpeta donde ejecutd la herramienta:

¢ SetupPlintegratorSetup_ldentityMigration_FailedViews_.txt: lista de ID de vista a las que no hemos
podido agregar identidades de AF. Este archivo se puede utilizar como entrada de la herramienta para
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una ejecucién posterior.
¢ SetupPlintegratorSetup_ldentityMigration_Report_.csv: da como resultado el formato CSV.

¢ SetupPlintegratorSetup_ldentityMigration_Report_.html: da como resultado el formato HTML, que se
puede visualizar en un navegador web.

¢ SetupPlintegratorSetup_ldentityMigration_Logs_.txt: ver registros de migracion.

¢ SetupPlintegratorSetup_ldentityMigration_InstancePathBackup_.xml: backup de los elementos, los
atributos y las plantillas de AF de InstancePath (* no presente si la herramienta se ejecuta en el modo de
vista previa).

Ejemplos de parametros de entrada para IdentityMigrationTool

En los siguientes ejemplos se muestra el uso de parametros de entrada para la herramienta de migracién de
identidades, donde:

¢ La configuracion de la vista de Pl Integrator se almacena en el siguiente elemento \\PIAF\Configuration\
OSlsoft\PI Integrator for Business Analytics\Instancel.

e Los servicios de Pl Integrator se ejecutan en la cuenta de servicio prod\piintegratorservice.

¢ El dominio para los creadores de vistas, por ejemplo, prod\user01, es prod. El sufijo de dominio que
gueremos aplicar a estos creadores de vistas, por ejemplo, user01@prod.opsmain.com es
prod.opsmain.com.

¢ Elarchivo de ID de vista de entrada se encuentra en la ruta de archivo C:\Users\user01\Downloads\
IdentityMigrationTool\SetupPlintegratorSetup_ldentityMigration__FailedViews.txt.

Predeterminado para la cuenta de servicio, no realice una copia de
seguridad y modifique las vistas

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSlIsoft\PI Integrator for Business Analytics\Instancel"
/D:"prod\piintegratorservice" /M /N

En este ejemplo, la herramienta realiza las siguientes acciones:

¢ (/M) Modifica la plantilla PI_INTEGRATOR_VIEW y ve elementos seglin sea necesario.
¢ (/N) No intenta realizar un backup XML del InstancePath especificado.
¢ Omite las vistas cuyo atributo IDList no esté en blanco.

¢ (/D:ServiceAccountSAM) La herramienta tendra el valor predeterminado de las identidades de AF prod\
piintegratorservice de la cuenta de servicio especificada para cualquier vista cuyo creador no se pueda
encontrar o no pueda asignarse a ninguna identidad de AF que tenga acceso a datos de lectura en la base de
datos de AF de origen de la vista.

Filtrar por dominio creador de vista, modificar vistas y sobrescribir valores
de atributo IDList sin espacios en blanco

IdentityMigrationTool.exe /I:" \\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel"
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/M /O /S:"prod" /U:"prod.opsmain.com"

En este ejemplo, la herramienta realiza las siguientes acciones:

¢ (/M) Modifica la plantilla PI_INTEGRATOR_VIEW y ve elementos seglin sea necesario.
¢ Intenta realizar una copia de seguridad XML del InstancePath especificado.
¢ (/0) Sobrescribe cualquier atributo IDList aunque no esté en blanco.

¢ Omite las vistas cuyo creador de vistas no se pueda encontrar o no se pueda asignar a ninguna identidad de
AF que tenga acceso a datos de lectura en la base de datos de AF de origen de la vista.

¢ (/S:SamDomain) Omite las vistas cuyo creador de la vista no pertenezca al prod de dominio especificado.
Para cualquier vista cuyo creador de vista pertenezca a este dominio, supondra que el sufijo Nombre de
usuario principal (UPN) del creador de la vista es prod.opsmain.com.

Modificar vistas y filtrar por una lista de vistas de entrada

En este ejemplo, la herramienta realiza las siguientes acciones:

IdentityMigrationTool.exe /I:"\\PIAF\Configuration\OSIsoft\PI Integrator for Business Analytics\Instancel" /M
/V:"C:\Users\user01\Downloads\IdentityMigrationTool\
SetupPlintegratorSetup_ldentityMigration_FailedViews.txt"

¢ (/M) Modifica la plantilla PI_INTEGRATOR_VIEW y ve elementos segln sea necesario.
¢ Intenta realizar una copia de seguridad XML del InstancePath especificado.
e Omite las vistas cuyo atributo IDList no esté en blanco.

¢ Omite las vistas cuyo creador de vistas no se pueda encontrar o no se pueda asignar a ninguna identidad de
AF que tenga acceso a datos de lectura en la base de datos de AF de origen de la vista.

e (/V) Omite las vistas que no estan en la lista de ID de vista de entrada.

Secure views for an identity

Los administradores del servicio de Pl Integrator Framework pueden asignar acceso a las vistas de todas las
identidades en la pagina Administracién.

1. Hagaclic en el icono del menu E y en Administracion.
2. Enla pagina Administraciéon, haga clic en la pestafia Usuarios.
La lista Permisos de acceso del usuario muestra una lista de las identidades de Pl AF.

3. Seleccione la identidad cuyos permisos desea configurar. Consulte Permisos de acceso de vista.
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View Permissions
JoyceTest Owner A

EventFrameRowiFilter Chamer W

Test2
Feader

Test
Add View Permissions Remove View Permissions

La lista Permisos de vista muestra las vistas de la identidad seleccionada y los permisos actuales para esas
vistas. Consulte la seccidn Ver permisos de acceso para obtener mas informacidn.

4. Seleccione la view que desea configurar.

Seleccione permiso de Duefio o Lector de la lista.
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Arquitectura de escala de
Pl Integrator for Business Analytics

En el siguiente diagrama, se muestra la arquitectura de PI Integrator for SAP HANA.

Pl Integrator for Business Analytics con un Pl Integrator Worker Node

Cluster Manager

[ Represents separate processes

Destination Targets . _
B Represents required services

Los procesos de Pl Integrator Framework, Pl Integrator Worker Node, y Pl Integrator Sync residen en el mismo
equipo.

Cada instancia de Pl Integrator for Business Analytics tiene un minimo de un proceso de nodo de trabajador que
administra la publicaciéon de vistas, incluidas las tareas programadas, las tareas de transmision y las tareas
ejecutadas una vez. Puede agregar nodos de trabajador adicionales para mejorar el rendimiento de la
publicacion. Esto se puede hacer durante la instalacion de Pl Integrator for Business Analytics. Después de la
instalacion, puede agregar mas nodos usando la opcién Agregar o eliminar programas en el Panel de control de
Microsoft Windows.

Recuerde que cada nodo de trabajador adicional requiere mas recursos de RAM y CPU. Para obtener mas
informacion, consulte Requisitos del sistema. No podrd agregar nodos de la aplicacion web de
Pl Integrator for Business Analytics.

El Pl Integrator Worker Node publica tareas en los destinos de salida. A su vez, el gerente del grupo distribuye
automaticamente las tareas entre los nodos disponibles. Por ejemplo, suponga que existen dos nodos de
trabajador y cinco tareas. La primera tarea se asigna al primer nodo de trabajador; la segunda tarea, al segundo
nodo de trabajador; la tercera tarea, al primer nodo de trabajador, y asi sucesivamente. Cuando un nodo de
trabajador se agrega al grupo, se reinician todos los servicios de Pl Integrator for Business Analytics, y el gerente
del grupo equilibra las tareas entre todos los nodos disponibles, incluido el nodo agregado recientemente.

Nota: Las tareas no se asignan a los nodos en orden alfabético. Si un nodo falla, el gerente del grupo reasigna las
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tareas que se habian asignado a este a los nodos de trabajador restantes. Pl Integrator Framework Service
reinicia automaticamente el nodo de trabajador desconectado. Una vez que se reinicia, las tareas existentes no
se vuelven a equilibrar para incluir el nodo de trabajador reiniciado. Sin embargo, se equilibran tareas nuevas en
todos los nodos de trabajador. Si esto da como resultado una distribucion desequilibrada de tareas, puede volver
a equilibrarlas a estas en forma manual.

Optimizar los procesos del nodo de trabajador
Siga estas pautas para optimizar el rendimiento de sus nodos de trabajador:

¢ Instale como minimo dos nodos de trabajador de PI Integrator; asegurese de tener la cantidad necesaria de
RAM y CPU para admitir nodos de trabajador adicionales. Luego, si uno de los nodos falla, el otro podra
tomar las tareas del nodo con fallas, y los datos de visualizacion se publicaran igual.

¢ Revise las estadisticas de su vista e identifique qué vistas estan tardando tanto tiempo en publicarse que se
perdera el préximo scan. Divida las vistas problematicas en multiples vistas mds pequefias. Si el problema
persiste, considere agregar otro nodo.

e Compruebe que sus vistas estén estructuradas de manera eficiente. Utilice las plantillas de Pl AF cada vez
gue sea posible, pero no cree figuras que arrojen resultados desmesurados. El nimero de coincidencias de
figuras tiene un impacto directo en el rendimiento. Por lo tanto, si es posible, disefie su figura de busqueda
en la pagina de creacidén de vista de Seleccionar datos para especificar solo aquellos elementos que necesita
y filtre los elementos innecesarios. (Esto se realiza antes de que se apliquen los filtros de registros).

e Programe sus vistas de manera que no todas publiquen al mismo tiempo. Desplace las tareas entre si.

Si, después de optimizar las vistas, aun necesita mejorar el rendimiento, agregue un nodo de trabajador al grupo.
Consulte Requisitos del sistema para conocer los requisitos de memoria y hardware. Puede tener hasta cinco Pl
Integrator Worker Nodes. Todos los nodos de trabajador deben residir en el mismo equipo en el que esta
instalado PI Integrator for Business Analytics.

Pl Integrator for Business Analytics con miiltiples Pl Integrator Worker Nodes

Cluster Manager

‘ 1 Represents separate processes

Destination Targets ) .
I Represents required services
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Administrar los nodos de trabajador de PI Integrator

Pl Integrator for Business Analytics proporciona un gerente del grupo que puede utilizar para ver el estado del
grupo y administrar los nodos de trabajador. Para cada nodo, muestra lo siguiente:

¢ Nombre del servicio: nombre del servicio del nodo de trabajador. El nodo de trabajador predeterminado se
denomina PI Integrator Worker Node 1. Cada nodo de trabajador subsiguiente se identifica con un nimero,
por ejemplo, Pl Integrator Worker Node 2, Pl Integrator Worker Node 3, etc.

Nota: Los servicios de Pl Integrator Worker Node se instalan con el tipo de inicio configurado como Manual.
El servicio de Pl Integrator Framework reinicia automaticamente el servicio segln sea necesario. Por lo tanto,
no es necesario que los usuarios reinicien el servicio.

¢ Estado: muestra si el nodo estd hacia arriba o hacia abajo. El servicio de Pl Integrator Framework reiniciara el
servicio del nodo de trabajador en un minuto.

¢ Direccidn: un identificador Unico utilizado internamente que indique la ubicacién de TCP para el proceso.
Este identificador cambia cada vez que se inicie el servicio del nodo de trabajador.

Las tareas que se ejecutan en cada nodo se muestran con la siguiente informacion:

¢ ID de la tarea: GUID que se asigna a la tarea.
e Nombre de la tarea: nombre de la vista.

e Estado de la tarea: muestra el estado de la tarea; por ejemplo, programada, para publicacién, para
transmision.

« Ultima hora de ejecucién: la marca de tiempo de la tltima publicacién de la vista.
Puede realizar las siguientes tareas de administracion:

¢ Segln sea necesario, puede redistribuir tareas de manera mds uniforme entre nodos de trabajador haciendo
clic en Reequilibrar nodos.

¢ Haga clic en una tarea para ir a la pagina Mis vistas en la que puede obtener mads detalles acerca de la vista,
gue incluye mensajes de registro y estadisticas de ejecucion.
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Destinos de Oracle

Pl Integrator for Business Analytics reserva la cadena que no distingue mayusculas de minusculas ID, PlintTSTicks
y PlintShapelD. Si algunas de las columnas reciben el nombre de estas cadenas reservadas, se agrega un guion
bajo (_) a la cadena, por ejemplo, ID_o Id_.

La base de datos Oracle reserva una lista adicional de palabras. Si estas palabras aparecen en el nombre de una
columna de view, se agrega un guion bajo (_) a ellas. Por ejemplo, ACCESO se cambiaria a ACCESO_. Consulte la
documentacién de Oracle para obtener mas informacion sobre las palabras reservadas de Oracle.

A continuacion, se incluye la lista de las palabras reservadas de la base de datos Oracle:
ACCESS
ADD

ALL

ALTER
AND

ANY

AS

ASC
AUDIT
BETWEEN
BY

CHAR
CHECK
CLUSTER
COLUMN
COMMENT
COMPRESS
CONNECT
CREATE
CURRENT
DATE
DECIMAL
DEFAULT
DELETE
DESC
DISTINCT
DROP

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 190



'AV EVA\TM Pl Integrator for Business Analytics

Cadenas reservadas

ELSE
EXCLUSIVE
EXISTS

FILE

FLOAT

FOR

FROM
GRANT
GROUP
HAVING
IDENTIFIED
IMMEDIATE
IN
INCREMENT
INDEX
INITIAL
INSERT
INTEGER
INTERSECT
INTO

IS

LEVEL

LIKE

LOCK

LONG
MAXEXTENTS
MINUS
MLSLABEL
MODE
MODIFY
NOAUDIT
NOCOMPRESS
NOT
NOWAIT
NULL
NUMBER
OF

OFFLINE

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 191



'AV EVA\TM Pl Integrator for Business Analytics

Cadenas reservadas

ON
ONLINE
OPTION
OR

ORDER
PCTFREE
PRIOR
PRIVILEGES
PUBLIC
RAW
RENAME
RESOURCE
REVOKE
ROW
ROWID
ROWNUM
ROWS
SELECT
SESSION
SET
SHARE
SIZE
SMALLINT
START
SUCCESSFUL
SYNONYM
SYSDATE
TABLE
THEN

TO
TRIGGER
uiD
UNION
UNIQUE
UPDATE
USER
VALIDATE
VALUES

© 2015-2025 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 192



'AV EVA\TM Pl Integrator for Business Analytics

Cadenas reservadas

VARCHAR
VARCHAR2
VIEW
WHENEVER
WHERE
WITH
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Soporte técnico y otros recursos

Para obtener asistencia técnica, péngase en contacto con el soporte técnico OSlsoft llamando al +1
510-297-5828 o visitando Pagina de contacto del portal de clientes de OSlsoft. La pagina Comuniquese con
nosotros ofrece opciones de contacto adicionales para los clientes que estan fuera de Estados Unidos.

Cuando se ponga en contacto con el Servicio de asistencia técnica de OSlsoft, tenga a mano la siguiente
informacion:

¢ Nombre del producto, version, y nimeros de compilacién

¢ Detalles sobre la plataforma del equipo (tipo de CPU, sistema operativo y nimero de version)
¢ Hora en la que se inicié el problema

¢ Los archivos de registro en ese momento

¢ Los detalles sobre cualquier cambio en el entorno antes de que se produjera el problema

¢ Elresumen del problema, incluido cualquier archivo de registro relacionado con este durante el periodo en
que se produjo

Para consultar a otros usuarios del software OSlsoft, participe en la comunidad de usuarios de OSlsoft, Pl Square.
Los integrantes de la comunidad pueden solicitar asesoramiento y compartir ideas sobre Pl System. El espacio PI
Developers Club dentro de Pl Square ofrece recursos para ayudarle con la programacién e integracién de los
productos OSlsoft.
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Notas de |la version

Descripcion general

Pl Integrator for Business Analytics
Notas de la versidon

Pl Integrator for Business Analytics 2020 R2 SP2 (versidn 2.7.0.112) es una version de funciones centrada en
mejorar la flexibilidad de integracion, la seguridad y las capacidades de inicio de sesion. Entre los aspectos mas
destacados, se incluyen los siguientes:

e Compatibilidad con cuentas de servicio virtuales

¢ |U de los ambitos de registro

e Mejoras adicionales en el objetivo, incluida la seleccidon dinamica de regiones de AWS y la compatibilidad
actualizada con las versiones mas recientes de la base de datos de Oracle y de los componentes de acceso a
datos de Oracle (ODAC)

Esta version deja de usar Pl Views y ofrece varias mejoras en el inicio de sesién y el rendimiento.

Para obtener mas informacidn sobre las caracteristicas y funciones del producto, incluidos los requisitos del
sistema y las instrucciones de actualizacion, consulte Requisitos del sistema y Actualizar
Pl Integrator for Business Analytics.

Mejoras

Se agregaron las siguientes caracteristicas:

Elemento de trabajo

Description

106816

Se agregd soporte para cuentas de servicio virtuales,
lo que mejora la seguridad y la flexibilidad de
implementacioén.

95689

Se introdujo una nueva interfaz de usuario para
administrar y configurar ambitos de registro, lo que
mejora la facilidad de uso.

104079

Se desaprobé la funcionalidad de Pl Views para
abordar una vulnerabilidad de seguridad critica.

108693

Se corrigio el proceso de configuracién de destinos de
AWS; la lista de regiones de AWS ahora se carga de
forma dinamica desde los puntos finales de servicio en
lugar de usar una lista estatica.

103656

Se actualizé la compatibilidad para admitir las
versiones mas recientes de la base de datos de Oracle
y de los componentes de acceso a datos de Oracle
(ODAC).
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53833

Se mejoré el inicio de sesidon interno para un mejor
diagndstico y monitoreo.

Reparaciones

En esta seccidon se enumeran los elementos que se resolvieron en esta version:

Elemento de trabajo

Description

107139

Se aplicé un hotfix para solucionar problemas con el
manejo de ID de fila de Redshift.

73695

Se corrigié un problema por el que AdlGen2Writer no
cerraba correctamente los archivos al vaciar, lo que
garantiza la integridad de los datos.

54501

Se mejoraron los mensajes de excepcion mediante la
inclusién del nombre de la tabla en los errores
Getlastld para facilitar la solucion de problemas.

113283

Se implementd Async Target Wrapper en NLog para
mejorar la velocidad de inicio de sesién y el
rendimiento general.

112268

Se deshabilitd la capacidad de modificar el puerto al
actualizar a través del kit de instalacién para evitar
problemas de configuracion.

112329

Se resolvié un problema por el que, después de
publicaciones fallidas del escritor de HDFS, la siguiente
publicacion correcta podia perder datos previamente
en cola.

117900

Se resolvié la validacion de los nombres de vista
durante las operaciones de creacién, modificacién o
importacion.

48813

Se corrigié un error (“No se pudo encontrar la vista
para el usuario”) que se producia al descartar cambios
o después de intentos fallidos de volver a publicar en
vistas clonadas.

108733

Se soluciond un problema por el cual las vistas no se
podian cargar cuando la suplantacion de usuario
estaba activada.

48893

Se corrigié un problema por el que el puerto
predeterminado no se liberaba después de desinstalar
el integrador si se utilizaba un puerto no
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predeterminado (no el puerto 443).

48906 Se resolvié un problema por el que las vistas de
transmision de valor clave dejaban de enviar datos
tras una excepcion de conexion de AFListener.

48805 Se corrigid un error por el que las vistas de activos y
transmision dejaban de publicar datos después de una
excepcion de conexion de SQL Server de backend.

48850 Se corrigié un problema del instalador en el que se
producia un error en la comprobacion del servidor AF
si el dominio de la cuenta de servicio gMSA era
incorrecto.

113281 Se mejoré la légica de procesamiento de excepciones
para evitar reinicios innecesarios de nodos de trabajo
en determinadas implementaciones.

113475 Se soluciond un problema repetido por el cual las
vistas de transmision de valor clave dejaban de enviar
datos tras una excepcion de conexién de AFListener.

48626 Se mejoraron los mensajes de error de dataset para
gue sean mas precisos cuando se produce un error en
los datos de actualizacidn.

48731 Se corrigieron las politicas de retencidn para que los
limites filterMinimum/MaximumFrequency ahora se
incluyan correctamente.

48880 Se resolvié un problema por el que los mensajes
desencadenados por eventos no se enviaban
inmediatamente al Centro de eventos de Azure.

95089 Se corrigidé un error por el que a los archivos de salida
de Parquet publicados en S3 les podia faltar una fila
de datos.

69017 Se corrigié un problema por el que SqlWriter podia

informar estadisticas inexactas, especialmente,
durante el inicio de la aplicacidn.

107603 Se actualizé Pl Integrator for Business Analytics de
.NET Framework 4.6.2 a 4.8 para abordar las
vulnerabilidades de seguridad conocidas y mejorar la
posicién de seguridad general del sistema.
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Las solicitudes de mejora y los problemas existentes se pueden revisar en el Portal de clientes. Consulte el

Articulo de Conocimiento 16600, ¢ Cmo veo anuncios de versiones, alertas, problemas conocidos y articulos de
conocimiento relacionados con mis productos? y siga el Método 2: bldsqueda general para obtener instrucciones
sobre cémo mostrar una lista de problemas conocidos.

Informacion de orientacion y seguridad

Asumimos el compromiso de ofrecer al mercado productos seguros. Esta seccidn tiene el propdsito de
proporcionar informacidn relevante relacionada con la seguridad para guiar su decisién de instalacion o
actualizacién. Revelamos de manera proactiva informacion agregada sobre la cantidad y la gravedad de las
vulnerabilidades de seguridad abordadas en cada version. En las siguientes tablas, se proporciona una
descripcidn general de los problemas de seguridad abordados y su gravedad relativa en funcién de la calificacion

estandar.
. | il
Categoria de gravedad Rango de puntaje base de CVSS Cantidad de vu perabl idades
corregidas
Critico 9-10 1
Alto 7-8,9 4
Medio 4-6,9 21
Bajo 0-3,9 5

Archivos del kit de distribucion

Producto Versiones de software
AVEVA.PlintegratorBA_ADV_1000_2.7.0.112_.exe |2.7.0.112
AVEVA.PlintegratorBA_ADV_5000_2.7.0.112_.exe | 2.7.0.112
AVEVA PlintegratorBA_ADV_20000 2.7.0.112 .ex |2.7.0.112
e
AVEVA PlintegratorBA_ADV_100000 2.7.0.112_.e | 2.7.0.112
xe
AVEVA.PlintegratorBA_STD_1000_2.7.0.112_.exe |2.7.0.112
AVEVA.PlintegratorBA_STD_5000_2.7.0.112_.exe |2.7.0.112
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https://customers.osisoft.com/s/knowledgearticle?knowledgeArticleUrl=Release-Announcements-Alerts-Knowledge-Articles-Known-Issues
https://customers.osisoft.com/s/knowledgearticle?knowledgeArticleUrl=Release-Announcements-Alerts-Knowledge-Articles-Known-Issues
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_our_commitment
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_communication
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_scoring
https://docs.aveva.com/bundle/security-commitment-and-disclosure-standards/page/1309709.html#_vulnerability_scoring
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Xxe

AVEVA.PlintegratorBA_STD_20000_2.7.0.112_.ex |2.7.0.112
e
AVEVA.PlintegratorBA_STD_100000_2.7.0.112_.e |2.7.0.112
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AVEVA Group Limited Tel +44 (0)1223 556655

High Cross

Madingley Road Www.aveva.com

Cambridge

CB3 OHB ) . . .
UK To find your local AVEVA office, visit www.aveva.com/offices

AVEVA believes the information in this publication is correct as of its publication date. As part of continued product development, such information is subject to
change without prior notice and is related to the current software release. AVEVA is not responsible for any inadvertent errors. All product names mentioned are
the trademarks of their respective holders.
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